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Introduction

It must be said first and foremost that tuning an engine can be an exciting experience, as well as a risky
one. If you really don't know what you are doing, or even where to start, read all the manuals until you do,
and if youʼre still lost - seek professional advice. Failure to do so may damage your engine, and even
yourself!
This guide covers the wiring, software features and settings of the ME100/ME221/ME300/ME442 Engine
Management System. The ME221/442 is the core control system as used by many of our Plug-In ECUs so this guide applies to some of them also. It doesn't go into the details of ‘tuning for performanceʼ as such
(i.e which cams work best, or why 4-2-1 headers can improve torque etc), only the way you would be able to
use the ME system to get the best from your engine, putting its feature set to use to realise your tuning
goals. Visiting a rolling road and an experienced mapper will sometimes be the best option for most users
(the ones who just want their car to perform how they want, without much interest in as to how to get it to) for others, the experience of doing it themselves is what matters, and with the ME platform being so flexible,
and so many rolling roads and tuners supporting it, as well as a user friendly tuning system, plus a growing
support network, both styles of approach are equally accessible.
The ME100 and ME300 is an ignition only variants of the ME221 and ME442 respectively. As such, fuel
control areas will not operate, although everything else will, including idle, knock, environmental and boost
control trims.
Further manuals can be obtained from our website at www.motorsport-electronics.co.uk.
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Safety First!
It must be said first and foremost that tuning an engine can be an exciting experience, as well as a risky
one. If you really don't know what you're doing, or even where to start, read all the manuals until you do, and
if you're still lost - seek professional advice from one of our world-wide installation agents. Failure to do so
may damage your engine, and even yourself!
If you have no experience of engine management - follow the manual closely, ask for support if
you get stuck, and aim only to get the basic physical install done - leave the rest to a reputable
tuner to avoid engine damage or personal injury. NEVER tune your ECU on the public highway!
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Geting Help
There are various avenues for support - the first being these online manuals and documentation.
Almost all support can be answered with a simple “itʼs on this page” - but in those rare cases, you can
either raise a support ticket via our website, or call us Mon-Fri 9am-5pm GMT on +44 (0) 1373 710610
where one of our support engineers will be happy to guide you through any queries.
Please bare in mind while we will try and offer some tuning support, in most cases a visit to your nearest
ME approved agent will be the best advice for tuning. Our basemaps are provided “as-is” and should be used
at your own risk. Note they are from REAL cars, tuned on the rolling road at our headquarters and validated
by our agents and thousands of customers across the globe - but just like wiring ‘odditiesʼ this is no
guarantee of their suitability for your specific modifications - using a basemap for more than startup testing
prior to calibration is not advised!
There is also a vast and vibrant user community online that can offer helpful insight - check Facebook for
“ME Users”, and feel free to get involved!
Created with the Standard Edition of HelpNDoc: iPhone web sites made easy

MEITE User Manual
The Motorsport Electronics Integrated Tuning Environment, or ‘MEITEʼ for short, is the system used to
monitor, tune and modify our range of engine management products. Designed for Windows 7+, it is built
using the latest technology to give a fluid user experience, allowing as much (or as little) control as you like,
whilst still being flexible enough to grow as your knowledge and experience with the system improves.
The latest version can always be downloaded directly at www.motorsport-electronics.co.uk, and updates
can also be performed automatically from within the MEITE itself. It also takes charge of updating the
connected products inbuilt software (called firmware) to bring more features to the product as and when they
are released.
Please note that for specific products that use the MEITE, such as the ME221 ECU, there exists a separate
sections in this manual, detailing how its algorithms, options and functions work - this manual is designed
to cover your interaction with the MEITE, not the featureset of the product it is being used to tune.
Created with the Standard Edition of HelpNDoc: Free Kindle producer

Keyboard Shortcuts

MEITE KEYBOARD QUICK REFERENCE
3D TABLES (GRID VIEW)
Q / W - Coarse Adjust Up or down on currently selected cell(s)
A / S - Fine Adjust Up or down on currently selected cell(s)
ALT+S - Interpolate selected cells vertically
ALT+W - Interpolate selected cells horizontally
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EQUALS - Opens the modifier for the selected cell(s) such as +, -, % changes
BACKSPACE - Opens the “set to value box” for selected cell(s)
ALT+F - “Follow Mode” enable/disable
CTRL+ARROWS - Select cells
2D TABLES
ALT+W - Interpolate selected cells
BACKSPACE - Opens the “set to value box” for selected cell(s)
HISTOGRAMS
ALT-P - Pause/Resume all current Histograms (useful for data review after runs)
Note that you can assign different short-cuts to different functions using
the short-cuts page of the Configuration Settings.
Created with the Standard Edition of HelpNDoc: Free help authoring tool

Status Bar
The status bar at the bottom of MEITE indicates key information when connected to an ECU.

M ap Selected M ode
These three boxes indicate the currently selected Injection, Ignition and Boost tables. Configured by
switchable maps.

Status Lights
The status lights show when limiters or error-nous events have happened. You can reset a warning event by
clicking them if they are flashing. If the ECU enters that warning event again, they will relight.
INJ%
Shows if the Injectors have tripped their maximum duty levels. If this is repeatedly happening and you are
not achieving the AFR you would like, then you need to either increase fuel pressure or injector size.
SYNC
Shows the current sync status, and also, will warn if you have loss of sync (i.e trigger noise).
SC/FC
Spark Cut and Fuel Cut limiters are active if these are lit. Hovering the mouse shows the cut percent.
BST
This shows if the current manifold pressure has gone beyond the abs. maximum boost set in boost settings,
and the ECU is then limiting. You can see that both Spark Cut and Fuel Cut is taking place at this point.
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Hovering the mouse states the reason (which is also shown on the boost status DRO. You can also see
CAN Status is active (transmitting) in green.

KNK
This shows if Knock is being triggered in accordance with the Knock Settings.
CAN
Shows if Canbus is active (Green), off (Black) or in fault state (Red).
ALS/LC
Shows the status of launch control and Anti-Lag systems.

Power Cycle
If this is lit, it because you have changed a critical setting (such as engine trigger type) and therefore need
to completely power cycle the ECU for the changes to take effect.

Current Loaded M ap
If you have loaded a file, the name of the file will be shown here. If you have simply connected to an ECU,
then nothing will be shown.

Logging/Autotune
These show if MEITE based Logging or Auto-Tune are currently active.

Data
These arrows flash to show comms are happening with the connected engine management system.

Connection State and Firmware
If you are not connected, or comms have dropped, this will show red or yellow. Clicking it will force a
connection attempt. Once connected, it will be green, with the currently connected ECUs Firmware version
being display.

Comm Port
The currently chosen comm port is shown here. You can also choose which port to use here.

Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

Layouts & Display Options
Created with the Standard Edition of HelpNDoc: Free Web Help generator

Layout Manager
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The Layout Manager can be accessed from the View Menu.
It allows you to add/delete and duplicate Tabs in the software, as well as just temporarily hide them.
You can also create new layouts, import layouts sent to you, or, export layouts.
Any layouts you have worked with will appear in the drop down list at the top of the window. This is useful to
go back to Default Layouts if you make a mess of the current layouts when first experimenting. MEITE will
also prompt you on exit if you want to save the changed you have made to current layout (such as moving or
adding DROs etc). Its generally a good idea to not save the changes unless you have specifically changed
things to your liking. Most parts of the manual assume a Default Layout is used with the correct DROs etc
open.

Created with the Standard Edition of HelpNDoc: Easy EPub and documentation editor

Display Units
Analog sensors can display there data in either the internal "RAR" reading (which is a number from 0 to
65,535 representing 0-5 volts) or, direct as Volts. Thermistor channels can also be shown as Ohms
(assumed from the known internal pull-up resistances).
This will also make the sensors display (as well as be calibrated) in their HRTs in this mode also, making
calibration easier from data-sheets.
You can choose how the HRT tables display these units from the View menu.
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Created with the Standard Edition of HelpNDoc: Create cross-platform Qt Help files

Connecting to ECUs
The ME100/ME221/ME442 Wire-In offers a serial 9 pin connection. The ME221/ME442 Plug-Ins (Gen2 with
White Circuit board) offers direct USB connectivity.
Created with the Standard Edition of HelpNDoc: Easily create iPhone documentation

Serial Connection
This example covers the ME221 & ME442 Wire-In Engine Management Platform which uses an RS232
Serial Connection.
The wire-in ECUs communicates over a 9 way serial connection. While some older (and industrial) laptops
feature this connection, most modern laptops to do not, and so a Serial-to-USB adapter, such as the one
pictured below will be needed. The MEITE has been tested with genuine FTDI adapter cables. Note that
some cheaper Chinese copies may not work as effectively, so be sure to either purchase a genuine FTDI
adapter (around £25) or alternatively order direct from our website.
After connecting the comms lead to the ECU and then via the adapter to the USB port on your laptop,
Windows will look to install the drivers for the USB adapter automatically. If it fails (or you have difficulty
connecting, please download and install the latest drivers from the FTDI Website.)
The next step, with the MEITE closed, is to turn on the ignition such that the ECU is powered. If the vehicle
is fully wired then the fuel pump should prime (showing that the ECU is alive and well).
Now, you can launch the MEITE in the usual way,(Program Files>Motorsport Electronics>MEITE) and it
should automatically locate the correct communications port, and a green box should be shown in the
comms status bar at the lower right of the MEITE, to show that the system is now connected to the
controller. After a moment, a progress bar will display as the MEITE downloads the current calibration from
the ECU. You are now ready to tune the ECU, in ‘on-lineʼ mode.
If the green box is now shown, then you use the drop down box in the lower right corner to select a different
comm port, and then click ‘Connectʼ from the ECU menu or click the coloured box in the to attempt a
reconnect. Note if you have more than one comm port, be sure to try the others if you don't get a connection
initially.
Once connected the lower right will say Connected as well as the firmware version of the ECU:
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USB Connection
The MEITE installer will automatically install the correct USB drivers for the ME221/ME442 Plug-Ins.
Connect to the ECU using a standard USB A cable, turn on the ignition and then start MEITE. If it does not
automatically connect, check the comm port in the lower right, then click connect as usual.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Working with Calibrations
Calibrations are the dataset that the ECU uses to run the engine. The tuner will generally setup all the data
in a calibration therefore "matching" the ECU to your engines needs. Always be sure to start with one of our
basemaps (or one that is as close as possible, or get in touch so we can generate you one) as there are
ALOT of settings in an ECU and a missed option such as a limiter etc could stop the engine working
correctly.
Created with the Standard Edition of HelpNDoc: Free help authoring environment

Online/Offline Modes
When using the MEITE, there are two main modes of operation, on-line, and off-line.
On-line is when you are successfully connected to an Engine Management System, and the data shown is
a live representation of what is contained within the ECUʼs memory. Off-line is a mode used to edit base
maps and calibration files ‘on the benchʼ, which can at a later time be sent down to the ECU once
connected.
You can enter off-line mode by starting MEITE, and then loading a calibration (without being connected to an
ECU). MEITE will ask you to confirm you wish to work in off-line mode, and then will load all of the
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calibrations data. The DROs will be shown with greyed out text to indicate your on off-line mode, and the
lower right connection status will also show "Off-line". The bottom status bar will also show the currently
loaded calibration name.

The current connection status is shown in the status bar, at the lower right of the screen - note that the ECU
requires power to be connected. If for whatever reason communications to the ECU are lost, then clicking
‘Connectʼ from the File menu will attempt to reconnect to the ECU, and will then pull the data directly from
the ECU.
Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

Loading a Calibration
Calibration files can be loaded and saved from the File>Load/Save Calibration menus.
Loading a calibration will first attempt to send it to the currently connected device, and if the connected
device matches the definition file version of the calibration file, then it will load, and shortly after the MEITE
will reconnect to the ECU to create a mirror image of the now updated ECU. If this definition differs, then
some areas will be left unedited. For example, if you attempt to load on an older calibration which does not
use AFR target table settings, onto a more modern firmware version which does, then those areas of the
ECUʼs memory will be left untouched. When saving the file thereafter, the definition version of the calibration
will be updated to that of the connected ECU, and all data will be saved to to the file.
When loading a calibration to a connected ECU, the Load Calibration wizard (shown below) allows you to
select the areas to be loaded to the ECU - for example you can deselect everything from the list and just
highlight the “Warm-up” section - sending only those areas from the saved calibration to the ECU - allowing
partial import of different calibrations into the ECU. You should generally only load “Tuning Data Only” loading “All” will also overwrite the Input/Output settings which are factory set for your model - this can be
carried out by advanced users if they so wish however.
You can also view the calibrations notes by clicking "View Notes"
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Created with the Standard Edition of HelpNDoc: Full-featured Kindle eBooks generator

Saving a Calibration
When saving a calibration, choose the file name and directory as per normal Windows usage. The file will be
stored with the *.mecal extension. Note that when a calibration is saved, its definition file version is also
recorded, which is detailed further in the loading of calibrations.
Created with the Standard Edition of HelpNDoc: Qt Help documentation made easy

Calibration Notes
You can edit calibration notes using the ‘Notesʼ option under the File menu. The text entered is saved with
the current calibration on the PC, not the ECU - useful for tuners to keep records of what the calibration
specifics there may be when loading them in the future.
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Definition Version
The definition version is an internal system which details the layout of the memory of the ECU. For example,
a very old firmware may not have certain functions or tables, and the definition would have these areas
omitted. If you try and load a calibration that is from a different definition type (i.e it was from a different
firmware version) MEITE will inform you, and, where possible will text match entities to try to port data
across, though this should always be checked after.
When you perform a firmware update, the definition data which is also stored in the *.MEFW file is also
extracted and placed into the MEITEs dataset on the PC.
Created with the Standard Edition of HelpNDoc: Full-featured EBook editor

Working with Data
Created with the Standard Edition of HelpNDoc: Write EPub books for the iPad

The Entity Tree
The tree view on the left of the main window (shown below with the red highlight), shows all the user
accessible variables, readouts, configuration controls and data tables that the current definition file holds,
which of course relates to the areas you can view and configure within the ECU.
Any entity on the tree view can be double clicked, and its default widget type will be added to the current tab
view. Note that some widget types are specific for a data type, such as a 3D mapping table can not be used
to show current coolant temperature.
For details of all items on the Entity Tree see the entire section in the manual here.
If you have a finished layout and no longer need the entity tree view on display you can set it to autohide
from the View Menu.
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Digital Readouts (DROs)
The most simple widget is the Digital Read Out, or DRO. A DRO is used to show the value of a particular
entity, such as current coolant temperature, or battery voltage. Its text size will re-scale when resizing the
control.
To add a DRO to the current tab, for example “Engine RPM”, simply right click the ‘RPMʼ item on the entity
tree (in this case, under ‘Inputsʼ), and select DRO. The new RPM DRO item will be added to current tab,
ready for you to resize and position it.
To alter the DROs significant digits/decimal places, simply right-click, and select it from the context menu
that appears.
You can also set a Min/Max set point for a DRO, by right clicking it. The DROs colour will change to
indicate a high/low reading. This is stored in the definition file for that ECU type - so it will stay with any
ECU of that type that you then tune. Note that it also covers all DROs of the same type - so if you set it for
the RPM DRO on the mapping tab, it will also be applied to the RPM DROs elsewhere in the program.
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Using Drivers
The config or driver. widgets are specific modules to handle bespoke control settings on the ECU, such as
engine configuration, boost control settings, idle valve setup, and so on.
To edit a value, either use a drop down box or edit the text directly. Once edited, remember to press the
‘enterʼ key. The border of the Config Driver will turn red briefly (to indicate data has been sent to the ECU)
then turn green to signify that the ECU has indeed received, and stored the data. The changes will take
effect, and be permanently stored to the ECUs Flash memory - meaning a power cycle will not lose these
changes.
An example, the Injection Driver, is pictured below:
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Note that some settings require a power cycle of the ECU after making changes, the CYCLE POWER
indicator will light on the bottom status bar.
You can also import the data from another calibration using the Menu button.
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Using 2D Tables
The Two-Dimensional Table (or 2DT) allows you to edit how an output variable relates to an input, for
example, shown below, how the coolant correction amount relates to the engines coolant temperature input.
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Yellow lines and text on the view show the current live results that are being used in the ECU (when on-line).
Also, on the left of this widget is a table view where you can edit both inputs (by double clicking them) and
the outputs (by pressing backspace on a selected cell).
You can also Interpolate data by selecting a group of numbers, right clicking, and hitting "Interpolate", or by
pressing Alt-W.
You can also drag the blue nodes on the line view up and down to change the data in the graphical sense.
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When working with 2D tables, any changes you make will take effect in the ECUs operations, however, it
will not be permanently stored until you either click the ‘saveʼ button in the top right (as shown in the image
above), or change focus to another widget. If you power cycle the ECU without pressing the ‘saveʼ button,
then your changes will be lost. To indicate that changes need to be saved, the top right button will turn RED.
Once clicked, it will turn back to grey, and state ‘savedʼ (as shown below).
You can also import a tables data from another calibration using the Menu button. A good way of grabbing
sensor data from another table.
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Using 3D Maps
The 3D Map view offers the ability to view a map that is used to compute outputs based on two inputs.
Typical uses for these type of views include the fuel/VE and ignition maps.
The title specifies where the data comes from, and where the output is assigned.
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On the default ‘Grid Viewʼ (above), the current input data points are shown by the cross hair intersection
formed by the yellow lines - and note that it also considers real-time interpolation to correctly show how far
the engine or connected system is from the ‘centreʼ of the current cell.

Editing the Data
You can move around this grid using the cursor keys, and simply press ‘Qʼ or ‘Wʼ keys to
increase/decrease the current cursor locations cell by the fine amount. This can also be done with multiple
cells, selected by clicking and dragging the mouse as per normal Windows operations (akin to Excel).
To set a collection of selected cells to a value, press BACKSPACE or EQUALS key twice and enter the
desired value.

Mathematical Operations
If you wish to apply mathematical corrections or set cell(s) values directly, then either select the single cell,
or group of cells by clicking and dragging, and then press ‘=ʼ and in the pop up, you can functions as per the
examples below:
· +20 - Would add 20 to all selected cells values
· -10 - Would take 10 from all selected cells values
· *1.6 - Would times all the selected cells by 1.6
· /3 - Would divide all selected cells by 3.
· +10% - Would add 10% to all selected cells
· -15% - would remove 15% from all selected cells

Interpolation
You can also interpolate a selected group of cells by either right clicking the selected cells, and choosing to
interpolate by rows/columns from the pop up menu, or by pressing Ctrl-W for horizontal interpolation, or CtrlS for vertical interpolation.

Follow Mode
There is also a tick box named ‘Followʼ (short-cut, just hit the ‘Fʼ key to enable follow mode). With this
mode on, the current edit cursor will move around the map as the yellow cross-hairs do, moving to the most
favoured cell - this is useful when in a steady state control mode such as on an engine dyno or rolling road.
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3D View
Also, there is a ‘3D modeʼ which projects the table as a 3D wire-frame, colour scaled image. In this case
(shown below) you have a red dot which represents the engine/systems current real position, and a blue dot
which represents the cursor. The interaction keys are the same as the ‘gridviewʼ, with the addition of being
able to press (Control+Cursor Arrow) or click and drag with the mouse to rotate the view in that direction.
The follow mode also works in the same fashion in this view.

Like when working with 1D tables, any changes you make will take effect in the ECUs live operations,
however, it will not be permanently stored until you either click the ‘saveʼ button in the top right, or change
focus to another widget. If you power cycle the ECU without pressing the ‘saveʼ button, then your changes
will be lost. To indicate that changes need to be saved, the top right button will turn RED, and its text will
say ‘SAVEʼ.
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Histograms
The Histogram control is a powerful tool for real time analysis of the ECUs parameters - useful for fault
finding diagnostics as well as tuning transients such as acceleration enrichment or perfecting the PID
settings for closed loop boost control.
Right clicking an entity on the entity tree and selecting “Histogram” will add a single channel histogram view
to the current tab.

When the control is resized to a small enough size, it will show only the first channel, and also the current
highest and lowest values, as shown in the picture above, on the left - for the O2 RAW reading.
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When extended to a large enough size, it will show the full featured histogram control. The full feature mode
also shows the axis values, as well as allowing up to four channels of data to be shown on one control.
To change the displayed channels, right click the histogram and use the ‘Channelsʼ dialog to select which
data entities you would like to show.
You can also change the displayed time frame from the right-click Time Frame menu - allowing you to show
varying ranges of history - useful for using a histogram for longer term recording for example of power
run/pulls when tuning.
Another useful function is that by pressing Ctrl-P on the currently selected histogram, the real time feed is
paused (or resumed), allowing easier instant review.
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Logging
Logging is access from the Logging Menu in MEITE there are two types - logging to the PC live when
connected to MEITE, and on-board memory logging as featured in some ECU models (ME442 Range).
Created with the Standard Edition of HelpNDoc: Free HTML Help documentation generator

Logging to Local PC
The MEITE has the inbuilt feature of being able to record all data entities into a standard CSV file on the
connected PC, which can be reviewed in several free data logging applications, for example, we currently
recommend MegaLogViewer as it can easily display the CSV data. This differs from using the on-board
logging of some of the ME product range which will store the data to their internal memory for download to a
PC/laptop at a later date.
To enable data logging, while connected go to the ‘Loggingʼ menu, and from the pop-up dialogue box select
the entities you wish to log (or All/None). Make sure that the log folder at the bottom is valid, otherwise an
error will occur.
Note that when you STOP logging, the file will be created as per the file-name details set in the data-logging
dialogue box.
You can start and stop logging from the the ‘Loggingʼ menu, and the logging status is also shown in the
lower right corner of the MEITE window in the status bar. Logs are generally required by our support team to
help diagnose issues, and also for tuners use to track down intermittent problems, or simply to review the
current maps behaviour under driving conditions.
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Onboard Logging (ME442 Range)
The ME442 range features on-board logging. MEITE is used to manage logging (inducing downloading logs
to the PC) from the On-Board logging menu.
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Setting Real-Time Clock
The ME442 range (Plug-In and Wire-In) has a battery backed Real-Time-Clock that once set will keep
accurate time even when the battery is disconnected on the car. (You can access it from the Logging menu
at the top of MEITE.) The clock data is used to time-stamp log files so its easier to locate the file of choice.
The top row states the current ECU date and time. The bottom row will automatically show the computers
current time, so you can set it easily.
The CR2032 backup battery will last approximately seven years, and can be replaced if required by the
manufacturer. If you note that the date/time is being lost during power cycles, please get in touch to arrange
a service/replacement. Please note this service not covered under warranty.
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Managing Logs
You can manage the logging from the logging menu.
Be sure to set your real-time clock first so logs are correctly time-stamped.
The configuration allows you to select the channels you wish to log (using the tick boxes on the right), and
also the frequency in Hz.
The Set/Get Config. options are removed in newer firmware, as the system will automatically store any
configuration changes you make.
The "Switch Active State" option allows you choose whether to log on a High or a Low reading from a Digital
Input assigned to "Logging Enable". This is useful if you want a simple toggle switch on the dash to
start/stop logging.
You can also manual start and stop logging using the buttons in the logging dialogue. Note if you start
logging, even after cycling power, the ECU will resume logging (under a new file) once the ECU power is
resumed.

You can view the logs from the "Manage Logs" tab. All logs in memory are shown, along with the date/time
and length. You can select files to Erase, or download. Pressing 'Download' will show a progress bar and will
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save the file to your PC in a place of your choosing. The data-log will still be left on in memory if you wish to
download it again later.
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Viewing Logs
Once downloaded and saved to your PC from the Logging screen, you can use an array of programs to open
the logs downloaded from an ME442 as they are in a standard CSV comma delineated format.
Created with the Standard Edition of HelpNDoc: Free help authoring tool

Trigger Logger
The MEITE features a powerful inbuilt trigger scope for analysing waveforms seen by the ECUs Precision
Timing Module. These are used to trace faults with crank/cam sensor or for working out which pattern is
suited to your engine for correct engine position decoding.
When connected to an ECU, go to ECU Tools>Trigger Logger under the menus to bring up a new trigger
scope window on the current tab.
When ready, press START, and crank the engine (you can also just press start when the engine is running)
and you will see the scope windows begin to fill with data. When you have a few seconds worth, press
STOP.

You can see above the 36-1 pattern that is currently being fed into the ECU, as well as the fact there are no
Camshaft sensor pulses arriving.

29 / 197

Motorsport Electronics User Documentation

You can do several operations on the data:
· Use the mouse-wheel or +/- keys to zoom in and out.
· Moving the mouse cursor over the lines will show you the tooth times in milliseconds (fig 6.2)
· You can also select a block of events by RIGHT clicking in two places of the data. The amount of
rising/falling edges as well as total time elapsed is then shown.

You can also then use the MENU button in the top right of the trigger scope to save the file, which will be a
typical request from us for support when diagnosing trigger issues or adding new trigger methods.
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Updating ECU Firmware
The MEITE includes the ability to update connected ME products with new firmware versions as they
become available.
To access the Firmware Update Tool, ensure you are connected to a system in the usual manner above,
then from the main menu Tools -> Firmware update, the following dialogue will appear:
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The connected devices details are shown on the left boxes, including its product code, type and definition
file version, as well as the current firmware version on the device.
After selecting a new firmware file via the browse “...” button, (only *.mefw are supported), the new firmware
information is shown in the rightmost boxes.
Newer versions of firmware for your product may be available from our website.
Simply press ‘Updateʼ and follow the on-screen prompts. Note that any current calibration is saved to disk
automatically.

Be sure to unplug ignition coils if told to do so.
If you are updating to a newer definition file of your product, the MEITE will automatically extract and store
the new definition data from the MEFW file, and add it to its internal library of definition files, or it will
connect to our online server and download it automatically when you first connect to a new ECU. (Ensure
you have an internet connection.)
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Updating MEITE
If you have an internet connection, the MEITE will check the Motorsport Electronics servers for new MEITE
versions, and allow you to use the Update Tool to download & install them.
You can view the notes about what changes have been mad. Also, there is the option of viewing BETA
versions of MEITE which includes new features currently undergoing public testing.
Simply choose the version, and press Install then follow the on-screen prompts.
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Menu Functions
The following manual sections give a brief note about each menu option, and will generally link to the correct
section detailing the function of that item.
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File
The File Menu allows the Loading & Saving of Calibrations, the editing of a calibrations Notes, as well as
exiting of MEITE.
Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Save a Calibration File
Please see here.
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Load a Calibration File
Please see here.
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Calibration Notes
Please see here.
Created with the Standard Edition of HelpNDoc: Easily create EPub books

Exit
This will close MEITE. If you have changed the layout you will be prompted if you wish to keep the changes.
Created with the Standard Edition of HelpNDoc: Easy EPub and documentation editor
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ECU
Created with the Standard Edition of HelpNDoc: Free EPub and documentation generator

ECU Tools
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View
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Autohide Entity Tree
This option when ticked will cause the entity tree on the left of the main screen to auto-hide unless the
mouse is moved over it. This frees up some screen space.
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Logging
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Help
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About
The About box, as well as presenting contact details for Motorsport Electronics, also displays the ECU
Firmware version, definition file version and MEITE version information - critical for technical support issues and required in any support discussions.
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Wiring & Physical Installation
This section details individual wiring guides and instructions for various inputs, outputs and genera, install
info. It should be followed first when installing your ECU. Note that Plug-In ECUs have their own specific
Hardware Install Guides which can be found on our website under support.
Created with the Standard Edition of HelpNDoc: News and information about help authoring tools and
software

Sensors
Sensors are used by the ECU to determines the engines position and fuel requirements.
The critical "Fuel" sensors include:

·
·
·
·

Manifold Pressure Sensor
Throttle Position Sensor
Coolant & Inlet Air Temperature Sensors
O2/Lambda Feedback (Optional)

Also for the engines position tracking the following sensors are required:

·
·

Crank Position Sensor
Cam Position Sensor(s) (Optional for fully sequential and VVT operation)

Some example wiring guides for sensors are shown in the relevant wiring guides for ME100/ME221 and
ME442 Wire-Ins, such as the diagram below.

Typical assignments for the above wiring:

34 / 197

Motorsport Electronics User Documentation

Created with the Standard Edition of HelpNDoc: Easily create EPub books

Analog Voltage Inputs (Throttle, MAP, Lambda)
Analog Voltage Inputs (Assignable V# in the Analog Settings and ANA Vx in Pinout/Wiring Diagrams) are
direct 0-5V inputs to the ECU.
They should be used with sensors that generate a voltage output (such as Throttle, MAP, MAF, Lambda
etc). You would then assign the chosen channel to correct sensor "RAW", such as TPS RAW in the
Analog Settings.
They are protected, high impedance inputs, which means they can be wired in parallel with stock ECUs if
required and won't effect the stock ECUs reading.
Over-voltage (over 5v) should be avoided where possible as damage to the input can occur if excessive
repeated over-voltage spikes occur.
You can see some examples of these sensors wired to the ME442 here.

Extra Temperature Inputs
Note you can also wire thermistor/resistive sensors to these voltage inputs, but you will need to fit a 2700
ohm pull-up resistor (such as these) to the input and the 5V REF supply, such as the diagram below:
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Analog Temp. Inputs (Coolant, IAT, Oil Temp.)
Analogue Temperature Inputs (T# in the Analog Settings and ANA Tx in Pinout/Wiring Diagrams) are direct
0-5V inputs to the ECU that feature a 2,700 Ohm pull-up to 5V internally.
They should be used with sensors that offer a varying resistance to ground, such as temperature
thermistors.
Because the internal pull-up reference is known (2K7 to 5v), you can set MEITE to show the measured
resistance (in ohms) of these sensors when working with them, making calibrating them easier.
They are protected, high impedance inputs.
Over-voltage should be avoided where possible as damage to the input can occur if excessive repeated overvoltage spikes occur.
A diagram of the Thermistor (for example a coolant or IAT 2 pin sensor) based circuit is shown below.
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The resultant voltage at the ANA-T pin is then read by the ECUs ADC Systems block, which then reports
this to the control algorithms.
A couple of a examples of how this works:
If the NTC Thermistors value matches the internal 2,700 ohms, then the ADC System will read ½ of the 5V
internal reference, so 2.5 volts.
If the NTC Thermistor is disconnected (infinite resistance to ground) then the ADC System will simply read
the 5V directly - (if you see 5V or very close to it on an ANA-T pin, then you may have either broken wiring
or a faulty sensor.)
If the ANA-T pin is shorted to ground then the RAW/Sensor System will read ZERO volts - again a good
diagnostic step if you think a sensor may be faulty is to bridge its wiring - if you see the RAW/Sensor
System drop to approx. 0 volts, then you know the wiring is OK.
If you see no change, then you have a wiring or assignment fault.
Enter your sensors calibration data directly into MEITE under the HRT tables, for the chosen sensor you
have mapped the input to from the Inputs->ADC Settings.
Always sanity check the readings after doing so.
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Throttle Position Sensor
The throttle position sensor provides feedback to the ECU to ascertain enrichment when “pumping” the
throttle, or if running in Alpha-N mode where Load is determined by throttle position, to determine the load
input for the VE equation. It is also used for an array of other systems such as idle control, so it is important
to have a working and calibrated throttle sensor.
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Most throttle sensors are three-wire. They require a 5V reference, a ground, and then output a 0-5v signal
dependant on the position of the sensors shaft in relation to its body..
On most sensors, the centre pin is signal. It doesn't matter which way you wire the 5v reference or ground
as the software will automatically compensate if they are wired back to front. However, if possible, you
should aim for the sensors signal output wire to be near 0V when the throttle is closed, and near 5V when
the throttle is wide-open.
You can calibrate it manually by entering voltages into the TPS HRT table (after assigning the TPS RAW
channel to correct ANA-V input in IO Settings), or, use the TPS Wizard, which can be found under the Tools
Menu.
Simply follow the on-screen instructions and your TPS will be correctly calibrated.
An example of wiring a throttle sensor for the ME442 is shown here as part of the basic sensors..
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Manifold Pressure Sensor
If you plan to run a turbo/supercharger, or if you are using a stock plenum, then it would be wise to use
MAP (Manifold Absolute Pressure) for primary load (in the Injection Driver settings as before), and as a
result, it is important to install and calibrate a MAP sensor.
For naturally aspirated setups, such as throttle bodies, you may wish to use throttle for load (a system
called ‘Alpha-Nʼ fuelling) and as a result you may not want to even install a MAP sensor. In this case, it is
important to set the MAP HRT to always read 100KPa - as shown in the above image, by setting the entire
tables ‘MAPʼ column to 100. This means the fuelling algorithm will not be affected by MAP readings.
If youʼre using a MAP sensor, then it should be calibrated. Most MAP sensors include a data sheet, that
illustrate their voltage output based on the pressure they are exposed to. Below is an excerpt from a MAP
sensors datasheet from the web - note these numbers will vary depending on the sensor, and that they
usually specify the pressures in ABSOLUTE terms, that is, 0KPa being a perfect vacuum, approx 100KPa
being atmospheric air pressure at seal level (or 1 Bar), 200Kpa representing 1 Bar of Boost (i.e 1 Bar above
atmospheric), and so on.
The 3-Bar (up to 300KPa) MAP sensor we supply has the following pinout, and its HRT table is also shown
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below.

39 / 197

Motorsport Electronics User Documentation

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

Lambda Sensors

Narrow-Band Lambda Sensor
If using a simple narrow band sensor (that outputs 0-1V depending on mixture being rich/lean) then connect
its signal wire directly to your chosen Analog V input, and its ground to the sensor ground pin of the ECU.
It may also have a heater element. Connect one wire of this to the chassis ground, and other to the power
feed for the fuel pump, so that the heater only operates when the engine is running.
For more information on configuring Lambda sensors please see the Lambda Sensors section.
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Flex Fuel Sensor
Flex sensors output both fuel temperature and ethanol content via a pulse-width-modulated signal. The ME
platform supports the common GM & Continental Flex Fuel Sensor. See here for details on Flex Fuel
Strategies.

GM Sensor
Wire its signal line direct to a chosen Digital Input line and set that chosen pin to “Ethanol Sens.” from
within MEITE to enable advanced Flex Fuel monitoring and control strategies. Connect up as per the image
below:

40 / 197

Motorsport Electronics User Documentation

Continental Sensor
The Continental Ethanol sensor has a part number of A2C53344228. It can be wired with its signal direct to
the Digital Input of your choice. You can see the pin-out is written on the connector in the below image. Vdd
should go to an ignition switched live, Out, is the signal (wire to your chosen Digital Input and set that input
to “Ethanol Sens.” from within MEITE to enable advanced Flex Fuel monitoring and control strategies.), and
Gnd should go to sensor ground.
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Crank/Cam Sensors
Note you should always use suitable shielded cable for crank and camshaft sensor wiring, with the shield
earthed at ONE end only (usually the ECU end).
A crank sensor is critical for the ECU to maintain correct engine angle tracking - issues here can lead to
misfires, non-starting and even engine damage, so always ensure you carry out any testing needed to rule
out crank sensor faults if an issue presents itself.
There are typically two types of sensor on the market, VR (or variable reluctance) and Hall.
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VR type sensors do not require power, and instead, generate an AC voltage as metal teeth on the crank
pulley/flywheel casting fly past it, whereas Hall sensors require a power supply, and output a DC square
wave based on whether a tooth is currently under the sensor, or not.
VR Sensors should be wired to VR Crank/VR Cam inputs +/- connections, while Hall sensors should be
wired to Digital Inputs on the ME442 Wire-In, or the ME221/ME100, use a pull-up on the signal line of the
Hall sensor (a 1K resistor to 5V REF usually suffices) and connect this to VR+. Leave VR- unconnected in
this case.
Be careful to route the wiring away from any sources of electrical noise such as starter motor, alternator or
the HT ignition system.
The guide on setting up triggering, and more info specifically on trigger wheels, can be found here.
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Knock Sensors
The ME range of ECUs are designed to use the Bosch Wideband Knock Sensor as per one we list on our
website. It is essentially a microphone that the ECU is tuned to listen for the "pinging" sound when knock
occurs. This is done via the Knock Settings on the ECU.
The sensor should be bolted to the engine block. Most engines have an OEM mounting point for the knock
sensor.
They have 2 pins, and use a standard mini-timer type connector. Simply wire the sensor Pin 1 (left most pin
in the below picture) to the Knock +Ve/Knock Signal Pin and the other Pin to Ground (Sensor ground
preferred, such as the Ground available on the Auxiliary plug on Plug-In systems.)
Shielded twin core cable should be used, with the shield being connected to the chassis of the car.

43 / 197

Motorsport Electronics User Documentation

Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator

Wheel Speed Sensors
If you are using HALL based sensors that are “open-collector” type (they usually have three connections,
power, ground and signal) then you can simply wire their signal line into the chosen Digital Input and set its
function in MEITE to capture pulses for VSS/Traction Control.
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Sensor Grounds
On the ME442 Wire-In, sensor grounds should go to Pin 52. On the ME221 Wire-In, they should go to pin
28. Plug-ins usually have a Ground reference connection on their auxiliary connection.
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EGT Sensors
Exhaust Gas Temperature K-Type Thermocouple sensors can be wired directly into the ME442 Plug-Ins and
the ME442 Wire-In. For the ME221 variants,m you will need an external K-Type amplifier.
To connect them, use suitable thermocouple wire.and link the "positive" wire to the EGT signal input (eg.
EGT1 on the ME442) and the "negative" wire of the EGT sensor to the sensor ground pin of the ECU.
Install the Sensor into the manifold/exhaust as indicated by the supplier of the sensor.
See the EGT Sensors section on using the data provided by the sensors.
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Outputs
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Injectors
The ME ECU range has several injection channels (4 on the ME221 Wire-In, 8 on the ME442 Wire-In/PlugIn) each of which is capable of driving several high impedance injectors.
(An injector is considered to be high impedance if its resistance is larger than 12 ohms. Low impedance
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injectors are usually under 4 ohms impedance across their two terminals).
Generally however, the ECU will use only four of these channels to drive injectors fully sequentially on a four
cylinder engine.
The Injector should receive a switched 12V ignition supply on one terminal, and the second terminal should
be routed to the required injector pin on the ECU.
You can also choose to wire the injectors in batch. You can run any number of injectors on a channel - as
long as the resultant impedance does not fall under 4 ohms.
(Each Injectors Impedance) divided by (Total Injectors per driver/channel) equals (Total Impedance per
channel)
To calculate this use the following examples as a guide:
We have 4 injectors, each being 16 Ohms:
16/4 = 4 :: OK to run on one channel.
We have 8 injectors, each being 12 Ohms:
12/8 = 1.5 :: Cannot be ran on one channel so instead, we can run the injectors split over 4 channels..
We have 8 injectors, each being 12 Ohms, and we intend to run them over 4 channels - the equivalent of 2
injectors per channel:
12/2 = 6 :: OK
If you plan to run LOW impedance injectors, then ballast resistors should be used. Please contact
Motorsport Electronics Limited for more information on this.
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Fuel Pump Relay
You can use one of the ME ECUs Slow/Relay Low Side (LS) drivers to drive the fuel pump. Note this must
be done via an automotive four-pin relay as fuel pumps can draw 20+ Amps. Please note the diagram below
on how to achieve this:

The fuel pump will turn on and ‘primeʼ for a few seconds with the ignition becoming live, then turn off. It will
then only run again when the ECU detects an RPM of the engine - this safety feature means in the event of
an accident, the fuel pump will turn off if the engine stalls.
Note this is a great initial indicator that power and the ECU is all working - if you don't hear the fuel pump
prime after turning the key on, then its time to check fusing and wiring - it is the most basic in-built ‘testʼ
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feature of the ECU.
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Relay Low Side Outputs
Low side relay outputs should be sued to drive relays or slow acting solenoids, such as purge valves etc. An
example (for a fuel pump) of wiring them is shown below:
They are LOW SIDE driver, meaning when ON they allow a connection to GROUND. They can flow up to 1A
per channel, and are over-current and temperature protected.
For more information about their configuration, please see here.
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PWM Low Side Outputs

ME442 Wire-In PWM Low Side Outputs
Note that LS 1 to LS 8 are 1.2A current limited LOW side PWM outputs while LS 9 and LS 10 are 6A
current limited flyback-protected PWM outputs.

ME100/ME221 Wire-In PWM Low Side Outputs
All LS1-LS7 (ME100) and INJ1-4 and LS1-3 (on ME221) are 6A, PWM capable Low Side channels. They do
not have fly-back diodes installed, so will need them if driving PWM or Inductive loads.

ME221/ME442 Plug-In
Please refer to the Hardware Install guide for your model for details on spare outputs.

Created with the Standard Edition of HelpNDoc: Easily create EBooks
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Flyback Diodes
If you are using a low side output on the ME100 or ME221 to drive an inductive load (such as a VVT or Idle
solenoid) you should install a flyback diode across the two wires that go to it. Use a 1N4001 diode, with the
striped end Tee'd into the 12v supply, and the other end Tee'd into the LS signal line.
Note if you are driving simple outputs such as relays for fuel pump, cooling fans, shift lights, etc, then you
do not need to install these diodes.
1n4001 diodes can be found on electronics suppliers such as RS Components. RS number 628-8931
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Water Methanol Wiring
Water methanol systems usually consist of simply a 12V pump that when triggered by the Water Methanol
Settings is then energized. The metering of the methanol is controlled by the chosen nozzle size in the
pipework.
Wire as per below, using a relay to drive the pump to avoid over-current loading the outputs. Any LS
(including PWM, Relay or Injector) output can be used, and its mapping in IO settings should be set to
"Water Inj.".

Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Coiil-On-Plug (COPS) Install
Instead of using OEM ignition systems, or wasted spark coil packs, Gen2 ME Plug-Ins and ME442 Wire-Ins
allow the use of TTL/Active Triggered Coil-On-Plug upgrades.
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COPs by definition can be very electrically noisy. When replacing OEM wiring, be sure to ground the COPs
to the cylinder head using a suitable eyelet. Failure to do so can cause USB communication issues. You
can also install a 10,000uF capacitor across the 12V supply to the COPs and the ground near the COP
units to further add noise immunity.
Most opt to run the ignition sequentially, that is, to fire each cop once per 720* Engine cycle. This requires
the correct settings in the Ignition Driver (Fully Sequential) as well as assigning the correct ignition channels
in the Output Settings.
The Ignition Trigger Pins can be found in the relevant products wiring diagram. Note the Plug-Ins usually use
the original trigger lines for the OEM coils so new wiring can be ran from the OEM pins, and then additional
trigger lines for coils 3 and 4 will come from the Auxiliary connector. Plug-In specific information can be
found here.

Common Coil Pin Outs
VAG/Audi R8 COPs

Pin 1 - 12V Power
Pin 2 - Signal Ground
Pin 3 - Trigger Signal
Pin 4 - Power Ground

Toyota/Denso COPs
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Pin 1 - Power Ground
Pin 2 - Trigger Signal
Pin 3 - Tacho Pulse
Pin 4 - 12V Power
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Wire-In ECUs
The following sections contain pinout information for our Wire-In ECUs, such as the ME100, ME221 and
ME442.
Created with the Standard Edition of HelpNDoc: Free Web Help generator

ME100/ME221 Gen1 Wire-In
The following sections are for the Gen1 ME100 & ME221 Wire Ins. The product is pictured below:
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ME100/ME221 Wire-In Pinout

ME100/ME221 Pin-out & Wiring Diagram
The below picture illustrates the pin-out orientation. Note that the ECU is shown, so the number represent the
‘backʼ of the wiring harness connectors, or ‘wire-sideʼ.
The wire connectors are TE Parts, available from electronics suppliers such as RS or mouser.com:
The 12-Way Plug is TE Part Number 175965-2
The 16 Way Plug is TE Part Number 175966-2
The Crimps (28 needed) are TE Part Number 175265-1

PIN

Name / Function

Our Loom Colour (Base/Stripe)

1

Injector 4 (LS7 on ME100)

GREEN/ORANGE

2

Low Side Output 3 (LS3)*

BLUE/RED
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3

Low Side Output 2 (LS2)*

BLUE/BROWN

4

Injector 2 ((LS5 on ME100)

GREEN/BROWN

5

Injector 1 (LS4 on ME100)

GREEN/BLACK

6

Low Side Output 1 (LS1)*

BLUE/BLACK

7

Injector 3 (LS6 on ME100)

GREEN/RED

8

Tachometer Output (12V)

BROWN

9

GROUND

BLACK

10

Coil A / 1 (Cylinders 1 & 4)

BLUE

11

GROUND

BLACK

12

Coil B / 2(Cylinders 2 & 3)

GREEN

13

12V Ignition Switched Power (5A
Fused)

RED

14

5V Reference Output

PURPLE

15

CAM Sensor +ve

WHITE in SHIELDED RED

PIN

Name / Function

Loom Colour (Base/Stripe)

16

CRANK Sensor -ve (leave
unconnected for hall/opto)

BLUE in SHIELDED BLACK

17

HS_Digital_Input_2

RED/WHITE

18

Intake Air Temperature Signal
(Pulled up via 2K7 Ohms)

ORANGE

19

Coolant Temperature Signal
(Pulled up via 2K7 Ohms)

YELLOW

20

O2 Sensor Signal (0-5v, Narrow or
Wideband)

RED/BLACK

21

Knock -ve

BLUE

22

CAM Sensor -ve (leave
unconnected for hall/opto)

BLUE in SHIELDED RED

23

CRANK Sensor +ve

WHITE in SHIELDED BLACK

24

Knock +ve

White

25

Spare Analog 1 (0-5v)

RED/BLUE

26

MAP Sensor Signal

GREY

27

TPS Sensor Signal

PINK

28

Analog/Sensor Ground

BLACK

*be sure to install flyback diodes if needed on LS lines.
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ME100/ME221 Plug-In Harnesses
The ME100 and ME221 have the option of plug-in harnesses. The standard connectors are labelled for ease
of installation, however, there is also an "Aux" bundle.

The group of red wires should be fed a fused ignition switched live (Fuse with 10A is typical.) The group of
Black wires are the grounds and should run to a clean chassis earth.
Please note the assignment tables below do you can us the "Aux" spare wires for other functions.

'Aux' Wire Colour

ME Connection (Pin)

Brown

Tacho (8)
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Red (black stripe)

O2 Signal (20)

0-5v Analog Input

White

Knock +Ve (24)

Knock Sensor Signal

Blue

Knock -Ve (21)

Knock Sensor Ground

Blue/Black Stripe

Low Side 1 (6)

Blue/Brown Stripe

Low Side 2 (3)

Spare PWM Low Side

Red/White Stripe

Digital Input 2 (17)

Can be used for VSS

Red/Purple Stripe

Spare Analog 1 (25)

0-5v Analog Input

Typically used to switch Fuel Pump Relay (suppl

If you wish to use Digital Input 2 or Spare Analog 1 as Digitial Inputs, note you should install a 10K resistor
to 5v as shown in the Spare Analog Guide here.
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ME442 Wire-In
The following section deals specifically with the ME442 Wire-In ECU, as pictured below.
The Connectors and Crimps are FCI, and can be ordered direct from us at Motorsport Electronics.
Unterminated and Pre-Terminated loom options for specific engines are also available.
There are further sections here including:
· Physical Installation
· Standard ME442 Wire-In Pin-out
· Power/Ground
· Communications (including CAN-Bus)
· Basic Sensors
· Lambda Sensors (Including Wideband Lambda)
· Trigger Sensors (Crank/Cam)
· Coil/Ignition Outputs
· Injector Outputs
· Fuel Pump and Cooling Fan Outputs
· General Low-Side Outputs
· Drive-by-Wire Connections
· Idle Connections
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Physical Installation
The ME442 is IP67 sealed against dust and water ingress, and as a result, it is safe to install in the engine
compartment. Do not install near extreme temperatures such as the exhaust manifold or turbocharger. The
metal casing does not need to be earthed, but it does not harm it to do so. The FCI 90 way connector is
also fully waterproof when correctly assembled with rubber boots etc.
For crimping connections, the FCI tool used by our looming factory to crimp the cables is over £2,000, so
may not be viable for most small workshop installs - to that end a normal Mini-Timer type crimp tool can be
used such as the Durite 0-703-53. Crimps for the main header are part number: 211CC2S1160P
The four 6mm mounting holes are rectangularly arranged with centres at 85x194mm.
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ME442 Wire-In Pinout (REV C)
Crimps for the main header are part number: 211CC2S1160P
MATCHES ME442 V2.0 REV C
Pin

Function

Notes

1

COIL 4

IGBT 20A MAX

2

COIL 3

IGBT 20A MAX

3

INJECTOR 4

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

4

INJECTOR 2

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

5

DIG_IN 4

PULLED HIGH WEAK 5V

6

DIG_IN 1

PULLED HIGH WEAK 5V

7

DIG_IN 2

PULLED HIGH WEAK 5V

8

DIG_IN 3

PULLED HIGH WEAK 5V

9

LOW SIDE 18

500mA RELAY (SLOW) DRIVE

10

GROUND CHASSIS

H_BRIDGE GROUNDS (CHASSIS)

11

EGT 1

EGT 1 K-Type +ve Input

12

LOW SIDE 2

2.5A PWM-ABLE

13

LOW SIDE 15

500mA RELAY (SLOW) DRIVE

14

VBAT IGNITION

BATTERY VOLTAGE SUPPLY (SWITCHED IGNITIO

15

VBAT IGNITION

BATTERY VOLTAGE SUPPLY (SWITCHED IGNITIO

16

LSU HEATER -VE

17

ANA VOLT 3

0-5V ANALOG PROTECTED INPUT

18

ANA VOLT 4

0-5V ANALOG PROTECTED INPUT

19

LSU UN
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20

LSU VM

21

CAN 1 HIGH

22

CAM A VR+

23

CAM A VR-

24

SERIAL 1 GROUND

SERIAL COMMS GROUND

25

SERIAL 1 TX

SERIAL COMMS TRANSMIT RS232 LEVEL

26

ANA VOLT 1

0-5V ANALOG PROTECTED INPUT

27

INJECTOR 8

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

28

INJECTOR 5

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

29

COIL 7

IGBT 20A MAX

30

COIL 8

IGBT 20A MAX

31

COIL 2

IGBT 20A MAX

32

COIL 1

IGBT 20A MAX

33

INJECTOR 3

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

34

DIG_IN 6

PULLED HIGH WEAK 5V

35

CAN 2 LOW

--

36

CAN 2 HIGH

--

37

LOW SIDE 11

3.5A PWM-ABLE FLYBACK PROTECTED

38

LOW SIDE 10

3.5A PWM-ABLE FLYBACK PROTECTED

39

LOW SIDE 6

2.5A PWM-ABLE

40

LOW SIDE 17

500mA RELAY (SLOW) DRIVE

41

LOW SIDE 7

2.5A PWM-ABLE

42

LOW SIDE 12

500mA RELAY (SLOW) DRIVE

43

LOW SIDE 14

500mA RELAY (SLOW) DRIVE

44

LOW SIDE 4

2.5A PWM-ABLE

45

LOW SIDE 9

7A PWM-ABLE FLYBACK PROTECTED

46

5V REF

500mA MAX 5V SENSOR SUPPLY

47

ANA TEMP 4

THERMISTOR INPUT PULLED TO 5V via 2K7

48

ANA VOLT 7

0-5V ANALOG PROTECTED INPUT

49

LSU IA

50

LSU IP

51

CAN 1 LOW

CAN 1 LOW

52

SENSORS GROUND

SENSOR & COMMS GROUND AND VR SHEILDS

53

KNOCK 1 SIGNAL

KNOCK DSP 1

54

KNOCK 2 SIGNAL

KNOCK DSP 2

55

SERIAL 1 RX

SERIAL COMMS RECIEVE RS232 LEVEL

56

ANA VOLT 2

0-5V ANALOG PROTECTED INPUT

57

ANA TEMP 2

THERMISTOR INPUT PULLED TO 5V via 2K7

58

INJECTOR 6

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

59

COIL 5

IGBT 20A MAX

60

COIL 6

IGBT 20A MAX

61

GROUND (INJECTORS 1/2/3/4) POWER GROUND TO CHASSIS

62

DIG_IN 5

PULLED HIGH WEAK 5V

63

INJECTOR 1

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

64

VBAT (H-BRIDGE SUPPLY)

BATTERY VOLTAGE SUPPLY (SWITCHED IGNITIO

CAN 1 HIGH
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65

H-BRIDGE A OUT 1

DBW H-BRIDGE

66

H-BRIDGE A OUT 2

DBW H-BRIDGE

67

H-BRIDGE B OUT 1

DBW H-BRIDGE

68

H-BRIDGE B OUT 2

DBW H-BRIDGE

69

LOW SIDE 5

2.5A PWM-ABLE

70

LOW SIDE 16

500mA RELAY (SLOW) DRIVE

71

LOW SIDE 19

500mA RELAY (SLOW) DRIVE

72

LOW SIDE 13

500mA RELAY (SLOW) DRIVE

73

LOW SIDE 1

2.5A PWM-ABLE

74

LOW SIDE 3

2.5A PWM-ABLE

75

LOW SIDE 8

7A PWM-ABLE FLYBACK PROTECTED

76

5V REF

500mA MAX 5V SENSOR SUPPLY

77

ANA TEMP 3

THERMISTOR INPUT PULLED TO 5V via 2K7

78

ANA VOLT 6

0-5V ANALOG PROTECTED INPUT

79

TACHOMETER

200mA 12V PWM-ABLE

80

CRANK VR-

81

CRANK VR+

82

CAM B VR-

83

CAM B VR+

84

CAM C VR+

85

CAM C VR-

86

ANA TEMP 1

THERMISTOR INPUT PULLED TO 5V via 2K7

87

ANA VOLT 5

0-5V ANALOG PROTECTED INPUT

88

INJECTOR 7

2A CONSTANT PROTECTED (6ohm Min Hi Imp)

89

EGT 2

EGT 2 K-Type +ve Input

90

GROUND (INJECTORS 5/6/7/8) POWER GROUND TO CHASSIS
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Unterminated Wire Colours
Our unterminated ME442 harnesses have the pin number written on each wire, as well as being colour
coded to the below table set:
Function

Notes

Wire Colour

COIL 4

IGBT 20A MAX

White/Orange

COIL 3

IGBT 20A MAX

White/Red

INJECTOR 4

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Orange

INJECTOR 2

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Brown

DIG_IN 4

PULLED HIGH WEAK 5V

Blue/Orange

DIG_IN 1

PULLED HIGH WEAK 5V

Blue/Black

DIG_IN 2

PULLED HIGH WEAK 5V

Blue/Brown

DIG_IN 3

PULLED HIGH WEAK 5V

Blue/Red

LOW SIDE 18

500mA RELAY (SLOW) DRIVE

DG/Dashed Blue

GROUND CHASSIS

H_BRIDGE GROUNDS
(CHASSIS)

Black
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EGT 1

EGT 1

DG/Purple

LOW SIDE 2

2.5A PWM-ABLE

DG/Brown

LOW SIDE 15

500mA RELAY (SLOW) DRIVE

DG/Dashed Orange

VBAT IGNITION

BATTERY VOLTAGE SUPPLY
(SWITCHED IGNITION)

Red

VBAT IGNITION

BATTERY VOLTAGE SUPPLY
(SWITCHED IGNITION)

Red

LSU HEATER -VE

Brown

ANA VOLT 3

0-5V ANALOG PROTECTED
INPUT

DO/Red

ANA VOLT 4

0-5V ANALOG PROTECTED
INPUT

DO/Orange

LSU UN

Brown/White

LSU VM

Brown/Blue

CAN 1 HIGH

CAN 1 HIGH

Yellow/White

CAM A VR+

White inside Sheidled

CAM A VR-

Blue inside sheilded

SERIAL 1 GROUND

SERIAL COMMS GROUND

Black

SERIAL 1 TX

SERIAL COMMS TRANSMIT
RS232 LEVEL

Yellow/White

ANA VOLT 1

0-5V ANALOG PROTECTED
INPUT

DO/Black

INJECTOR 8

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Purple

INJECTOR 5

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Yellow

COIL 7

IGBT 20A MAX

White/Blue

COIL 8

IGBT 20A MAX

White/Purple

COIL 2

IGBT 20A MAX

White/Brown

COIL 1

IGBT 20A MAX

White/Black

INJECTOR 3

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Red

DIG_IN 6

PULLED HIGH WEAK 5V

--

CAN 2 LOW

--

--

CAN 2 HIGH

--

--

LOW SIDE 11

3.5A PWM-ABLE FLYBACK
PROTECTED

Red/Blue

LOW SIDE 10

3.5A PWM-ABLE FLYBACK
PROTECTED

DG/Dashed Grey

LOW SIDE 6

2.5A PWM-ABLE

DG/Green

LOW SIDE 17

500mA RELAY (SLOW) DRIVE

DG/Dashed Green

LOW SIDE 7

2.5A PWM-ABLE

DG/Blue

LOW SIDE 12

500mA RELAY (SLOW) DRIVE

DG/Dashed Black

LOW SIDE 14

500mA RELAY (SLOW) DRIVE

DG/Dashed Red

LOW SIDE 4

2.5A PWM-ABLE

DG/Orange

LOW SIDE 9

7A PWM-ABLE FLYBACK
PROTECTED

DG/Dashed White

5V REF

500mA MAX 5V SENSOR
SUPPLY

Purple
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ANA TEMP 4

THERMISTOR INPUT PULLED TO
5V via 2K7
DO/Blue

ANA VOLT 7

0-5V ANALOG PROTECTED
INPUT

DO/Blue

LSU IA

Brown/Yellow

LSU IP

Brown/Green

CAN 1 LOW

CAN 1 LOW

Yellow/Green

SENSORS GROUND

SENSOR & COMMS GROUND
AND VR SHEILDS

Black/White

KNOCK 1 SIGNAL

KNOCK DSP 1

KNOCK 2 SIGNAL

KNOCK DSP 2

SERIAL 1 RX

SERIAL COMMS RECIEVE
RS232 LEVEL

Blue

ANA VOLT 2

0-5V ANALOG PROTECTED
INPUT

DO/Brown

ANA TEMP 2

THERMISTOR INPUT PULLED TO
5V via 2K7
DO/Dashed Brown

INJECTOR 6

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Green

COIL 5

IGBT 20A MAX

White/Yellow

COIL 6

IGBT 20A MAX

White/Green

GROUND (INJECTORS 1/2/3/4)

POWER GROUND TO CHASSIS

Black

DIG_IN 5

PULLED HIGH WEAK 5V

--

INJECTOR 1

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Black

VBAT (H-BRIDGE SUPPLY)

BATTERY VOLTAGE SUPPLY
(SWITCHED IGNITION)

Red

H-BRIDGE A OUT 1

DBW H-BRIDGE

Grey/Red

H-BRIDGE A OUT 2

DBW H-BRIDGE

Grey/Blue

H-BRIDGE B OUT 1

DBW H-BRIDGE

Grey/Green

H-BRIDGE B OUT 2

DBW H-BRIDGE

Grey/Orange

LOW SIDE 5

2.5A PWM-ABLE

DG/Yellow

LOW SIDE 16

500mA RELAY (SLOW) DRIVE

DG/Dashed Yellow

LOW SIDE 19

500mA RELAY (SLOW) DRIVE

DG/Dashed Purple

LOW SIDE 13

500mA RELAY (SLOW) DRIVE

DG/Dashed Brown

LOW SIDE 1

2.5A PWM-ABLE

DG/Black

LOW SIDE 3

2.5A PWM-ABLE

DG/Red

LOW SIDE 8

7A PWM-ABLE FLYBACK
PROTECTED

DG/Grey

5V REF

500mA MAX 5V SENSOR
SUPPLY

Purple

ANA TEMP 3

THERMISTOR INPUT PULLED TO
5V via 2K7
DO/Dashed Red

ANA VOLT 6

0-5V ANALOG PROTECTED
INPUT

DO/Green

TACHOMETER

200mA 12V PWM-ABLE

Yellow

CRANK VR-

White inside Sheidled Black

CRANK VR+

Blue inside sheilded Black
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CAM B VR-

White inside sheilded Blue

CAM B VR+

Blue inside shielded Blue

CAM C VR+

White inside sheilded Green

CAM C VR-

Blue inside sheidlded Green

ANA TEMP 1

THERMISTOR INPUT PULLED TO
5V via 2K7
DO/Dashed Black

ANA VOLT 5

0-5V ANALOG PROTECTED
INPUT

DO/Yellow

INJECTOR 7

2A CONSTANT PROTECTED
(6ohm Min Hi Imp)

Pink/Blue

EGT2

EGT 2

--

GROUND (INJECTORS 5/6/7/8)

POWER GROUND TO CHASSIS

Black
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Power/Ground Connections

Power Grounds
The ME442 features multiple power ground pins.
They should be earthed directly to the chassis. These allow current from the injectors, coils,
DBW system and low-side switches to flow back to ground (battery negative).
Sensor Ground
All sensors should return to Pin 52 as a protected sensor ground.
Ignition 12V
Ignition 12V lines should be connected to a 12V (Ignition Live) line that becomes active on
ignition only. Typically this would be fused as part of the EFI fusing at around 10-20A
(dependant on amount of coils, outputs etc). No ECU settings will be lost during ECU power
off/storage. The data-logging Date/Time clock is kept running by an internal battery backup (see
below). Note you will NOT be able to connect to the ECU with MEITE without it being powered.
Be sure this supply line stays powered during cranking, as some ignition barrels do not! Always
check for 12V when cranking if you seem to have issues starting.
Internal Battery
The ME442 houses an internal CR2032 battery (good for over 7 years) to keep the real-timeclock running even when the power is removed. This is used primarily for the engine log-book
and datalogging time-stamp. Motorsport Electronics offers a replacement service for this
battery.
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Communications (RS232 & CAN)

Serial Data Communication
The serial connection is rated at 115kbps and 230kbps with auto switching based on bandwidth requirement
and SNR. A good quality serial lead should be used for connection to the tuning laptop/PC, as well as a
genuine FTDI Serial -> USB Cable.
If you are using a semi or fully terminated wiring loom, then a female DB9 connection will already be
provided at the main connector. If you have opted for a plug/pins system, then you will need to make up the
connections as follows. Use a female DB9 connection to allow a PC/Laptop to connect via a straight through
extension cable and then a genuine FTDI Serial -> USB adaptor can be used.
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Note that some older laptops with in-built serial ports may not work with the ME221/ME442 due to not
supporting the higher speed. You should always use an FTDI Serial -> USB adaptor where possible. Prolific
and CH304 Chinese clones are NOT supported.
Always be sure to install the latest FTDI Serial/USB drivers which can be downloaded from the support
section of our website.

CAN-Bus Communications
The ME442 houses dual 2.0b compliant CAN transceivers. Note that the line is not terminated inside the
ME442, so a termination resistor will be required if the ME442 is at the end of the bus. Several OEM dash
CAN-streams are available, as well as a general purpose CAN stream for after-market dashboards. The CAN
DBC files are available on the ME website, as well as detailed in the appendix. Use twisted pair cable for
CANbus wiring.
CAN1-Low is Pin 51
CAN1-High is Pin 21
CAN2-Low is Pin 35

63 / 197

Motorsport Electronics User Documentation

CAN2-High is Pin 36
Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator

Typical Sensor Wiring
The typical ME442 analogue sensor wiring is shown below. These are the "bare minimum" of environmental
sensors the ME442 needs to operate. Note you can omit the MAP sensor if you are planning to run an
Alpha-N fuelling mode, however, adding a MAP sensor also aids with barometric correction if left open to the
atmosphere as opposed to connected to the inlet manifold.

Typical assignments for the above wiring:

Created with the Standard Edition of HelpNDoc: Easily create HTML Help documents
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Wideband Lambda Connections
When connecting a wideband directly to the ME442, if you have used our un-terminated loom, then a 2x3 (6
way) Molex connector is already present for you. The mating part number is Molex 46992-0610.
Only 5 connections are actually made to the ECU. The Heater Supply wire (Pin 4 on the wideband lambda
connector) needs to run to an ignition switched live.
The Molex pin-out is:
1 ME442 16 - (LSU Heater Gnd)
2 ME442 19 - (LSU UN)
3 ME442 20 - (LSU VM)
4 ME442 49 - (LSU IA)
5 ME442 50 - (LSU IP)
6 RED Runs from this plug, back down the sleeve to the ME442 and loops back along the 3m to end with
For the LSU4.9 the following connection diagram will aid in wiring it up: YOU MUST use the Bosch
connector. DO NOT cut the plug off as it contains a calibration resistor.
BOSCH OVAL "17025"
LSU Connector Pin Number

Lambda Function

Molex Pin Number

1

LSU _ IP

5

2

LSU_VM

3

3

Heater -ve

1

4

Heater +ve (run to an ignition switched live)

6

5

LSU_IA

4

6

LSU_UN

2
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Ignition Coil Connections
The ME442 supports both Active and Passive Coils.
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Active Coils usually require a low current, 5V pulse from the ECU to cause them to "dwell" and when the
pulse turns off, the coil fires. These are typical of Coil-On-Plug type coils or external igniter. The coils
usually have 4 or more connections on their connector.
Passive Coils (driven by an IGBT Low Side High Current Drivers) are simple a coil of wire that receives 12V
from the cars electrical supply, and the ECU switches the coil to a ground connection (much like a relay or
injector) and when this ground connected is made, the coil dwells, and when the ECU "opens the circuit"
the coil fires.
Wiring of these coils differs depending on their type, and you will need to set the correct ignition drive type in
the Output Settings or the Ignition Driver to either Active or Passive mode.
The following sub-sections detail the different wiring set-ups for different coil types with the ME442.

·
·
·

Wasted Spark Ignition using Passive/Ford type coil packs
Coil-On-Plug setups using Passive coils (such as some BMW or Jaguar engine variants)
Coil-On-Plug setups using Active/TTL coils such as using Toyota, Honda or VAG Pencil Coils

Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

Wasted Spark IGBT/Passive Coils
These are the typical easy-to-install option for most engines. Affordable Ford type coils are used from 2000
era model Ford Zetec engines as per the ones available from our website. Wire them as shown below, and
then ensure the ECU is set to run Wasted Spark in the Ignition Driver as well as being set to "Passive" coils
mode.
The connections for 8 cylinder will depend on the firing order of the engine. Most Four-Cylinder engines have
the same configuration hence coil -> cylinder numbering is shown if you are running a Four cylinder engine
just connect the top coil up as shown.
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Coil-On-Plug IGBT/Passive Coils
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These are quite rare as a coil type. One note-able engine that uses Passive COPs (Coil on Plugs) are the
90s/00s BMW engines. Jaguar AJ30 engines also use Passive COPs. You can normally tell they are
passive coils by them only having two connections. An ignition switched live feed and a ground trigger.
When grounded, current flows through energizing them, and when the circuit is opened, the spark occurs.
The ME221 and ME442 both feature the IGBT drivers required to energise these type of coils. Most of the
Plug-Ins are Active/TTL type only please refer to their manuals.
The below example shows wiring for four cylinders, of course you could use all coil outputs giving 8
channels in total for 8-cylinder applications.
The COPs pictured are Jaguar AJ30 Type (Affordable and easy to use). They have 2 pins - polarity on the
COPS should be noted as one pin on the COPs is usually labelled B+ for example.
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ME442 -> Clio 182 'Pin Swap' Installation
The ME442 Wire-In shares the same connector as the Renault Clio 172/182 DBW cars. As such, you can
relocate pins in the stock Clio wiring connector to allow you to install the ME442 in its place. It also
supports the stock Clio dashboard. Any disregarded wires should be heat shrunk and sealed.
The below table details which pin to move from where, and to:
Note all Analogue Grounds should all interconnect and link to ME442 Pin 24 (ANA Ground)
The same goes for "Power Grounds" and 5V Sensor Supplies. See the table for how they should link, and
share multiple pins.
Function

OEM Location

Relocate To (ME442 Assignment)

Coil 2 & 3

1

31 (Coil 2)

Ground

3

10, 90, 61 (Grounds Power)

5V Sensor Supply

6

46, 76 (5VREFS)

5V Sensor Supply

7

46, 76 (5VREFS)
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Fuel Relay 1

9

9 (LS 18)

Main Relay

10

44 (LS 4)

Primary Fan

11

13 (LS 15)

Knock +

12

53 (Knock 1 Signal)

TPS Signal 2

13

17 (ANA V3)

PPS Sig 1

14

18 (ANA V4)

Analog Ground

15

24 (ANA Ground)

MAP Signal

16

56 (ANA V2)

TPS Signal 1

17

26 (ANA V1)

IAT Signal

18

57 (ANA T2)

Crank VR +

24

81 (Crank VR+)

CAN HIGH

27

21 (CAN 1 HIGH)

Ground

28

10, 90, 61 (Grounds Power)

12V Ignition Supply

29

14 & 15 (Ignition Live)

Coil 1 & 4

32

32 (Coil 1)

Ground

33

10, 90, 61 (Grounds Power)

VVT

37

12 (LS 2)

PPS Signal 2

43

78 (ANA V6)

O2 Front

44

87 (ANA V5)

Coolant Signal

46

86 (ANA T1)

Brake Switch

52

6 (DIG IN 1)

Crank VR -

54

80 (Crank VR - )

CAN LOW

57

51 (CAN 1 Low)

INJ 1

59

63 (INJ 1)

INJ 3

60

33 (INJ 3)

Throttle Motor +

61

65 (H Bridge A Out 1)

Throttle Motor -

62

66 (H Bridge A Out 2)

Ground

65

10, 90, 61 (Grounds Power)

Ground

67

10, 90, 61 (Grounds Power)

Ground

68

10, 90, 61 (Grounds Power)

5V Sensor Supply

71

46, 76 (5VREFS)

Knock Ground

72

10, 90, 61 (Grounds Power)

Analog Ground

73

24 (ANA Ground)

Analog Ground

75

24 (ANA Ground)

Ground

76

10, 90, 61 (Grounds Power)

Ground

77

10, 90, 61 (Grounds Power)

5V Sensor Supply

78

46, 76 (5VREFS)

Analog Ground

79

24 (ANA Ground)

Ground

80

10, 90, 61 (Grounds Power)

Analog Ground

82

24 (ANA Ground)

5V Sensor Supply

83

46, 76 (5VREFS)

Analog Ground

84

24 (ANA Ground)

Analog Ground

87

24 (ANA Ground)
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INJ 4

89

3 (INJ 4)

INJ 2

90

4 (INJ 2)
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Plug-In ECUs
The ME Plug-In range comes in two generations. Generation One which has a BLACK circuit board (and a 9
way serial connector for comms) and Gen2 which uses WHITE & BLUE Circuit boards. Only Generation 2
versions have the ME442 upgrade option.
The two types are pictured below. Gen1 is on the left, Gen2 is on the right:

Created with the Standard Edition of HelpNDoc: Full-featured EPub generator
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Connectivity and Disclaimer
While we develop the connectivity, products and basemaps on REAL cars in house, that doesn't mean to
say there isnʼt some weird and wonderful cross-over that moved a certain connection - we detail any of these
“special” cases in the appendix if applicable. It is however always the installers obligation to check the
compatibility of the ECU with the OEM harness - Motorsport Electronics Limited cannot be held liable for
any costs incurred through incorrect installation of use of the product. DRIVE-BY-WIRE SHOULD NOT BE
USED ON PUBLIC HIGHWAYS - DO SO AT YOUR OWN RISK.
Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

Model Specific Plug-In Install Guides
For your chosen model of Plug-In, there are model specific Quick Start Install guides on our website under
support here.
For specific help with advanced ECU features, additional wiring etc, this entire on-line manual should be
referred to.
Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

ME442 Plug-In Wideband Connection
If you have an ME442 Plug-In, you can use our affordable interlink cable (as pictured below) to simply plug in
an LSU4.9 into the WBO2 connector on the ME Core. You can order the lambda cable sensor kit here.
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SD Card Installation (ME442 Plug-Ins Only)
SD-Cards are used for on-board logging on the ME442 Plug-Ins. The cards have to be at least Class 10, with
SDHC. 16GB cards will give nearly 500 hours of logging so are ample. Simply install the card into the SD
Slot on board when the ignition is OFF.
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Note you will not be able to directly read the cards with a PC, instead, logs must be downloaded via MEITE.
Created with the Standard Edition of HelpNDoc: Easily create Help documents

Extra Switch Inputs
Simple connect a toggle switch in-line from your chosen "DIG IN #" on the Aux connector, then to ground.
You can follow the settings on how to then use it to trigger different events under the Digital Input Guide
Created with the Standard Edition of HelpNDoc: Free help authoring tool

Extra Sensors
You would use the ANA Vx Connections on the Auxiliary connector for spare sensors.
For a voltage based sensor (for example a MAP sensor) 5V and GND are also on the AUX connector to
power the sensor. You can then just connect the signal wire from the sensor to your chosen ANA Vx pin on
the Aux Plug and configure as per here.
You can find out the pin-out of the AUX connector on your Plug-In ECU at the end of the Install guide for your
model, which you can select from here.
A example of this is below: Note you will need to check the pin-out of your pressure sensor (and making
sure it is a 0-5v output) and then assign it, and finally calibrate it according to its data-sheet in MEITE. In the
diagram below, we take 5V, Ground and feed the signal back into ANA V5. Typically, 22AWG wire is used.
The connector body is MOLEX 39-01-2205 and the pins are MOLEX Mini Fit Jr. All available from
mouser.co.uk.

If you are instead using a thermistor based sensor (resistance changes with temperature, like an oil
temperature sensor), then you can still use one of the ANA-Vx inputs, only you will also need to add a pullup resistor. The Ana-Vx section of the manual here details this. 5V REF and Ground can be obtained from
the AUX connector as per above.
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Coil-On-Plug Conversions
You can use either Toyota or VAG COP units with the Gen2 ME221/ME442 Plug-Ins. These are "Active"
style coils.
COIL 3 and COIL 4 trigger signals come out of the AUX Plug on the baseboard.
COIL 1 and COIL 2 should be triggered from the stock ignition trigger pins. The pins of the stock ECU are
listed in the tables in the appendix of each models specific Hardware Install Guide.
The GROUND and POWER supply wires should be heavy gauge. Note they should be neatly grounded to
the cylinder head. Failure to do so can create electrical noise which can effect USB operations of the ECU.
The OEM 12V feed (taken from the place the OEM coils were supplied their power) should be used to power
the new coils, and should be rated at around 10A or more.
It is always best to run new wiring instead of using OEM triggering wires and power wires as COPs can
draw significant amounts on current.
Once you have wired them, test them as usual using the test output function. Then, change the Ignition
mode to Fully Sequential in the Ignition Driver, and finally, check that COIL 3 and COIL 4 are assigned to
COIL 3 and COIL 4 in the Output Settings. Be sure to check dwell settings as recommended by your coil
supplier to avoid damaging them.
Note that if the engine runs fine when set to "Wasted Spark (COPS)" but does not run in "Fully
Sequential" Ignition modes (yet still sparks as expected) you may just need to add/subtract 360
degrees from your trigger offset to align the ignition event with the compression stroke as opposed
to the exhaust stroke.

-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------

72 / 197

Motorsport Electronics User Documentation

Created with the Standard Edition of HelpNDoc: Write eBooks for the Kindle

The Tuning Process & Features
The below illustrates the typical tuning process when using an ME Engine Management System (or any
ECU for that matter!).
The following sections detail the basic process you should follow when tuning an engine. It doesn't detail the
exact theories of tuning ignition and fuelling, as that is something that there have been countless books,
videos and articles cover - and also, most opt for a professional tuner to get the best from the engine. So its
more of a guide as to how to use the features of the ECU
In almost all cases, it is best to start with one of our base maps available from the website that mirrors your
engine as closely as possible, as that way, the majority of the hard work has been done for you…. See the
MEITE manual for details on how to load a basemap.
Be sure to either load a fresh basemap (if using a Plug-In ECU) or obtain a start-up calibration from us to
ensure the triggers are set correctly for your engine.
Below is an overview on the steps to go through to get your engine running.
The most important thing to remember, is there is no point progressing to a step if youʼre not happy with the
settings/operations of the previous step. Trying to configure wideband (step 9) on an engine that doesn't
even read the coolant sensor properly (step 3) would be a waste of time!
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

First, check the Engine, Injection and Ignition Driver. (here)
Configure the IO Settings and Perform Tests on the various outputs you are using. (here)
Setup your sensor inputs, and check their operation. (here)
Attempt to crank the engine, and monitor for sync issues. (here)
Check & set Ignition timing offset. (here)
‘Jack the throttleʼ slightly to maintain a steady, basic idle, and tune the VE and Ignition tables.
Tune the Idle Control, Start and Warm-up Enrichment.
Setup Auxiliaries, such as cooling fan control, etc.
Configure Wideband/Lambda Control.
Configure Motorsport Features.
Created with the Standard Edition of HelpNDoc: Free help authoring environment

Basic Configuration
The first steps in setting up the ME ECU for your engine are found under the ‘STARTʼ tab in MEITE (When
using a Default Layout). These allow you to define the physical engine you plan to run. These include the
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Injection, Ignition and Engine Driver.
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Configuring Inputs
The 'IO Setup' tab (when using a Default Layout) in MEITE allows your to configure the various outputs of the
ECU, as well as perform test functions on the ECUs outputs, and to test wiring and systems on the engine.
The tab consists of Output Settings, Digital Input Settings, Analog Input Settings and Tachometer Settings.
For the plug-and-play range of ECUs, the I/O is very much defined by the circuit board itself, so you should
normally just load a basemap for the PnP system, and leave the I/O settings alone. For wire-in ECUs, you
can use the I/O settings to assign different functions to the spare inputs and outputs, as well as repurpose
things such as unused injector channels.
Below you can see a typical I/O Setup for an ME442 Plug-In ECU. We can see that the user has decided to
control a Boost solenoid on LS 10 output, and the Primary Fan on Relay LS 12.
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You should wire your engine as per the I/O settings, or change the I/O settings to suit your wiring - more
information on physical connectivity is given in the hardware install guides for the PnP Range, as well as the
ME221 Wire-In install guide - all available from the ME website.
You can also see how the Analogue sensor inputs have been chosen and routed, under the ADC settings.
These should typically be left as such, but, for example, if you wanted to swap the Inlet Air temp and
coolant temp wiring, you could swap the settings in this dialogue to reflect that change. Always be sure to
point sensors to a "RAW" input where possible. These RAW values are then passed to the HRT of that
sensor, which then converts it to the correct unit and value.
Created with the Standard Edition of HelpNDoc: Create help files for the Qt Help Framework

Analog Sensors
Analog sensors are the 0-5v and resistive based sensors that give the ME ECU its information required for
both fuelling and other logging functions.
These include Manifold Pressure, Throttle Position, Lambda sensors, as well as temperature sensors such
as coolant and intake air temperature.
You will need to wire them to your ECU, (note Plug-Ins will already be routed correctly where applicable, and
our factory basemaps will already have the channels and calibration curves correctly assigned) and then
assign the chosen sensors to the channels, then finally calibrate and confirm the readings are correct from
within MEITE.
The setup steps for analog sensors are as follows:
1. Wire the sensors to the ECU as required. Note you should use Ana Vx inputs for voltage outputting
sensors like MAP, TPS, pressure and Lambda sensors, and Ana Tx for thermistors such as coolant, air
and oil temperature.
2. Assign the sensors to the correct channels in the Analog Settings.
3. Calibrate the HRTs for each sensor such that the sensors report correctly in MEITE.
All of this is viewable from one tab within MEITE, the “Sensor Cals” screen, as pictured below:
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When checking sensors, start at the most basic and work your way from there. For example, the first
reading to check is the battery voltage. In the image above we have our test ECU imply powered on the
bench, and yes, with the ignition on, we are seeing 12.3 Volts - perfectly normal. We may see this reading
drop to around 8 or 9 volts during cranking, again, normal. And running, with the alternator working as it
should, we would hope for 13-14 volts.
Created with the Standard Edition of HelpNDoc: Create iPhone web-based documentation

Analog Input Settings
The Analog Inputs driver details all of the analog physical connections of the ECU, and how they connect to
the internal software functionality.
It is accessed from the entity tree under "Inputs>Analog Settings".
There are several different channel types. Vx and Tx represent Analog Voltage Inputs or
Thermistor/Temperature Inputs.
VBAT is the internal channel connected to the powersupply subsystem. CJ125 is the link to the Bosch
Onboard wideband controller and KNK relate to Knock channels. These channels should not be modified.
You will note that the Vx and Tx channels have a [##] following them. This is the physical pin number on the
ECU. For example, in the image below, we an see we have mapped the Manifold Pressure Sensor (MAP
Raw) to V1 (which should be connected to Pin 26 of the ECU). If instead we wired the Throttle Position
Sensor there, we can simply drop down the list and change the assignment to 'TPS Raw'. This flexibility
allows easier loom design.
It is important to note that in general only "Raw" should be assigned - which is then passed through the
corresponding HRT table to generate a 'useful' value that the ECU will use elsewhere.
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RAW Values Explained
Please note it is not a requirement to work in "RAW" Units - you can work in an array of different
units, please see 'Configuring Units'.
The Analog (varying level) sensors work via a reading taken from the chosen I/O pin in the Entity Tree
View>Inputs>Analog Settings driver. The input to these pins typically range from 0-5 volts. This 0-5 volts is
then scaled to what is called a RAW value, that is where 0 volts = 0 RAW and 5V = 65,533 RAW.
Tip: If you wanted to work out what the RAW number would be for say 1.3 volts, then it would be 1.3 x (65535 ÷
5), which equates to approx. 17,000.

The next process that happens, is that these ‘RAWʼ readings are converted into a normal units reading,
such as degrees, percent or pressure, via the HRT tables, which are shown as the four graphs in the Sensor
Cals Screen, or available as indidual tables in the Entity Tree View>HRTs.
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HRT Tables
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HRT Tables are used to translate the externally read voltages of the sensor inputs into values that are then
used within the ECU in their normal form.
For example, below we can see the TPS HRT. This converts the voltage read from the chosen analog
voltage channel (by assinging to that channel TPS Raw) to a 'useful' value, the Throttle Position (TPS) in
percent.
Essentially, HRTs allow external sensors to be calibrated anyway the tuner wishes. The standard layout for
the common four sensors (IAT, Coolant, TPS and MAP) as well as a selection of the digital readouts are
pre-laid out in the "Sensor Cals" tab of MEITE if using a Default Layout.
Created with the Standard Edition of HelpNDoc: Full-featured Help generator

Calibrating IAT/CLT Sensors
There are two methods to calibrate coolant/Inlet air temp. sensors (and any thermistors for that matter). The
first is using factory supplied data for the sensors you're using, the second, although not as accurate, is by
measuring the temperature of the sensor by heating it slowing and updating MEITE as it passes through
different points. Both are described below.
For information on wiring of temperature sensors, please see here.

Method 1: Using Factory Data
Most new sensors have a data-sheet which describes their resistance for a given temperature.
MEITE has a range of pre-set calibrations for various sensors built in, and also, our Plug-In models has the
OEM sensors already calibrated in the basemaps we offer.
The in-built pull-up resistors in all ME products are fixed at 2K7, which means you can work in OHMs when
setting up thermistors in MEITE. This makes calibration quick and easy. Be sure to set your units
appropriately in MEITE.
Simply enter your data from the supplied table into the correct HRT for the chosen sensor. Below, we can
see the factory data for a Bosch coolant sensor, and the corresponding CLT HRT after entering the data.
Note you have 16 'rows' in the HRT system, so pick data points that cover the expected range you'll be
working with. After entering the data (note the datasheet is in "Kohms" so 0.62=620Ohms) into the CLT HRT
the below will be shown:
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Tip: If you see very high resistance (or voltage nearing 5V) on one of the IAT or CLT lines, then you likely
have that circuit ‘openʼ - ie.. the ground or signal line are not properly connected to that sensor. Try
unplugging one of the sensors to see how the value reads in what would be a ‘faultʼ condition.

Method 2: Calibrating by Testing
The other option to calibrate thermistors is to use a multimeter to measure the resistance of the sensor.
Next, use a series of different temperatures such as a cup of cooling water and with a thermometer record
the temperature of the water (as it cools from boiling) with the sensor immersed, record a table of
temperatures vs resistances. This will give good ball park data for the table. Ice can be used for 0*C or less.
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A baked potato makes a great of getting over 100*C also!
Enter the data you discover into the HRT as per the above.
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Calibrating the MAP Sensor
If you plan to run a turbo/supercharger, or if you are using a stock plenum, then it would be wise to use
MAP (Manifold Absolute Pressure) for primary load (in the Injection Driver settings before), and as a result, it
is important to install and calibrate a MAP sensor. This is known as 'Speed Density' tuning.
For naturally aspirated set-ups, such as throttle bodies, you may wish to use TPS for load (a system called
‘Alpha-Nʼ fuelling) and as a result you may not want to even install a MAP sensor. In this case, it is
important to set the MAP HRT to always read 100KPa - as shown in the above image, by setting the entire
tables ‘MAPʼ column to 100. This means the fuelling algorithm will not be affected by MAP readings.
If you're using a MAP sensor, then it should be calibrated. Most MAP sensors include a data sheet, that
illustrate their voltage output based on the pressure they are exposed to. Below is an excerpt from a MAP
sensors datasheet from the web - note these numbers will vary dependant on the sensor, and that they
usually specify the pressures in ABSOLUTE terms, that is, 0 being a perfect vacuum, approx 100KPa being
atmospheric air pressure at seal level (or 1 Bar), 200Kpa representing 1 Bar of Boost (i.e 1 Bar above
atmospheric), and so on.

We can see from the table that the the low pressure (40 kPa) Vout “Average” is 0.631v, and the highest
pressure (304 kPa) Vout is 4.914v. We could also work out the other rows, but as most sensors are linear,
there really is not much need to.
First, we assume you have selected the correct Analog input channel that you have wired the MAP Sensors
signal wire into, and set it to "MAP Raw" in the Analog Input settings driver.
If you bring up MAP Raw DRO in MEITE on any tab, you should see the voltage read from the MAP sensor.
By sucking or blowing into the MAP sensors vacuum port, you should see the MAP Raw DRO voltage
change in MEITE. If it does not, you either have either an assignment issue or a wiring issue. The DROs and
HRTs are already set in the default tab named "Sensor Cals."
Be SURE you have first set MEITE units to work and display in VOLTS. (This is the default).
The next step is to enter this data into the MAP HRT table via the following process: (open it from the tree
view under HRTs if needed).
1.
2.
3.

In the Top Left box of the MAP HRT table, double click it, and type 0.631, press enter.
In the Top RIGHT box of the MAP HRT table, enter 40, press enter.
In the second row, on the left, enter 4.914, press enter.
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4.
5.
6.

In the second row, on the right, enter 304, press enter
We don't want the rest of the table to be used, so in all other boxes on the left, enter 5, and in all
other boxes on the right, enter the highest number the map sensor can read, which is 304. That
means even if the sensors voltage somehow goes over its maximum, it will still read 304 kPa.
Click the red ‘Saveʼ icon in the top right of the MAP HRT window. The window will have a green border
to signify the data has been sent to the ECU and stored.

The MAP HRT table will now look like this:

You should see approximately 98-101 kPa with the sensor reading atmospheric pressure at sea level,
decreasing as you go up in altitude (most of the UK for example shows approx 98 kPa), Colorado in the US
shows 90 kPa, and so on. You can also test by blowing into the MAP sensor, and watching the yellow
cross-hairs moving, showing you the RAW input, and the resultant pressure output.
Note that Plug-In variants of our ECUs will typically use an on-board 250 or 400 kPa sensor, and the basemaps already have this configured correctly.
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Calibrating the Throttle Position Sensor
Once you have fitted a Throttle Position Sensor, or TPS, you will need to calibrate it from within MEITE.
First, be sure you have correctly wired, and assigned the throttle sensor signal input to "TPS Raw" in the
Analog Settings. The signal on the chosen pin should sweep from approximately zero to five volts as you
move the throttle from fully closed to fully open. See the Throttle Sensor wiring section for information on
how to connect it to the ME range of wire-in ECUs. The Plug-Ins will already have it correctly wired and
assigned in the supplied base-map.

Throttle Calibration Wizard
You can use the Throttle Calibration Wizard (under ECU Tools menu) to easily calibrate your throttle. It will
also automatically correct the calibration for throttles wired "backwards". (Where the voltage decreases as
throttle opening increases.)
Simply start the wizard and follow the three steps below, and then the TPS HRT will be fully calibrated for
you.
If you do not see the the "Throttle (Volts)" change as you sweep the throttle, please check your throttle
sensor wiring.
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Traditional HRT Calibration M ethod
You can also choose to calibrate the throttle sensor using the HRT Table for the TPS Sensor. You can
access it from Entity Tree View>HRTs>TPS HRT.
Most would opt to use the wizard detailed above however.
Note If you are using a Plug-In, be sure (if applicable) that any jumper settings for TPS have been
made correctly. (Refer to that model's hardware install guide.)
1.
2.
3.
4.
5.

Again, go to the “Sensor Cals” tab in MEITE.
Sweep the throttle from open to closed. The TPS Raw reading should go from low to high. If it is
inverted, swap the 5v and Ground wires connecting to the sensor.
Note the ‘TPS Rawʼ reading at both CLOSED and WIDE-OPEN throttle. In the TPS HRT image
below, you can see the CLOSED reading was 6450 (0.1v), and the WIDE-OPEN reading 51200
(approx 4V). (Note you may be working in volts as units, which is normal).
Enter these as shown into the TPS HRT table, using the top two rows. The remaining rows should
read 65535 (or near 5v), 100, as shown.
Sweep the throttle again, and you should see the yellow crosshair ‘walkʼ up and down, as well as the
TPS(%) readout will now go from 0-100%.
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Oil Pressure & Temp. Senders
Oil Pressure & Temperature sensors are calibrated much the same way as the IAT/CLT sensors, only using
the respective HRTs (Oil Temp. HRT and Oil Press. HRT).
They would be connected to a Analog Voltage (for pressure) and Analog Temp. (for oil temp) pins, and
assigned to the Oil Temp. RAW and Oil Press. Raw in the Analog Settings as required.
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Digital Inputs
Digital inputs are used to trigger functions such as Air Conditioning, Map switching or even the reading from
a Flex Fuel Sensor. They are usually 0 or 5v. The ECU will see them as either On or Off, and wil not report
their voltage like an analog input would.
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Button/Switch Inputs
The ME range of ECUs features multiple spare digital inputs.
These inputs allow frequency signals (such as a Vehicle Speed Sensor, a Flex Fuel sensor or a Hall Effect
Cam position sensor), or a switch type input. Simply wire the switch such that it connects the digital input
to ground when triggered.
The ME442 Wire In and ME221/ME442 Plug-Ins digital inputs all have an internal 1Kohm pull-up to 5 Volts.
(meaning you only need to connect them to ground to "trigger" them)
You can map the physical pin to the chosen function from the "Input Settings" which is under the System
node on the entity tree.
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Using Spare Analog Inputs as Button Inputs
If you run out of digital input pins, you can also use a spare analog input for certain functions to act as a
digital input. When the chosen Analog Input is above 2.5v it is read as ON, and when it is below 2.5v it is
read as OFF.
An example of this is as follows:
We would like to use the Analog V3 input on our ME442 Wire-In as a map switch input. We plan to toggle
this wire by a toggle switch on the dash.
Wiring wise, we need to either put approx 5v into Analog V3, or 0v. So we use a "pullup" resistor to hold
Analog V3 at 5v when the switch is not connecting Ana V3 to ground. The circuit would look like the below.
a 10K resistor is recommend for pullups. We can get 5V from the 5VREF pin on the ECU, or, for example
on ME221s, the throttle 5v reference. A diagram of the circuit is below:
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Next in MEITE, we need to set ANA V3 to act as a "Button". We do this from the Analog Settings (Under IO
settings Tab) We set the chosen input to Btn 1 Raw:

Now we can check the button actually works by toggling the switch and noting the readout Btn 1 Val (under
Inputs on the entity tree):

Next, lets set map switching to use the chosen Btn 1 Analog button as a signal source, then set it to switch
fuel (VE) maps when this button is set:
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And that's it - you now have an analog input re-purposed to act as a digital input to switch fuel maps.

Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

EGT Sensors
The ME442 range features inbuilt EGT K-Type Amplifiers which means you can directly connect K-Type
thermocouples to the ECU for accurate exhaust gas temperature measurement.
You can view the EGT status and the current reported temperature from the respective items on the entity
tree under "EGT". Be sure to enable EGT from the EGT Settings.
The EGT Status will also report if the sensor is not connected/loose connection, aiding in diagnostics.
The ME442 Plug-Ins only have EGT #1 (single channel), whereas the ME442 Wire-In has two EGT
channels.
For details on their connections please see the this section of the manual.
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Configuring Outputs
The Outputs section concerns general testing of the outputs, and some information on typical output uses.
The Outputs Settings dialogue (under the System node in the entity tree) allows you to assign a physical
output channel to an array of functions. There are several physical output types, including Injector, Coil, Low
Side H-Bridge and so on channel types.
Below is the Output Settings on the ME442 Wire-In. Settings and channels will differ depending on ECU
type. For example the ME221 has only Coil A and Coil B channels under coils as it only has two coil drivers
built in.
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Testing Outputs
You can also test outputs from IO Setup screen. Ensure you're connected to the ECU, everything is
powered etc, then select from the drop down box next to the output pin you would like to test, the type of
test you want to perform.
Remember to set it BACK to the correct option after carrying out a test, and you can only test one
output at a time!
Let's test the fuel pump in the following example:
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We know we wired the fuel pump relay to LS 1 on the ME221 Wire-In. The other side of the really is
powered to 12V, so when we toggle LS 1 (Low Side 1, e.g it switches to ground) the fuel pump should turn
off and on.
We choose “TEST: SLOW TOGGLES” from the drop down box next to LS 1, as shown below. We will then
hear the fuel pump relay/fuel pump, turn OFF and ON every couple of seconds. If it does not, we have a
wiring issue!

The next thing we may wish to test could be a coil or an injector output. It is important to note we shouldn't
turn the coils on for long periods of time (over several milliSeconds) as it may damage the coil or the ECUʼs
drivers, so for that, we should use TEST: INJ/COIL (5ms - 3s). This will drive the output for 5 milliseconds,
every 3 seconds. Enough for the injectors to click, or the coils to fire off a spark.
The other test functions are ‘ONʼ, ‘OFFʼ and ‘Fast Togglesʼ - which are self explanatory.
If you wish to test unused outputs, follow the below circuit. You can then wire the "test LED" into any of the

89 / 197

Motorsport Electronics User Documentation

unused Low-Side, Injector or Coil outputs, and see visually if the output is working when setting an output to
a test mode as above.
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Injector Outputs
Injector outputs can be used as general purpose low-side outputs (3.5A capacity) but in general they will be
used for the fuel injectors. You can assign the chosen injector channel to the selected injector pin from
within the Output Settings dialogue. (This is available on the IO Setup tab when using a default layout in
MEITE, or under the System node in the entity tree.)
You will need to know the flow rate of your injectors in cc/min (and at what pressure), which you would then
enter into the Injection Driver settings so the ECU can accurately compute the fuel amount.
In terms of injector sizing, as a general rule of thumb, if you have 4 cylinders and one injector per cylinder,
and you want around 300bhp, aim for around 700cc/min flow rate. If you want 600bhp, you would aim for
1400cc, and so on.
Also, the ECU provides an Injector Dead time compensation table which will drive the injectors for longer as
battery voltage drops - for example during cranking.
For information on wiring your injectors please see here.
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Coil Outputs
The ME ECU range has two types of coil outputs, either Active/TTL (Transistor Transistor Logic) or
Passive/IGBT (Insulated Gate Bipolar Transistor). You need to make sure you use the right kind of output for
the coils you choose to use, or vice-versa. The Plug-In range has the correct hardware type (either IGBT or
TTL) to suit the OEM ignition system, as well as the correct settings when you load a suitable base map.
Both types are explained here:

TTL "Active" Coils & COPS
TTL coils usually have an ignition amplifier built in, and expect a simple 5v signal from the ECU to tell them
when to dwell (to start charging the coil) and when to fire. Most TTL coils work on a positive or "normal" logic
mode. That is, 0v on the signal pin and nothing happens, and when 5v is placed onto the signal pin the coil
beings to charge, then, when the signal pin goes back to 0v, the coil then fires.
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TTL coils usually have three or more connections as they have an ignition switched power (12v) a ground
and a signal wire at a minimum.
For more information on wiring COPs please see here.

IGBT "Passive" Coils
IGBT (sometime called dumb/passive coils) are simply a wire wound transformer. They typically flow several
amps, and as a result require an IGBT (high current ground switch) to drive them, as fitted to our ME442 and
ME221 wire-in ECUs. The ECU provides a connection to earth, with the other side of the coil being
connected to a fused ignition supply. When the ECU wants the coil to fire, it connects it to ground, allowing
energy to flow through the coil, and then, and the right time, it breaks this connection causing the coil to
fire.
IGBT (or "dumb") coils usually have only 2 connections per coil channel as they are simply a coil of wire
within. They will have a 12v ignition switched supply to one connection, and the other will run to the ECU
which is switched to ground via the high current IGBT driver, allowing current to flow, and the coil to "charge"
or dwell.
Most Japanese models use TTL coils and a module - as a result most of our Plug-Ins are set-up for this,
offering a simple 5v output for the coil trigger lines.
The ME442 Wire-In offers 8 ignition/coil channels, and these can be set to either TTL or IGBT mode from
within MEITE.
The ME100/ME221 Wire-In offers 2x IGBT channels. Suitable for directly firing standard coils such as Ford
Coil-packs.
The ME221 has two IGBT coil drivers built in, so direct driving of wasted spark coil packs is the common
method of ignition control. In this mode, be sure to set ignition drive mode to ‘normalʼ, not ‘invertedʼ, as this
may cause damage to the ECU. COIL.1 and COIL.2 are the respective outputs for the ignition coil.
Generally, the coil receives a 12V ignition feed (we recommend fusing at 10A), and the coils -ve terminals
run to the ECU. COIL.1 generally ignites the spark plugs for cylinders 1 & 4, while COIL.2 operates the
spark plugs for cylinders 2 & 3 (as set by the Ignition Driver). A typical ‘Ford Typeʼ coil pack and its pinout is
shown below.
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PWM Low Side Outputs
PWM (Pulse Width Modulated) Low Side outputs are used for things like PWM idle, boost and VVT control
valves. They can also be used as slow relay type outputs if you wish as they work from 1hz-500hz speeds.
Spare coil or injector outputs can also be used as general PWM outputs.
Dependant on the ECU, some PWM outputs have different current capabilities, however, they are all LOW
SIDE, meaning they provide a path to GROUND when turned on.
Please refer to the wiring section for details on the different ECU models PWM output power handling
capabilities.
Remember you can also use Test Modes to test these outputs as needed.
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Relay Low Side Outputs
Relay low side outputs are all "switch to ground" pins. They differ from PWM Low Side Outputs in that they
cannot be driven by "PWM" functions (as they cannot be updated at more than 5Hz) such as idle, VVT etc,
and instead, should be used to drive relays (or slow acting solenoid valve), such as the fuel pump, cooling
fans, air-conditioning relay etc.
Current ratings depends on the model of ECU you're using, but they are typically <1A per channel.
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An example of how you would wire a relay to one of these pins is shown in the Wiring Section.
You can see the typical usage for some of these outputs on the below image of the Output Settings
dialogue.
You can use Test: Slow Toggles or Test: On/Off to test these outputs.
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Fuelling Configuration
The Fuelling configuration details the fuel control portion of our ECU range. Note the ME100 and ME300 do
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not feature fuel control as they are ignition only, so this section does not apply.
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The ME Fuel Model
The ME Engine Management range uses an advanced ‘Volumetric Efficiencyʼ (VE) model of the engine's
airflow to determine the fueling requirements. This has immense benefits over traditional systems that use a
simple pulse-width table, in that any changes to fuel pressure, injector size, or even minor engine changes
do not need a complete remap, only adjustments to the engine configuration.
VE simply means how much air is in the cylinder in comparison with how much room there is. So a 2.0 Litre
engine with a certain throttle angle might only draw 50% of the total air that it can (i.e. only fill the cylinders
to 1.0L of air), hence at this point, the engine would have a VE of 50%. In order to determine the mass of air
that is available, its pressure must also be taken into account. This goes to say that the VE table of an
engine that has a Manifold Absolute Pressure (MAP) sensor will be significantly different than the one of an
engine that only has a Throttle Position Sensor (TPS), as the first dynamically calculates the air quantity,
while the latter relies on a static model relating to the position of the throttle plate. Any more fuel would
simply go out the exhaust, and any less fuel and we would have air left over - this moves to stoichiometries,
whereby with gasoline, we need 14.7 times the amount of air (by MASS) as we do fuel to have a complete
burn. (The stoichiometric ratio). Note however that engines may require richer or leaner mixtures to get the
best from the engine reliably - no fuel map would ever target 14.7 across all driving conditions!
Essentially, when you map the engine, to a predetermined set of Air-Fuel Ratios (AFRs) you will be ‘reverse
engineeringʼ the engine's airflow potential - its VE.
The engines VE is set mechanically by the hardware (cam profile, port design, exhaust etc) of the engine more VE = more air = more fuel can be added = more power, so a correctly tuned VE table will have a curve
similar to the torque curve of the engine.
There are countless books and guides on understanding a VE model available online, so instead of going
into too much detail on this, here are some suggested reading links:
●
●

Greg Banishʼs Book gives a good general understanding of VE and tuning:
https://www.amazon.co.uk/Engine-Management-Performance-How-S/dp/1932494421
Boschʼs technical book, while extensive, gives some advanced information regarding EMS
https://www.amazon.co.uk/d/Books/Gasoline-Management-Professional-AutomotiveInformation/3658039639/

A note on Pressure readings…
When working with the ME221/442 (or most after-market ECUs) the manifold pressure (and if used in Speed
Density mode, the resultant engines ‘Primary Loadʼ) is shown in Kilopascals, or kPA.
This is an ABSOLUTE reading, meaning 0 kPa means a perfect vacuum, e.g. in space, and approx 100 kPa
means the pressure of the air at sea level (imperially ‘1 Bar Absoluteʼ, or, approx 15 psi absolute).
So, for example, if we were to say we were running 1 Bar (15psi) of BOOST (which is a GAUGE pressure),
then we would be running 1 Bar (of atmospheric pressure) plus 1 Bar of turbo-generated pressure - so our
readout in kPA would then show 200kPA.
Another example would be to say we were running “half a bar” of boost (0.5 Bar / ~7.5psi) then our manifold
pressure reading would be 150 kPa.
Created with the Standard Edition of HelpNDoc: Benefits of a Help Authoring Tool
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The Injection Driver
The Injection driver (under Injection on the entity tree) is the configuration of the fuelling equations of the
ECU. Note the ME100 does not have this settings as it is ignition only.

Fuelling Mode
This determines how the injectors (which are typically wired individually per cylinder to injector channels on
the ECU - Injector 1 to Cylinder 1s Injector etc) are fired.
Off
This turns off all fuelling events, as used when timing the engine to stop the spark plugs becoming soaked,
or for clearing the engine in the case of flooding.
Batch
This will fire all injector channels together, once per cycle.
Grouped

Fully Seq.
This will fire each injector in order as defined by the firing order to match each cylinders intake storker. You
can time this up by setting the injection angle table.

Use IAT in Algorithm
This option (when set to Yes) will use the Gas Laws to determine the mass of air entering the engine based
on the Inlet Air Temperature. If it is set to NO, then you should tune your Environmental>Inj, IAT Trim
table to supplement or reduce the fuel based on the air temperature to your liking.
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Injection Angle
This determines when the injection events will happen. The injection angles are set based on speed/load in
the Injection Angle table (under Injection on the entity tree). YOu can set whether these angles relate to the
start or end of the injection pulse.

Inj. Max Duty
This is the maximum duty that the injectors should be driven. If the fuelling equation delivers an injection
duty over this, then a hard cut limiter will happen, protecting the engine and the tuner will also be notified of
this by a warning at the bottom of MEITE. Generally, injectors should not be driven over 90% duty - if they
are required to do so to meet your target AFR then you need either larger injectors or more fuel pressure.

Pri. Inj Size (cc/min)
Enter the flow rate of your injectors here. This should be the documented flow rate and the documented
pressure (which is entered in Inj Re. Pressure).

Fuel Pressure (Kpa)
Enter the expected/set fuel pressure of the fuel rail in Kpa. This is only used with the reference pressure to
calculate true fuel flow.

Inj Ref. Pressure (Kpa)
Enter the pressure which delivered the Pri Inj Size flow rate. For example if the datasheet for your injectors
says 350cc/min at 3.5Bar then you would enter 350cc intpo Pri Inj Size, and then 350 in this box. Then, if
you in fact run 7bar of fuel pressure on your engine (you would of entered 700 in the above "Fuel Pressure"
box, then the ECU knows that n reality, your injectors (in an ideal world) are flowing 700c/min.

Fuel Pump Prime Time
This the amount of seconds when the ECU first powers on that the chosen 'fuel pump' output will be "on" for.

Priming Pulse
This will fire the injectors for the length of time (relating to coolant temperature) in the Priming Pulse table
(under Startup). You can select to either prime when the key first turns on, or when cranking begins, or of
course, neither.

Staged Injection
See the staged injection section for more information on this.
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Primary VE Table
The primary VE table is the main fuel map. It is the VE (percent of cylinder air fill) and therefore is used to
compute the matching amount of fuel injection duration based on all other factors (such as engine size,
injector flow rate etc) as set in other tables and driver settings dialogues.
The left axis is LOAD which will either be Manifold pressure (as KPA) or Throttle Percent (in %) as set in the
Engine Drivers Algorithm Configuration Section.
You can see it below, shown as a 3D table under the Mapping Tab:
You would tune this table such that your desired AFRs are met, but before doing so, make sure you set the
axis as you wish (for example if using throttle for load then the load axis needs to be a 0-100 listing)
whereas if you are running a turbocharged engine running an expected 1 Bar of boost (200Kpa) then it
should go from around 30Kpa (typical idle/overrun vacuum) to 200Kpa to allow tuning of al possible manifold
pressured. Double click the load numbers to change them.
Likewise for the top row, showing RPM, you should set this to mirror your engines possible RPM ranges.
You would then tune the VE table such that your desired AFRs are met for all Load and Speed points. Then,
view it as 3d table and "smooth" it out as a VE table will always typically be smooth with no jagged spikes
or cliff edge transitions.
More information about tuning the VE table is here.
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Injection Angle
The ME ECUs offer the possibility of setting the crankshaft angle at which the injection event should start.
The table used to configure this is Injection>Fuel Injection Angle. There are a few opinions on this, but most
tuners aim to spray the fuel while the intake valve is open. At higher loads and RPM, where injector duty
rises to more than 25% (180* crankshaft, length of the intake stroke), spraying fuel onto the closed intake
valves will help atomization and cool them at the same time.
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As with all tuning information, please use your best judgement when configuring this parameter.
As opposed to ignition angles, the injection angle is set in true crankshaft degrees (not advance), so a
higher value will make the injection event start later. You'll notice that, when running fully sequential injection
and big injectors, choosing the injection angle correctly can make the difference between a smooth and a
rough idle and low-load operation. For reference, here's the timing of the four strokes in relationship to the
start of injection angle:
0* - start of power stroke
180* - exhaust stroke
360 * - intake stroke
540* - compression stroke
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Cylinder Trimming
Injector trims allow you to trim final fuel flow as a percentage. Note these should be left at 100 unless you
have data or evidence that means you need to adjust it, such as injector flow differences. Ideally, if you can
see mismatched air/fuel flow between cylinders, fix the physical reason why that is, as opposed to adjusting
in software!
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Overrun Fuel Cut
Overrun Fuel Cut (or OFC for short) is a method used by some OEM ECUs to turn off fuel injection under
certain conditions - such as rolling down hill with the throttle closed (ie under engine braking.) It can help
with fuel economy and cylinder cooling if correctly configured. By default, most basemaps have it disabled.
You can access the Overrun Settings from the Entity Tree under "Injection", as well as show the status from
the "Overrun Status" DRO.
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The following settings are present:

Enabled
This allows you to overall enable or disable the Overrun Fuel Cut Strategy.

Min RPM
The minimum RPM for Overrun OFC to operate. If the RPM is below this, then OFC will not activate.

Max MAP
The Maximum Manifold Pressure for OFC to operate. Usually this is the MAP you see when in overrun, and
is typically quite a low number, <40KPa in most applications.

Max TPS
This is the maximum throttle percentage for OFC to operate. i.e it will never operate in the above example of
the throttle is more than 2% open - obviously because OFC should only operate when the throttle is
completely closed.

Min CLT
The minimum temperature that the engines coolant should be before allowing OFC operation. Cutting Fuel
during warm up can cause a very "messy" engine to work with.

Init Delay(s) & Cut Time(s)
Once all of the above conditions have been met, a timer will start to count (it is reset to 0 every time the
engine leaves the above conditions.) When the timer reaches the time entered here in seconds, then OFC
will begin to operate, steadily tapering the fuel percentage over the "Cut Time". If for example the Injectors
are at 10% duty normally under these conditions, then once OFC activates in the above example, after 2
seconds, the fuel will taper from 10% duty to 0% duty over the Cut Time, which is 5 seconds. The Injectors
will continually now not inject fuel for as long as the engine remains in the conditions.

Return Time
When you return from OFC, for example the driver presses the throttle or the MAP increases due to load
increasing, then the fuel percetage will 'softly' regain from 0% back to the normally commanded amount over
the time in seconds specified here.

Fuel add trim(%) & Fuel add dur(s)
Because the inlet manifold will have been "dried" during OFC, some extra fuel is usually needed for the
return to normal operation. These two settings define by how much the cvommanded fuel amount should be
enriched, and also for how long this enrichment should occur
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Ignition Configuration
The ignition configuration relates to spark timing etc. The main starting point is the Ignition Driver.
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The Ignition Driver
The ignition driver (System>Ignition Driver) is a simple driver that allows you to set the ignition type.

Off
With Ignition mode set to off, the coil outputs will not be triggered even when Sync is maintained. This is
usually not used as fuel will still be injected (depending on the Injection Driver Fueling mode) which may
then wet-up the spark plugs.

Distributor (Fires Only Coil 1)
This mode will fire Coil 1 an even amount of times per 720* based on the number of cylinders set in the
Engine Driver. For example, if it is set to 4, then every 180* an ignition event will be sent to Coil 1.

Wasted Spark
This mode required only a Crank signal to operate. It will fire through coils up to the total number of cylinders
divided by 2, with an angular seperation between events of 720* divided by the Number of Cylinders.
Example 1: 4 Cylinder will fire Coil 1 then Coil 2 alternately every 180 degrees.
Example 2: 8 Cylinder would fire Coil 1, 2, 3 and 4 with a 90* spacing to each cylinder.
Note the order will also be based on the Firing Order set in the Engine Driver.

Wasted Spark (COPS)
This mode will fire the coils in sequence as per Wasted spark, and it will also fire the matching cylinders
coil based on the firing order in a wasted spark configuration.. This allows you to use individually triggered
Coil-On-Plug ignitions with only a crank signal.
Example, with 4 Cylinders wired with COPS to Coil 1,2,3 and 4, and a firing order of 1,3,4,2, the coils 1 and
4 will be fired then 180* degrees later coil channels 3 and 2 will be fired.

Fully Sequential
This mode will fire the coil outputs sequentially in order as given by the firing order, spaced evenly
dependant on the number of cylinders. This will require both a cam and crank signal to work correctly to
determine the engines phasing.

Fixed Fire (10* Adv)
This mode will ignore all ignition timing information (expect for the trigger offset) and fire at a fixed 10* BTDC.
This is used to help "time up" the ignition triggering.
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It should be set to NO after timing has been set to the Ignition Advance will vary based on sensor/engine
speed data as per the ignition tables.
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Triggering Setup/Crank/Cam Sensors
Before we crank the engine, refer to the section above on setting the trigger types for both crank and
cam(s). Again, note that you do not need to run a cam sensor if you wish to run in batch/paired injection,
but for OEM triggers such as the MX-5/Subaru etc, you must use the correct Cam settings.
When using a Plug-In ECU, the base-maps for your model will have the crank, cam and timing offset details
already set, so ALWAYS load one of them first!
Triggering concerns the ECU being able to accurately measure the current speed and position of the engine.
You can use either VR or Hall-Effect sensors for this, and the ME ECU supports a range of OEM and
standard trigger patterns.
Usually, a wheel with either a missing tooth, or specific pattern (or a sync tooth on the cam) is mounted on
the engines front pulley or cast into the flywheel. A sensor reads this and the ECU can then determine the
engines current position and RPM.
If you only use a crank position sensor, the ECU can only be sure of the engines angle over a 360* cycle
(there are two complete cycles in a four-stroke engine as a piston can be at the top either about to go 'bang'
or just finishing pushing out exhaust gasses) - so it will only be able to run fuelling semi-sequentially and run
ignition in a wasted-spark configuration. If you add a cam sensor, then the ECU can correctly determine
phase, giving a full 720* angle of the 4-stroke cycle, so fully-sequential fuel and ignition (COPs) can be
utilised.
Some images below are sourced from the internet.
Below are a few examples of trigger arrangements:
An after-market 36-1 trigger wheel and sensor fitted to the engines front pulley (AR Engineering):

102 / 197

Motorsport Electronics User Documentation

This is an OEM Vauxhall crankshaft. Note the big "gear" which is in fact a 60-2 trigger wheel mounted
directly to the crank:
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Some engines use purely cam position to determine engine position, such as the RB range of Nissan
Engines (This is mounted at the front of the engine and the centre shaft is turned by the cam-belt sprocket):
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Trigger Types
Be sure to either load a fresh base-map (if using a Plug-In ECU) or obtain a start-up calibration from us to
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ensure the triggers are set correctly for your engine.
You can set the triggering options from within the Engine Driver.
Created with the Standard Edition of HelpNDoc: Free EPub and documentation generator

Trigger Routing
The ME platform has the ability to allow the user to select different pins to be used for trigger inputs. This is
used only in wire-in applications generally. Plug-Ins should use the settings configured as part of the
standard base-maps.
Use the information in the wiring section on how to use either type.
Below you can see the trigger routing box as part of the Digital Input settings. Note that VR inputs are
specific to VR sensors, while Digital Inputs can only accept Hall sensors (or other digitial sensors.)
You would select for each pin the signal that is going into it, as below you can see that the VR Crank (pins
80, 81)and VR CAM A (pins 22 and 23) on the ME442 have indeed been assigned to expect the signals from
those sensors.

The second example below shows how we may use a VR Crank sensor (and therefore wire it to VR Crank),
Cam A VR for the Inlet Cam, and use DIG IN 2 pin as an input for the engines hall-effect Cam Sensor on the
exhaust cam (Cam B).
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You can test that the signals are routed correctly by checking for increasing IRQs when cranking the
engine.
Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator

Getting an RPM Reading & Lost Sync Count
If you are receiving crank (and cam if it is wired) IRQs (see below), and you have set the Cam/Crank triggers
correctly in the System>Engine Driver, then you should now be reading an RPM when cranking, typically of
100-300rpm.
You should also note that the ‘Lost Sync Countʼ number should be stable at zero or a low number. (The
system will lose sync initially when the engine first starts turning, but once at a stable cranking speed, the
number should not continue to increase.)
If the Lost Sync continues to count up, or the RPM intermittently displays, then goes back to zero, then you
potentially have noise in the crank/cam sensor wiring - ensure it is shielded at the ECU end only on the
wire-in versions, and that the wiring is in good condition on Plug-In models of the ME ECU. You can also try
enabling filtering on the inputs in the Engine Driver to clean up electrical noise.
Another test is to make sure you're triggering on the right ‘edgeʼ (the same as swapping the two wires
leading to a crank/cam sensor on older ECUs). Change the trigger edges in the Engine Driver as a test.
Note again that basemaps have these set correctly if using our PnP ECUs or Wiring Looms.
Once you have a stable RPM when cranking, and the ‘Sync Statusʼ DRO reads FULL, you are now ready to
carry out the next step, setting trigger offset.

Remember that changing edges or cam/crankshaft types and settings require a power
reset for the changes to take effect.
Cam and Crank IRQs
The IRQs DROs for Cam & Crank sensors can be found on the ‘Diagnosticsʼ tab, as well as on the tree view
under Diagnostics.
A good layout is shown in the image below:
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IRQs show actual pulses from the cam and crank sensors being received by the ECUs processor. They
will always show a pulse count regardless of ANY settings on the ECU - even if you have the cam
sensor turned off in the System>Engine Driver, but still have it plugged in, it will record and show the
pulses here.
This makes this a useful first test that the Cam/Crank sensors are outputting pulses that the ECU is
detecting. If you have a crank/cam sensor connected, and the corresponding IRQ box does not count up as
the engine cranks, then you likely have a wiring/sensor issue - there is more info in troubleshooting.
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Setting Trigger Offset (Base-Timing)
If you are using an OEM trigger and sensor, please, initially note that:
· ST170/Zetec/Duratec (and Ford Engines with a stock sensor) will usually run a 36-1 crank trigger, and
require either 75 or 255 as their offset depending how the coils are wired.
· Vauxhall XE/VW/BMW/Peugeot, Fiat and other engines using a stock 60-2 trigger will require an offset
of 98 or 278 depending how the coils are wired.
Base-maps for the Plug-In Range already have their settings correct for other engines such as Mazda MX5s,
Toyota, Clio etc. All engine need to have their CAS/base-timing checked, follow the guide below.
If you are using an after-market trigger wheel, or an engine with a moveable sensor position (such as the
MX5 Mk1 with its CAS sensor) then the following process should be adhered to.

Finding and Marking Top-Dead-Centre
At this point, it is best to set Fuelling Mode to OFF in the Injection Driver (Remember to turn it back on
later!) so that the injectors are not commanded to fire - this will stop the bores from flooding during the
following testing. You can find this option under System>Injection Driver in the entity tree.
With a stable, steady RPM when cranking, and the coil rest states set correctly, you will now be receiving
ignition sparks at the plugs - if you are not, recheck your I/O settings, power to the coil & wiring , or try a
test mode on the COIL outputs to confirm the hardware is working as expected. (See Section on Output
Settings and Testing).
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Firstly, it is important to find the TDC (Top Dead Centre) of cylinder one on your engine, and make a suitable
mark on the front pulley and engine casing, ideally with tippex, such that you can see externally when the
engine is at TDC. Most engines have a marking already, as shown in the image below:

You can clearly see the indent in the pulley, and the ‘10ʼ mark (meaning when the indent is aligned with this,
the engine is at 10 degrees before TDC) and the ‘Tʼ mark, which when the indent is aligned with this, it is at
0 degrees - i.e, the piston in Cylinder One is at the top of the bore.
We will then also fit a timing light, such as the one shown below, to cylinder one HT lead - this will then
flash when the ECU tells that spark plug to fire, and by looking at the position of the mark on the front pulley
in relation to TDC marking, and comparing this to the Ignition Advance readout from the software, we can
see if the spark plug is indeed being fired at the time the ECU is commanding it to, and if it is not, we can
adjust the ‘Trigger Offsetʼ number in the Engine Driver to make it correct.

Setting the ECU to Fire in "Fixed Fire Mode"
Because the ECU tries to alter the advance angle (the point at which the ignition spark happens in relation
to TDC) dependant on many factors in the map, we need to stop this from happening, and instead, have the
ECU fire at a fixed angle of 10* BTDC (Before Top Dead Centre), regardless of these map settings.
To do this, go to the Ignition Driver (System>Ignition Driver) and set Fixed Fire to Yes - REMEMBER you
must turn this back to NO after this setup process otherwise the ignition advance will be fixed to 10*!

Now, the ignition advance DRO will ALWAYS read 10* (and the engine is always fired at what the ECU
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believes to be 10*) regardless of the settings in the map, engine speed, environmental corrections, and so
on.

Adjusting the Offset Angle
Now, with the engine cranking, asses where the TDC indicator on the pulley is (when illuminated by the
timing light) in relation to the factory (or mark made by you) TDC marking on the engine casing. Remember
to ensure the timing light offset (if it has a dial etc) is set to ZERO - we should be seeing this spark event
happening at 10* Advanced (BTDC).
We will assume, for the sake of argument, we find that the spark is fact happening at 22* BTDC. This
means we have an error of 12* over advanced - that is, the ECU is commanding the engine to fire at 10*, but
it is in fact firing at 22*, hence the error of 12*.
We will then go into the (System>Engine Driver) , and take 12* from the current Trigger Offset, so in the
below example where it is set to 255, we will change it to 243, and press enter (and the outer box will go
green to signify the change has been sent to the ECU).

It is them simply a case of checking once again with the timing light, eventually confirming the engine is
indeed firing at 10* BTDC on Number One cylinder.
We can then head back over to the Ignition Driver, and change the FIxed Fire mode back to ‘Noʼ, to use the
ignition map and functions of the ECU to decide on the ignition angle to use.
Note that an error of a couple of degrees will not be a factor in allowing the engine to run safely at low load
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on the basemap, and this can be refined later during the tuning process on the rolling road, or while
monitoring for knock.
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Initial Tuning
Many of the 3D tables (in real terms they are 2D but can be represented as a 3D surface, so many ECUs
refer to it as 3D tuning) need to have their axis configured for your particular engine. Most relate to the
measured Load the engine is under, and the other axis relates to the engines RPM. Of course some
engines have different RPM ranges, as well as load ranges, so it is important to configure these tables axis.
The base maps will usually take care of this for you however, here is a guide and explanation as to the
process.
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Setting Fuelling Mode (Alpha-N or Speed-Density)
Firstly, you would of chosen to run either Alpha-N (Throttle based load, i.e. if using throttle bodies) or SpeedDensity fuelling (using Manifold pressure as a load reading) via the System>Engine Driver.
If you are using throttle position to detect load (only used on naturally aspirated engines, where a manifold
pressure reading is not easily possible, such as throttle bodies) then your Algorithm Cfg should be set as
below in the System>Engine Driver:

This will (if you have successfully calibrated your throttle sensor) make the Primary Load DRO read 0-100%
as you move the throttle from closed to open.
If however your are using manifold pressure to measure load, such as on a turbocharged engine, or an
engine with a large post throttle plenum, then the algorithm config should be set as follows (again, in the
Engine Driver):

Now the primary load will be a direct copy of the manifold pressure reading, in kPa, so it will go from around
20 to perhaps 200 if you run 1 bar (100kPa) of boost.
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As a result of these different possible ranges depending on algorithm/load reading, you will need to calibrate
the left hand axis (load) axis of various tables to make the best use of the entire table's size. The tables to
focus on are the Injection>Base VE Table 1, Ignition>Ignition Table (Pri 1), and the Lambda>Target AFR
Table.
The following table is the Target AFR table, and you can see how the left hand column (Primary Load) is set
to go from 20 to 205 - obviously intended for a manifold pressure (Speed Density) based primary load,
running up to around 1 Bar of boost (200kPa absolute pressure).

If we were to use this on a throttle based map, (which as we said, would use 0-100 as primary load, i.e
throttle percentage) then we can see that we would have no difference on target AFR below 20% of throttle,
and almost half the table (rows with load reading over 100) would never be used. Hence the following would
be a much better use of the tables memory - also note we have more ‘resolutionʼ at very small throttle
openings, allowing better control of fuel at these minor changes - 90% to WOT (100%) throttle needs less
refinement as the ECUs interpolation is usually accurate enough.
Tip: Change the axis numbers by double clicking them.

The RPM (top row) should be obvious, and evenly spaced from your idle speed to the maximum RPM of
your engine.
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It makes it easier to tune your engine if the tables axis all match across things like Ignition, Fuel, Boost etc,
so as a setup process, it is a good idea to do this first.
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Initial Test Run
At its simplest, an engine requires fuel, air, compression and ignition to run.
As we now have the sensors and outputs working, as well as confirmed ignition events at the right times for
the cylinders, the next step is to add fuel and air to the mix, and hopefully establish a basic, running engine.
Compression of course is given by the engines physical design (and condition) - if you donʼt have
compression, you donʼt have an engine that will ever run!
In general the the only way to add air to the engine is via the throttle, or, if fitted, an idle air control valve.
To begin with, ignore idle air control, disconnect the electrical connection to the valve if possible, and
instead, allow a small amount of air by physically ‘jackingʼ the throttle open approx 3-5% (or open the idle
bypass screws if applicable). This allows enough air for the engine such that it should run and idle (albeit
high).
With the throttle ‘jackedʼ open, the air part of the engine's requirements to run are met - the next step is fuel.
Before, when testing for RPM Sync, we disabled fuel injection events - head back to the System>Injection
Driver and, instead, set the fuelling to ‘Batchʼ. This will fire all injectors at the same time, and while we can
look at paired and sequential injection later, this simple form of injection will be enough to get running (and
indeed most early 90s engines used batch injection full time.)
An in-depth explanation of how the final Fuel Pulse Width (the time in milliseconds the injector is fired for
each cycle) is derived can be found later in the manual, however for now, it is worth noting what we should
expect to see when cranking.
For this part, open the ‘Mappingʼ Tab in MEITE, as shown below:

Here we can see the Injector Pulse Width DRO in the lower left (which is reading zero in this example due
to there being no RPM input).
If you have already loaded a suitable basemap, and configured your engine specifics, including injector size
in the System>Engine Driver and System>Injection driver, then carry out a quick sanity check of all of the
sensor readings, and if everything checks out, crank the engine.
Immediately you should see a stable RPM reading, as well as the Injector Pulse Width reading. This
number will vary depending on engine size, injector size and temperature, however, typically 10-20mS is
typical for a cold engine, with 2-6mS typical for a warm engine.
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If the engine springs to life, (it may be idling high/low etc) then you have won the most part of the battle, and
you can continue on with tuning, however, of not, there are some symptoms and possible fixes (as a get
you running fix) listed in the "non-start Diagnosis" section of Troubleshooting.
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Tuning of VE (Fuel)
With the engine now running, allow it to reach normal operating temperature - typically 70-95*C. This is to
ensure no warm-up corrections are taking place, which can be verified by looking at the DROs under the
‘Environmentalʼ section of the tree view - they should all typically say zero.
You will need a wideband lambda system to correctly tune the VE table - if you do not have one, then you
may cause damage to your engine if you cannot verify correct fuelling - it is best at this point to either
purchase one, or take the car to one of our agents to have the engine professionally tuned.
With tuners all over the UK, and more and more being added across Europe and worldwide, car transport
will always be cheaper than a new engine.
You should also check that lambda control is currently in-active, by disabling Lambda under the Lambda
Settings driver (Lambda Control>Lambda Settings) by changing ‘Typeʼ to ‘Disabledʼ. Note that the WBO2
Curr. AFR will still display an AFR if you have correctly wired your wideband O2 controller to the ECU.
You then ensure your target AFR table is set correctly (Lambda Control>Target AFR Table). A typical table
for a turbocharged Mazda MX-5 engine is shown below:

We won't go into detail about the perfect AFRs to run in different areas of the map, as it varies from engine
to engine, however, typically:
●
As load increases, the engine mixture should be richened. Typically, around 13:1 AFR on naturally
aspirated engines at high load, and richer still (11-12:1 AFR) on forced induction engines as you enter boost.
●
Idle should be around 14-14.7:1 AFR
●
High RPM, low load should aim for 15:1 AFR for a ‘lean cruiseʼ to increase MPG.
We won't go into the fine art of tuning here, as that is very much something that should be ‘knownʼ to get the
best from the ECU, however, we will cover the basics. (Refer to the MEITE Manual on the keys/functions of
the 3D table views.)
As per the fuelling model at the start of this guide, we know we need to get the right amount of fuel in there
for optimum power and also safety at any given load and engine speed. Load can be derived either from
throttle position (when running a naturally aspirated engine) or from manifold pressure when running a
‘chargedʼ engine.
It is worth noting that a VE table will often ‘lookʼ like a torque curve - where the most VE is, is the same
point where the most fuel can go in, and the more fuel that is burnt CORRECTLY means the most torque is
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produced at that point.
Here is a turbocharged MX-5 VE table, we can see that more power is produced as manifold pressure
increases (i.e the more open the throttle and the more boost we have), and also that peak power is around
5,500-6,000RPM, as shown by the red areas of the plot.

If you are used to older pulse-width based ECUs then you will be compensating in your main fuel table for
the fact that a turbo charged engine requires rich (11-12:1 AFR) mixtures under boost, and leaner mixtures
around cruise and idle.
With our VE based model, we only need to map the engines REAL VE as we have another table that takes
care of what we would like the AFR to be (in terms of the maths behind converting a VE into fuelling, whilst
taking consideration the required mixture ratio at that point in the engine's operating range), and that, is
rightly named ‘Target AFR Tableʼ under the ‘lambdaʼ node:
So, we can see it is important to set the Target AFR Table FIRST, and then tune the VE table to reach these
AFRs at each point - ultimately, reverse engineering the engines ability to pump air - or - its Volumetric
Efficiency (VE).
If you were to change the cams, cylinder head design, exhaust etc, then you would effect the VE - correct
for those changes in the VE table, and the engine will still make the target AFR you have specified. The
reverse is true: If you map the VE of the engine correctly such that the AFRs match the target AFR table,
then any-time later you could change the AFR table, perhaps going from 12.6 to 12.1 at a certain point, and
the VE algorithm will modify the fuel pulse width accordingly to reach that AFR, accurately.
NOTE: If you are using closed loop wideband lambda control, it should be turned OFF when mapping, or
else the ECU will trim the fuelling to reach the AFR set in the Target AFR Table. This could be used as a
‘cheatʼ to map the engine - simply turn on closed loop wideband, and adjust the VE table live such that the
‘Fuel Lambda Trimʼ is as close to zero as possible - if the closed loop wideband algorithm is trying to richen
the mixture, then increase the VE number at that point, if trying to lean it, then reduce the VE at that point a ‘man in the middleʼ auto-tune algorithm….
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Tuning of Ignition Timing
Much like VE/AFR tables, it is important to first scale your axis correctly. Ideally, just match the VE tables
axis. (You can copy and paste axis between by right clicking them).
Ignition timing, again without going too far into the aspect of advanced tuning, works in a fashion like this:
●
As RPM increases, ignition ADVANCES (Increases, the spark comes EARLIER in the cycle)
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●

As LOAD increases, ignition is RETARDED (reduces, sparks LATER in the cycle.)

As a result, you can see a typical turbocharged engines map here (Running to 1.45 Bar of Boost, 245kPa):

As a rough guide, most engines will idle at around 10-20* of timing, so if you're simply trying to get the
engine running, you could block change (select the cells and use the ‘=ʼ key) the entire top left area to 15*.
It won't be anywhere near perfect, but for most engines, it's close enough before full tuning on a rolling road.
The resultant map could look like this:

Tuning of ignition should always be carried out with caution, too much advance could cause serious knock
and result in engine damage. Always use knock detection equipment where possible - for best results, use
a rolling road or engine dyno to find the minimum required advance for the highest torque reading, typically
discussed in books and online resources as “MBT” or Minimum Best Torque/Timing.
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Startup and Warmup Tuning
It is important that you have first, properly tuned the VE and ignition tables, at least around the top left areas
of the maps, that is the idle and cranking areas. You can note which areas of the map the ECU references
during cranking by watching the yellow cross hairs in the Base VE Table while cranking.
Without a correctly tuned VE table, you cannot expect start up, warm up or idle to operate correctly - be
sure to get the engine arm, tune the VE, then work on the starting procedures fine tuning.
Various control strategies are included in the ECU for the easy starting of the engine, these include control
over the priming pulse, cranking fuel, initial after-start enrichment, and further Warmup Enrichment. Although
usually considered the more time consuming areas to tune (the engine must be cold from each tuning
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attempt), once correctly set, the engine will start and warm correctly in any environmental condition.
The default tab (when using a default layout in MEITE) for this area is the ‘Crank_ASEʼ tab, as well as the
‘Warmupʼ tab, both pictured below:
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Priming Pulse
The priming pulse is triggered whenever the ECU is powered on or when cranking starts (as set in the
Injection Driver), and opens the injectors for a pre-set duration (in combination with powering the fuel pump)
to spray in some initial fuel to wet the walls of the intake. It can be changed from the Start-up->Priming
Pulse table, to reflect different pulse lengths at different temperatures.
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Cranking Fuel
When cranking, the engine may require more or less fuel to get started correctly. The ‘cranking RPM
windowʼ can also be set such that this fuel modification is only carried out during a set RPM range. Typically
50-400 RPM. Once the the engine RPM goes above this upper cranking RPM, the After-Start Enrichment
Algorithm becomes active. The driver for these settings is Startup>Startup Settings.
Under cranking, we need only be concerned with the Start up Settings box, and the Cranking Fuel Trim
table, which takes the current PW (derived from the VE table and other corrections) and multiplies it by this
tables output which is looked up based on engine temperature.
Similarly to warm up/environmental trimming, we see that once the engine is warm (in this case in the
image below 60*C) we no longer add extra fuel when cranking (the table is set to 1.00) as the engine will
usually start purely from the fuel requirement derived from the VE table.
As a guide, if the engine requires throttle to start (i.e, you're letting more air in) then the cranking enrichment
multiplier is too high.
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After Start Enrichment
After start Enrichment, or ASE, is an initial, short lived duration of extra fuel enrichment to help the engine
stabilise after cranking and initial fire-up.
ASE is triggered as soon as the engine RPM rises above the ‘Cranking Max RPMʼ (typically 400), (found in
the Startup>Startup Settings) and it then occurs for an amount of time, looked up in the ASE Decay Time
table based on the coolant temperature. Generally, the colder the engine, the longer the duration of ASE.
The ECU will look at the required fuel calculated from all other factors, and then multiply it by the ASE Fuel
Trim as soon as ASE begins, then taper this addition off evenly over the ASE Decay Time. If you wish to not
use any AE, then be sure to set the ASE Fuel Trim to '1.0' across the entire table so it has no effect. Typical
tables are already pre-filled for you in our basemaps.
You should tune ASE such that the engine is stable after initial startup, and usually reading slightly rich. If
the engine bogs with light throttle presses in the first few seconds after starting, but gets better as the
engine warms, then try increasing ASE by 5-10% increments.
The ASE Trim and ASE Decay Time Left DROs show how much ASE is effecting the fuelling.
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Warmup Enrichment
Much like a traditional carburettored engines choke, the ME ECU range allows a modifier to the fuelling to
be carried out in order to enrich the mixture when the engine is cold, or in a state of ‘warm upʼ. Note that
this is different to the cranking fuel, and After Start Enrichment (ASE is a quick over-rich state that happens
for the first few seconds.)
The Fuel CLT Trim Table allows you to enrich the mixture based on the reported coolant temperature. Be
sure to have your coolant sensors HRT/Calibration correct (see calibrating coolant sensors). The final
fuelling pulse width is multiplied by this tables output (shown in the ‘Environment>Fuel CLT Modʼ digital
readout). Note that above 70*C in the table shown above, the output is ‘1.0ʼ, or in other words, no longer
modified. It would also explain why you should only tune the VE of a warmed engine - otherwise you have
corrections fighting you!
The ECU also provides a coolant based ignition trim table, should you wish to add advance to a cold engine,
to increase engine speed without the use of any form of idle control. Normally however, this would be left at
1.00 across the whole table.
In terms of tuning, again, only attempt this after VE has been properly tuned, it is simply a case of targeting
your prefered idle mixture (or slightly richer) through all stages of the engine warming up. Adjust this table in
real time as the yellow cross hairs ‘walkʼ along it as the engine warms.
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Acceleration Enrichment Tuning
The ME system uses two methods of AE. You can use either the Manifold Absolute Pressure (MAP) or the
Throttle Position Sensor (TPS) to calculate the rate-of-change, or ‘Deltaʼ of the throttle plate. Note that MAP
based AE is ‘okʼ but for the best drive-ability, TPS based AE is preferred, and in any cases vehicles not
fitted with a TPS will lose out on other ECU features, so it is always recommended to fit a linear TPS
sensor. Please read the section on ‘Throttle Sensor Calibrationʼ.
The following tab layout is recommended to carry out AE tuning, and it assumes that the VE table under
steady state is mapped correctly, and the engine is warm.
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You will need the following widgets open:
●
Acc. Enrich Driver
●
Acc. Enrich RPM Clamp Trim (table)
●
PW Table Acc Delta Enrich (Table)
●
RPM, TPS%, Acceleration Delta, ACc Enrich VE Add (%), Total VE (%), Injection Pulsewidth DROs
Before we cover tuning the AE, the theory needs to be covered:
Acceleration enrichment (AE) is used in a fashion like ‘pump jetsʼ on carbs - it is designed to enrich the fuel
as the throttle is opened, to compensate ‘in advanceʼ of the drying of the intake manifold, and the increase
in airflow, before the VE map takes over and provides steady state fuelling.
Firstly, we must tell the ECU which type of source we will use to calculate the Accelerator Delta (its rate of
change) either MAP, or TPS. We always advise using TPS when possible.
Now the ECU needs to know when it should enter acceleration enrichment, and this is configured in the
Accel Driver via the ‘deadband(%/s)ʼ setting.
With the engine idling, or under general driving, take a note of the Accelerator Delta DRO, (datalog may be
easier for on road testing) and in steady state conditions, it may still fluctuate slightly (especially if using
MAP based AE). The number you should enter in the ‘deadbandʼ box should be slightly higher than this
number, such that AE is not triggered by normal steady state (no throttle movement) driving or idle
conditions.
At higher engine speeds (RPM), AE is not really needed, and you can set at which point we start to ignore
AE in terms of RPM with the Acc. Enrich RPm Clamp Trim table. In the above screenshot you can see at
2500 RPM we only apply 12% (0.12) of the calculated AE enrichment value, and above 4000rpm we donʼt
apply any extra fuel at all. This will of course depends on your engine, and would be part of the tuning
process.
The most crucial part of the AE tuning is the Hold Rotations, Decay Rotations and the main PW Table Acc.
Delta Enrich.
When we enter the AE algorithm (i.e when we detect a Delta of larger than the deadband) we take an initial
VE reading of the engine from the main fuel map (lets say 40 in this example). We then multiply this number
by the number calculated in the PW Table Acc Enrich. So in the above table we can see that as we have
more delta (or quicker change in the throttle) we have a larger number, but lets say for example this table
yields ‘1.5ʼ at the current delta, so the result would be 60. We then add 60 to our original VE, and we are
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given a total calculated VE of 100.
Now we apply this enrichment consistently to the VE from the main map for the amount of ‘hold rotationsʼ of
the engine (engine cycles) which may be 3 or 4 or 5 etc, and once the engine has performed this many
rotations we then decay the fuel off evenly over the ‘Decay Rotationsʼ.
The end result is a burst of extra fuel with its size being related to how much we have opened the throttle,
which then tapers down, all the while taking into account the clamp modifier amount based on RPM, and by
the time the AE extra fuel has decayed off, the normal VE table should be applying the correct fuel to keep
the engine at the desired AFR.
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Idle Control
The ME range allows several methods of idle control. Closed Loop, Open Loop and a ‘fixedʼ idle duty are all
achievable with the ME system. Spark Scatter can also be used for further fine tuning of idle.
If you are using a Plug-In ECU, the suitable OEM calibration file should contain tried and tested idle control
settings to deliver as close to (and in some cases exceeding) OEM performance and response.
You may have had the throttle ‘jackedʼ open mechanically to aid in startup and VE tuning, it is now a case
of mechanically reducing this idle such that when the engine is warm it indeed idles at your target warm idle
speed, even with Idle air control bypass unplugged/blocked.
Your engine should be set to mechanically idle well, and all sites around idle in the VE/Ignition table be
tuned accurately.
Idle control can't stop an unsteady system from being unsteady.
If your engine will not remain at a steady idle speed on a throttle stop, then you have basic tuning issues
which need to be remedied first. Yes, it may not be able to compensate for sudden electrical/AC/Power
Steering loads etc, but in a steady state condition, it should stay steady state.
Note that the ME221 does not support stepper based idle motors, only the more common PWM bypass
type. The ME442 supports stepper based idle also, as well as Drive-by-Wire idle control.
The idle settings are exhaustive - OEM idle (and sometimes even better) on a correctly tuned ME ECU is
more than achievable:
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PWM Based Idle
Pulse-Width-Modulated idle control is a system that allows air to bypass the throttle by varying amounts
based on the Duty Cycle of a signal sent to a solenoid valve.
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It can be thought of as a tap - if the signal is "never" on, then the valve is closed, if it is "always" on, then the
maximum air the valve can flow will flow. If we turn the signal on and off rapidly, (usually around 100 - 300Hz)
and vary the on time to off time, then the valves flow will also vary by the same amount.

The turning on and off, electrically speaking, is done by the valve usually receiving an ignition switched 12v
supply on one pin (or one side of the coil inside), and the ECU turning on and off the ground signal to the
other pin (other end of the coil winding), using one of its PWM Low Side Outputs. This makes the plunger
inside move forward and backwards very quickly, giving the desired air flow through the valve. Note that
PWM Boost Control works in a very similar way only changing the flow to the turbo actuator.
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In order to use the PWM (Pulse-Width Modulated) Idle valve, the ME ECU needs to know the valves control
frequency (PWM Base Freq), min and max duties, and whether more duty equates to more or less air flow
(These should all be available in the valves data-sheet, or from online knowledge bases). Enter these
numbers into the relevant fields into the idle driver.
In all cases the PWM valve duty (the percentage of time for which it is ‘onʼ) will not be modified unless the
TPS and RPM settings fall into the desired ranges, which we call the ‘idle zoneʼ. The Idle Status DRO
indicates the state of the idle algorithm.
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PWM Setup Process
It is important to follow the following process to tune your PWM idle control:
1. Tune the VE and ignition tables correctly.
2. Disconnect/blank the idle valve and set the engine so it MECHANICALLY (via throttle stops/air bleed
screws) idles at your desired idle speed (say 950rpm) when the engine is warm. Tune the VE Table so
AFRs are correct. Do not aim for 14.7 at idle, usually slightly richer is better. If your engine wont idle
mechanically set on the throttle stop, then idle control will be of no help at all!
3. Reconnect your idle valve, and using idle settings, set your idle drive frequency and then set to idle
mode to Manual Mode.
4. Adjust the Manual idle duty (which takes effect even if outside of the idle conditions) up and down. Find
the lowest number at which a difference happens (say 15%) and set that as your "PWM Min Duty".
Then find the max manual duty that you hit your maximum required idle control speed, which might be
1400RPM, (and might be 55% for example) and set this as your PWM Max Duty.
5. Set your Exit Idle Duty (under conditions) to the same number as PWM Min Duty. This means when the
RPM/throttle etc are outside the idle zone, such as when driving, the idle valve returns to the "closed"
state.
6. Allow the engine to cool completely.
7. Next set the idle mode to OPEN LOOP.
8. Check your idle conditions are set correctly such that idle mode is normal when you run the engine. If it
is out of range, adjust conditions, check throttle sensor etc.
9. Now as the engine warms, adjust the Idle OL Duty table such that the engine idles how you want it. If
you had a maximum of 55% and a minimum of 20% you may find that from very cold temperatures you
start at 45% and taper down as temperature rises to the Min. PWM duty number. It is important to set
the OL Duty Table correctly even for closed loop as it is used for startup and return to idle control.
10. If you're happy to run Open Loop, then essentially you're done - enjoy - however if you wish to run
closed loop which will automatically compensate for electrical load, oil pressure and so forth, then
continue on below.
11. For closed loop, we need to know the idle speeds you would like dependant on coolant temperature.
Set these in the Idle target RPM table.
12. Next, set the idle mode to Closed Loop, and tune the PID settings. The closed loop tuning example has
more info on this.
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PWM Idle Configuration
The Idle tab when using a default layout is shown below:
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The Idle Settings are the first port of call when configuring idle.
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Idle Mode
For details on Idle mode, there is a specific page in the manual here. Note some options will appear and
disappear on the idle settings window depending on mode.

Drive
Drive allows you to select how your physically controlling idle, either though a PWM Idle valve (in which
case the final output duty is routed to "Idle" which can be assigned in output settings to a PWM channel), or
DBW which routes it to the Drive-by-Wire controller - details on setting up Drive-by-Wire Idle are here.

PWM Drive
The PWM Drive settings allow you to set the valves optimum drive frequency (in Hertz) as well as its Min
and Max Duty at which its effective. It also allows you to set the Valve control mode, either normal or
inverted. If More Duty=More Air flow then the valve control mode is normal, otherwise, its inverted. More info
is covered in the PWM Closed Loop Idle Tuning Example.

DBW Drive
DBW TP Max is the maximum authority the idle algorithm has over the DBW position. details on this are in
the DBW Idle guide.

CL Startup
Close Loop Startup are modifiers use for starting the engine, giving idle flair etc, as well as "RTI/Return to
Idle". A guide on tuning this section is here.

Conditions
These are the conditions which must be met before the idle control algorithm actives. You can see the idle
status in the idle status DRO.

Close Loop Config
These are the specific PID settings for the idle algorithm. The idle tuning example contains further
information.
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PWM Idle Modes

PWM Manual Duty

With the idle control mode set to Manual Duty, the only idle settings in the idle driver that is relevant are the
‘PWM Manual Dutyʼ. Entering a number here will force the idle-valve to run at that duty when idle state is
achieved. A good, shorthand test mode, or can be used as a software adjustable ‘idle screwʼ. In all other idle
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modes, this value/setting is ignored. Idle conditions are ignored when in Manual Mode. The drive will always
be driven at the user set duty when the ignition is on.

PWM Open Loop
In open-loop mode, the ECU will run the idle valve at the duty looked up from the Coolant based idle duty
table (Idle>Open Loop Table). This is sufficient for most race engines, but will lack some of the ability to
handle extra ‘idle loadʼ such as headlights or AC being on - and as a result may need to have a higher than
normal idle speed set to compensate. It is typically very good however, and enough to get you to the tuners
for fine tuning. If you have problems with Closed Loop tuning, Open loop can be a real help to ‘make doʼ until
more time can be invested, or knowledge gained, in idle tuning. In the below example, you can see the valve
is driven at 25% until the engine starts to warm at which point it tapers down to around 20%.

It is worth noting that the open loop table also forms part of the functionality of Closed Loop idle control, so it
should be tuned correctly at all times.

PWM Closed Loop
In closed loop mode, the ECU will use a PID algorithm to attain the target RPM looked from the CL Target
RPM table (based on coolant temperature). It will also compensate for additional loads at idle (such as
AC/lights) to try and maintain the idle. PID settings P, I and D, as well as the update interval determine how
this function operates. For further information on PID tuning (which other areas of the ECU such as closed
loop boost control use) please see the relevant section in the appendix. DROs such as target RPM, target
Error and the P,I and D terms can be added to the current tab to aid its tuning.
The Closed Loop algorithm also features the ability to ‘flairʼ the engine speed on starting, as well as smooth
the engines ‘returnʼ to idle after driving. To do this you must first calibrate your OPEN LOOP duty table such
that a steady, desired RPM is held for all coolant temperatures. Typically you would aim for 1,200rpm when
cold and around 950 RPM when warm, though this of course varies with engines. Do this by setting the idle
control to ‘Open Loopʼ mode and tune the OPEN LOOP DUTY table to achieve these results.
The starting strategy in closed loop mode will also reference the Open Loop Duty table, so it is important it
is set correct, as when in closed loop mode, and the engine is below cranking max RPM, the duty of the
idle valve will be set to the Open Loops table setting, plus an addition of duty % defined by the ‘CL Start
Inc(%)ʼ. This increase causes the engines RPM to be higher on initial start.
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Once the engine catches, the duty (and thus the engines RPM) will be held at this higher level for a time in
seconds set by the ‘CL Start Delay(s)ʼ field. The duty will then taper to closed loop mode - this stops the
RPM ‘dippingʼ low once the engine has started. Typically you would add around 10-15% duty, and hold it for
5-6 seconds.
The other additional settings for the closed loop idle are under the ‘CL - RTIʼ (Return-to-Idle). This dictates
what the idle duty should be (and then again, held at) once returning from a driving state (ie higher
RPM/higher TPS etc) such that the idle catches correctly. Typically a small addition of duty (3-5%) and a
smaller hold time (1-3 seconds) will usually suffice to have the engine return to a steady closed loop idle
from any running condition.
An example process of tuning PWM Closed loop is here.
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Startup and Return to Idle Setup
The ME's idle control system offers OEM type flexibility in terms of idle start flair and return to idle
stabilisation.
The below applies to closed loop idle modes:

Startup
When the engine starts, the idle duty is set to the current setting in the Open Loop Idle Table at the current
temperature (even in closed loop this happens, so its important to tune your open-loop idle table firs) plus
the CL Start Inc (%).
It will be driven at this duty until the engine RPM goes over the Cranking Max RPM (typically 400) defined in
the Startup>Startup Settings. Then idle will go into normal mode after the CL Start Delay time (below its set
to 6 seconds)/
For example lets assume the engine is at 30 degrees. You can see below the OL (Open Loop) Duty table
would be commanding 60% to the valve. The CL Start Inc setting is 15%, so the valve will be driven at 75%.
Note if the PWM Max is 70%, then it will be clamped to 70%.
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Return to Idle
When the engine falls from a higher RPM back into idle conditions (such as when the driver comes to a stop
with the clutch depressed) then the idle mode will go to RTI (Return to Idle). Like the start-up, the CL RTI Inc
will add onto the OL table value at the current engine temperature, and hold that duty for the time set in CL
RTI Delay(s).
In the above example, lets now assume the engine is warm at 90* (and as a result the OL table commands
30% idle duty) then as soon as the idle conditions are met, the idle valve will be driven at 35% (30% from OL
table plus 5% from the CL RTI Inc setting) for 1 second.
Tuning these values are usually best left to an expert in tuning. Essentially, RTI should be set so the engine
doesn't "hang" for too long as it approaches idle, but not too short that the idle is unstable and the engine
"dips" to a low RPM.
Start-up flair is really down to users choice. A high flair will result in an easier to start engine, but may sound
a bit "amateur" - a balance is always attainable however, and it will act OEM once tuned correctly.
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PWM Closed Loop Idle Tuning Example
The following assumes a PWM valve such as used in this example on the 1990 MX-5 1.6.
Note that the following draws on further technical PID tuning information found in the Appendix.
To begin with, we need to know the base frequency at which the valve operates. It is best to either scope a
factory control valve, or to research this on the web. The OEMs take into consideration the mass of the
valve, the inductance and other factors to find the best control frequency. In the early MX-5ʼs case, this is
160Hz. We enter this into the ‘PWM Base Freqʼ box.
Next, we need to get the engine running, and of course we are assuming a correctly mapped VE table and
ignition table.
With the engine running, and warm (and extra electrical load like headlights, blower heater, heated seats etc
OFF), its now time to set the ‘fail safeʼ, mechanical idle. All throttle bodies usually have an adjuster, or air
bleed screw. With the IAC valve unplugged, or physically blocked, set the air bleed/throttle stop screw such
that the engine idles at your ideal idle speed when warm, say 950rpm. This means that worst case you have
a steady, usable idle to take it elsewhere to be tuned if you're unable to.
Next, we need to find the limits of control of the idle valve. To do this, we set the idle control mode to
‘manual dutyʼ.
Now, we can enter numbers in the ‘PWM Manual Dutyʼ field, which is the percent the valve will be driven ‘onʼ
for.
What we are trying to do, is find the smallest number where any less doesn't SLOW the engine, and the
LARGEST number where RPM doesn't increase anymore (or goes to a silly high idle such as 2,000rpm etc).
Start at 50%, and work up and down in 5% steps until you find these limits. It is also worth noting that if you
increase the number, and the engine SLOWs, (or if decreasing the number the RPM goes up) then your
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valve operates in an ‘INVERTEDʼ manner (which is true on some of the MX-5) so set the ‘PWM Valve
Controlʼ drop down to ‘INVERTEDʼ. The result of which is that a reported higher Valve Duty (from the Idle
Valve Duty % DRO) means MORE AIR is being allowed into the engine, and hence a higher RPM. (In
inverted the valve is actually driven LESS as this number goes up, but the end result is the same - a bigger
duty %, a faster RPM).
On the MX-5 in this example, moving up and down through manual duty %s, we find the minimum to be
around 27%, and the maximum to be around 55%, so we enter these into the respective PWM Min/Max
Duty fields.
We have now allowed the valve to only work in the range where it can actually do something - running at say
10% would be useless, as the slowest engine speed is reached at 27% - no need to go any lower on the
output duty!
With the ranges set, its time to take a starting guess at the PID settings. Generally, we would set the
update interval (or how often the algorithm will check and adjust) to 50ms (20 times a second), so letʼs enter
the ‘PID Upd Intervalʼ as 50.
Also, we can pre-set the P term to ‘0.8ʼ and the I to 800, and D term to ‘0ʼ. Note that typically for idle
control, the D term will always be left at Zero.
We must also make sure our target RPM table makes sense - it should go from the fast idle RPM at cold
temperatures down to the normal RPM at warm temperatures.
With the engine running and warm, we should see the ‘Target RPMʼ readout showing approx 850-1000 (or
whatever your table has it set to.
Next ensure that all of the other settings enable idle to happen when it should, ie at certain RPMs, throttle
positions and so forth, all settable from within the idle driver.
Now turn on the ‘PWM Closed Loopʼ mode, and note that the idle status indeed turns to a ‘Closed Loopʼ, to
indicate it is TRYING to idle, and the algorithm is active, and note the ‘RPM Errorʼ readout which shows how
far from the target RPM the engine currently is.
Now to tune the PID….
There is a very detailed guide in the appendix, but from a layman tuner perspective, here is a brief step-bystep.
1. Increase the P number such that the idle oscillates around the target RPM by around +/-200rpm.
2. Set the P to about half of what it was when it started oscillating.
3. At this point start to steadily increase the ‘Iʼ value which should ‘smoothʼ the operation of PID and
allow it to reach a steady idle. As a guideline, this number is normally very close to the oscillation
period measured above (in milliseconds).
4. You should see the duty readout moving around trying to find the ‘sweet spotʼ that gives a smooth
idle.
5. Load the engine/Rev the engine and allow it to fall back into idle etc. Increase the ‘Pʼ to improve
response time (back it down a bit after you're getting oscillations) and decrease the ‘Iʼ to make it
‘catch fasterʼ while in steady state.
6. As a rule of thumb, the ‘Pʼ and the ‘Iʼ work in opposite directions. Increasing the ‘Pʼ improves
response time, but increases the chance of getting oscillations, while increasing the ‘Iʼ makes the
system more stable and decreasing it makes it respond faster in ‘steady stateʼ.
7. As a second rule of thumb, always reach a stable value for ‘Pʼ before adjusting ‘Iʼ or ‘Dʼ (you shouldn't
ever need to use ‘Dʼ unless you really know what you're doing)
The overall idea is that PID can be tricky to tune - but when it is correct, the engines idle will perform as if
OEM, fast to respond to load changes and stable. We have listed some default IAC/PID settings in the
appendix for various engine models, and as more are discovered by us or reported to us we will add to the
list.
Remember some cars, such as the MX-5 feature an air bleed screw on the throttle body. With the Idle
control running in closed loop, and PID working properly, you should adjust this bleed screw such that the
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valve duty (which will automatically change to account for changes to the air bleed) should sit in the lower
quarter of the PWM Duty range when the engine is at warm idle. i.e on the MX-5, which has a range from
28-50%, we would adjust the bleed until the engine idles warm at the target RPM with a PID controlled valve
duty of around 30% - this allows the valve to have more ‘up RPMʼ when it needs it, rather than being ‘maxed
outʼ in the fast or slow valve duty.
Note: All initial settings should be done with the engine fully warmed up and with all extra electrics (i.e
headlights and wipers etc) off.
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Stepper Idle Control
This functionality is coming soon.
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Drive-by-Wire Idle Control
Please see the drive-by-wire idle guide.
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Idle Spark Scatter
Idle Spark Scatter is a useful strategy to help maintain a steady idle by adjusting the ignition angle in real
time to vary the engines torque. We will be using the Idle Tab in a default layout.
You will need to set your Idle Conditions (marked blue in the image below) such that the ECU knows when it
should be in idle mode. You will need a correctly calibrated throttle position sensor for this to function.
It will activate whenever the engine is in the Normal Idle mode (as shown by the Idle Status DRO, marked
green), and will then look at the target RPM table (pink) for idle , and adjust the ignition advance by looking
up the current "error" (the difference in the engines current RPM from the Target RPM, shown with the yellow
border below) in idle speed and applying the modification to the final ignition advance based on the Idle Ign.
Av. Spark Scatter Table. (red).
You can see below in the spark scatter table (bordered in red) as we go over the target RPM, we take off
some advance, up to around 10 degrees, then as we approach target RPM, we no longer modify the
advance, and finally ikf the engine starts to slow below the target RPM, we add around 10 degrees advance
at a -300 RPM error. Tuning will find the best results as needed.
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Idle Fuel Trim
There is also a PWM Fuel Modifier table which will add extra fuel based on the idle valve duty. For MAP
based maps, this can generally be left at 1.0 across the table, though in usual ME fashion, the option to use
it as a trim is there if required.
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Knock Control
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Knock can be defined as the spontaneous ignition of portions of the mixture, before being reached by the
flame front.
The effects of prolonged knock are extremely serious and include, but are not limited to: blown head
gaskets, holed piston crowns and engine seizure.
As this is not intended to be a guide on how to tune, but rather how to use the ME ECUs to apply existing
knowledge, we wonʼt go into too much detail about why knock occurs and how it can be prevented, although
some of the factors that determine detonations are: high ignition advance, incorrect combustion chamber
temperature management (high Exhaust Gas Temperatures, improper cooling etc), low-octane fuel and high
compression ratios (static or through forced induction).
The ME-range of ECUs feature an advanced Digital Signal Processor that allows the ECU to filter out a lot of
the background noise made by the engine, greatly enhancing the ability to detect knock at higher RPM.
Please be aware that, as with all knock detection systems, this is a “reactive system”, meaning that it can
only detect and try to prevent knock after it has occurred, its role being to complement a good tune and
guard against unexpected conditions (very high ambient temperatures, part failures), not act as some form
of auto-tune for ignition advance. Install a standard Bosch Knock sensor as detailed here.
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Frequency and Sensor Types
The frequency at which knock occurs depends mostly on piston diameter and in-cylinder temperature. There
are two types of piezoelectric knock sensors: tuned (resonant) and broadband (non-resonant). Tuned
sensors are factory-set to amplify the signal only around the desired frequency range, while significantly
reducing the rest of the frequency spectrum. While ECUs using older technology which lack signal
processing capabilities require this, our ECUs function best on broadband sensor, a sensor which captures
the signal in its entirety and can be used in any engine configuration.
Suitable sensors include the Bosch one available on the Motorsport Electronics webstore.
Weʼll start by examining the knock signal coming from the sensor. In exactly the same way as a
microphone converts your voice into an electrical signal, a broadband knock sensor will pick up the
vibrations produced by the engine while functioning and convert them into an electrical signal. Because of
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the different intervals and moments in time when each event in the engine happens, all these noises and
vibrations are distributed over a wider range of frequencies.
The knock signal processing component of the ECU then has to correctly isolate the signal around the
knock frequency and monitor its value. When it goes above a certain threshold, the engine is knocking.
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Knock Settings
You can adjust a range of settings in regards to knock control and the parameters that can be monitored
(Under Knock Control in the entity tree in MEITE):

●
Enabled - Controls the ignition and fuel trims, knock readings will still work even if set to ‘Noʼ.
●
RPM Min/Max - RPM range in which the knock control to act.
●
Max. retard(deg) - Maximum number of ignition degrees to subtract from the advance number when
knock is detected.
●
Rots. / retard step - How many engine revolutions before ignition is retarded by ‘Retard step (deg)ʼ
when knock is detected.
●
Advance step (deg) - When knock is no longer detected, how many degrees of timing should be
added back for each step.
●
Windows start (deg) - Not used for now, knock window starts with ignition event
●
Window len. (deg) - the duration (in crankshaft degrees), after the start of the window, during which
the ECU listens for knock. Known as “Knock Windowing”.
●
(Reset) Time constant (us) - Admissible interval is 40 to 600 us
●
(Reset) Gain - Admissible interval is 0.111 to 2.
●
(Reset) Band-pass frequency - Admissible interval is 1.22 to 19.98 - The engine-specific frequency
which should be used for identifying knock. Signal processing will be done to only keep a narrow frequency
band around this, the rest of the signal being ignored.
Warning: Settings marked with (Reset) require a power cycle of the ECU to apply the changes to the
DSP system.
There are several 1D tables that also specify how knock operates. These are:
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Knock Acc. Val Table - Determines the acceptable knock reading according to RPM. Should generally
decrease as the RPM increases.
Fuel Knock Trim Table - A simple multiplier to add fuel when knock is detected
Knock CLT Scale Table - A multiplier to modify the acc. Knock reading depending on temperature.
The outputs of the knock module (which can be viewed as DROs) are as follows:
Knock Status - Current status of knock control module (Disabled, No Knock, Outside RPM, Max Retard Ign,
Retarding Ign, Advancing Ign)
Knock Reading - The live value read from the signal processing module. This will decrease with RPM.
Because the window length is determined in crankshaft degrees, its duration (in milliseconds) will be lower
as the RPM increases (60* is 8.3ms at 1200 RPM, but only 1.66ms at 6000 RPM). As a result, the
“accumulated” value (which gives our reading) decreases as well.
Fuel Knock Mod & Ign Adv. Knock Mod - Shows modifications done by knock control to fueling and ignition
Knock Lvl Rel - This value is obtained by subtracting the current Knock Acc. Val from Knock Reading. If itʼs
positive, knock was detected.
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Setup Procedure
There is a simple process to go through to configure knock control, and this is outlined below. Note that
experienced professionals will be able to determine knock levels correctly.
1.
2.

Make sure your knock sensor is correctly installed and wired to the ECU.
Use a knock frequency calculator to determine the knock frequency of your engine. You can multiply
this by ‘2ʼ to use the 2nd harmonic frequency to lower background noise.
3. Make sure the ignition map is set very conservatively when doing the base runs.
4. Set the entire Knock Acc Val Table to a high number (>66,000)
5. Configure the RPM ranges, window and step size according to your preference.
6. Set ‘Enabledʼ to ‘Noʼ in Knock Settings.
7. Adjust the Time Constant and Gain (don't forget to cycle the power after each change) until Knock
Reading is around 30,000 at idle
8. Do a couple of runs in a higher gear with logging activated, or use a Histogram DRO view (pause it by
pressing ‘Pʼ after a run) trying to cover the entire RPM range where you want to have knock control
active.
9. Fill in the Knock Acc Val Table with the corresponding readings from the log, corresponding to the
RPM row which you're adjusting. Obviously, leave a margin (the value in the table should be higher
than the one in the log) for changing conditions. 10% should be enough, but use your best
judgement.
10. Adjust the Fuel Knock Trim Table to add fuel when knock occurs. Make sure you edit the input axis
as well as the output.
11. Re-enable knock control, and if safe to do so, create a knock event by over advancing and checking
the ECU reacts as expected. Do so at your own risk to you and the engine!
Be sure to test using an ancillary measurement system such as traditional 'det-cans' to ensure everything is
in line before relying on knock control to protect your engine!
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Limiters
The ME system features a default layout for the Limiters page.
There are two types of limiting, Hard Cut and Soft Cut. Hard Cut is when the engine is literally not able to
electronically rev higher (it could still be mechanically revved higher buy down-shifting incorrectly at speed
etc) but the ECU will no longer provide an ignition spark, fuel injection events, or both (depending on Mode in
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the Limiter Settings) once the Lim. RPM is reached (looked up from the Lim RPM table, see below).
The Soft Cut RPM Offset is how many RPM BELOW the Hard cut (in the below table we have a hard cut (at
operating temperature) of 8000 and a soft cut setting of 200, meaning soft cut will start to engage at
7800rpm). Once we reach 7800 RPM the ECU will progressively cut a percentage of fuel/ignition from 0100% as you approach the true hard cut value.
The Lim RPM table sets the engines max RPM (Hard Cut) based on engine temperature. In the below image
you can see that when the engine is very cold, it is limited to 4500 RPM, ramping up to the max engine
speed of 8000RPM when it reaches operating temperature of 60*C.
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Lambda Control
Lambda control relates to using a sensor to measure the exhaust gasses and used to either monitor it
during the tuning stage, or, apply real time feedback to adjust for fuelling errors. The default layout of the
lambda tab is shown below.
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The Lambda Settings driver allows the use of a narrowband or wideband lambda sensor for fuelling
corrections. Note that an accurately tuned calibration accounting for all conditions does not need lambda
feedback. Lambda feedback aids in emissions. The only issue being an exhaust leak (more air) could be
corrected by lambda feedback making the engine richer. Because of this the authority percentage (see
below) limits the amount external feedback can effect it. Use the default "Lambda" page to have everything
you need visible.
You can enable lambda control by using either using a basic narrowband sensor, an external wideband
controller (with the ME221) or the Internal controller as built in to the ME442 range.
Be sure to set your target AFR table to the values you would like.
The driver can be found under ‘Lambda Control->Lambda Settingsʼ. When opened in MEITE, and the "Type"
is set to either external (on ME221) or usually "Internal" on the ME442, the following options and settings
are then presented:

The settings shown are typical of a standard external Wideband sensor on a normal, four cylinder naturally
aspirated engine. Details of what each field represents are below.
Type: (Disabled, Narrowband, Wideband Simple, Wideband Prop.)
You can also turn off lambda feed back by setting this to disabled.
You can set it Narrowband mode or;
If using an accurate wideband lambda, there are two main methods of closed loop control - "simple" and
"proportional". Simple simply goes max authority rich/lean depending on the engine need enrichment or en-
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leanment. It generally should not be used except for testing purposes. Proportional is the usual method of
control. See the WB Algo P details below for more information.
Startup Delay
This is the delay after the engine starts running to wait before begging lambda control strategies. It allows for
external wide bands to warm up etc.
CLT Min
The coolant temperature in degrees before the algorithm will operate. (i.e. until the engine is above 65*C)
RPM Min/ MAP Min, MAP Max, TPS Max
These are the constraints required for lambda control to work - if the engine is operating outside of these
settings, the lambda fuel trim will revert to 0%.
TPS/MAP Max Delta
These are the maximum rates of change that will allow lambda control to happen. i.e if the Throttle is moving
at ahigher rate than this TPS settings, then lambda control will be disabled until the engine is "steady state"
again.
Step Size (%) and Eng. Rotations/Step
These are only used for narrowband tuning - every time the engine turns the amount of rotations set, the
fuelling trim will step by the set amount in the required direction to enrich/en-lean.
Authority (%)
This is the maximum the algorithm will be allowed to modify the maps fuelling by to try to reach your target
AFR. If it needs to move more than this than the map is most likely incorrect.
NB Stoic (Volts)
This is the target voltage for the system to aim for from the narrowband sensor. It is usually around 0.5volts.
NB Acceptable Stoic (Volts)
This is the error that allowed either side of the NB Stoic value at which trimming stops - i.e the lambda
target ash been met.
Target AFR Trigger Value (AFR)
When using a narrowband, the lambda trim will only operate when the engine is in the rea of the Inj. Target
AFR table that matches this reading. i.e usually only around 14.7 is typical.
WB Sense Min/Max (V)
These are voltages below and above which the AFR wideband (external) is considered faulty, and should
then be ignored, and the lambda tri set to 0%.
WB Algo. P
The "WB Algo. P" value should typically be set to 0.5. This uses the amount of error to adjust the fuel trim
percent more smoothly. A larger P means faster response, but runs the risk of overshooting. A lower P
means smaller steps (so longer to get to the target) but reduces risk of overshoot/oscillations.

139 / 197

Motorsport Electronics User Documentation

Created with the Standard Edition of HelpNDoc: Free Web Help generator

Lambda Sensors Types
Although not a requirement, a Lambda sensor allows feedback to the ECU about the fuelling - the ECU can
then adjust its fuelling in real-time based on this data - known as closed loop lambda control.
Without closed loop, the ECU will only take into consideration the target AFR (Air Fuel Ratio) as a function
of the VE formula - it will not act upon any reported AFR data. Both narrowband and wideband O2 sensors
are supported, however, when using a narrowband sensor, only ‘emissions targetingʼ is recommended.
Wideband however allows full closed loop targeting of the AFR in correspondence with the target AFR table
for real time fuelling corrections.
If you are planning to not use a lambda sensor, or a Narrowband sensor, that is, one which outputs 0-1V
dependant on mixture, then no HRT calibration is required, however, if you plan to use a external wideband
sensor (with its own controller) that outputs a 0-5V signal, then you will need to configure it in the WBO2
HRT table, which can be accessed from the tree view, HRTs>WBO2 HRT.
Much like the MAP sensor calibration, the wideband controller will come with a manual or data sheet that
specifies the Lambda/AFR for each given voltage output. Most on the market follow the rule of 0v=10:1 AFR
and 5v=20:1 AFR (Which would be a RAW of Zero meaning 10:1 AFR, and RAW of 65535 (or voltage of 5v)
being 20:1 AFR). All of our base maps have this table set as default, and if you wish to change them you
can follow the same procedure as when calibrating the MAP sensor.
Once you have set the WBO2 HRT table, and have it connected to the ECU, and the correct analog voltage
pin assigned to O2 RAW, the WBO2 Current AFR readout (which can also be logged) should match the
WBO2 reading your controller is reporting - even if you don't enable wideband control.
Note: There is a known issue with certain AEM gauges whereby the AEM gauges reading will differ from the
MEITEʼs ‘WBO2 Curr. AFRʼ DRO - this has been noted with other ECUs also - you should use the MEITEs
reading as opposed to the gauges.
Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

Narrowband Lambda
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For simple emissions control, it is often a good choice to fit a simple Narrowband Lambda sensor. See how
to wire them here. For information on tuning a narrowband lambda control system for emissions, see here.
A narrow band outputs 0-1 Volts depending on the AFR, being only accurate around its midpoint (0.5v) at an
AFR of 14.7. It cannot be used for load tuning etc, only for light load closed loop feedback for emissions
control.
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External Analog Wideband Lambda
If you are using a ME221 system (The ME442 has wideband built-in) then you may wish to feed into the
ECU an AFR signal from an external controller such as an Innovate or AEM wideband gauge. Simply take
the 0-5v signal from the external gauge/controller and feed it either into the stock O2 signal wire (if using a
Plug-In) or into an analog voltage input of your choice. Be sure to set the input setting to O2 RAW in the
Analog Input settings and calibrate the WBO2 HRT as required.
You will need to configure your lambda control settings as usual to make use of the data, or, it can be used
purely as a readout in MEITE.
If your wideband controller also features a "signal ground" wire, then it should be grounded as near to the
ECU as possible.
For connectivity information please see the wiring lambda sensors section.
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Closed Loop Narrowband Lambda
The Closed Loop Lambda driver allows the use of a standard 0-1v oxygen sensor to help maintain
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stoichiometry during areas where the AFR (Air Fuel Ratio) target table is set to 14.7.
This is particularly useful for conditions such as ‘fast-idleʼ for emissions compliance (as used by the UK
VOSA IVA and MOT scheme). With correctly functioning closed loop NB lambda control, when the ECU is
commanding a 14.7 AFR, the narrowband sensor should allow the engine to reach it. That being said, for
WOT and ‘lean cruiseʼ, a narrowband should not be used to ascertain the engines AFR, as it is accurate
only around 14.7AFR (lambda 1.0). More info on this is here.
For continuous closed loop AFR correction for any AFR, please refer to sections on Wideband Lambda
control. Either using an external wideband controller (with the ME221) or the Internal controller as built in to
the ME442 range.
The driver can be found under ‘Lambda Control->Lambda Settingsʼ. When opened in MEITE, and the "Type"
is set to Narrowband, the following options and settings are presented:

The settings shown are typical of a standard Narrowband sensor on a normal, 4 cylinder naturally aspirated
engine. Details of what each field represents are below.
NB Stoich (V)
This is the voltage the control system should target for stoichiometric fuelling - typically around 0.5 volts this can be checked with your sensors datasheet.
NB Acceptable Stoich
This is the allowed error in Volts at which the algorithm will consider the mixture to not need adjusting.
NB Sensor Fault
This is the voltage at which a fault of the sensor will be considered, and the algorithm will not operate in this
case.
NB Engine Rotations
This is the amount of time (in engine rotations) that are allowed to pass before applying the next ‘stepʼ.
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NB Step Size
This is the step size in percent by which the algorithm will alter the fuelling (either increasing or decreasing)
every ‘stepʼ until it hits the right NB Stoich voltage received from the sensor.
Authority (%)
This is the maximum the algorithm will be allowed to modify the maps fuelling by to try to reach stoich. If it
needs to move more than this than the map is most likely incorrect.
RPM Min
The minimum RPM before the algorithm will operate.
TPS max
The maximum throttle percent before the algorithm is turned off - i.e. to avoid trimming the map at (rich) wide
open throttle positions.
MAP Min/MAP Max
The zone in KPa reported from the MAP sensor where the algorithm will operate.
Coolant Min
The coolant temperature in degrees before the algorithm will operate. (i.e. until the engine is above 65*C)
Target AFR Trigger
One of the more powerful aspects of the ME ECU - the algorithm will look at your Target AFR table and only
try to trim the fuel when your target is as specified, generally, 14.7 (that is the only value a NB sensor can
indicate cleanly). This stops it trying to tune in the intentionally richer or leaner areas of the map.
Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Setting up Narrowband "Emissions" Lambda Control
If you wish to use your narrowband in an OEM configuration for MOT/Euro emissions testing, the following
settings will be optimal to allow this. Ensure you have wired the signal line into a chosen analog input (or the
OEM one if a Plug In system) and set that channel to O2 RAW in the Analog Input Settings.
If does require your fuelling (VE table) has been tuned such that without lambda control you hit "approx "
14.7:1 AFR between 2500-3000rpm at low load. The narrow band will auto adjust in real time to get it right,
but it must be at least close to start with.
You can see that we are taking advantage of only allowing narrowband tuning to occur at ROPMS of 25003000 below manifold pressures of 60Kpa, by setting the target AFR table to 14.7 in these zones. Any zone
which doesn't have 14.7 will turn Narrowband control off (as the sensor is only accurate around 14.7
anyway).
Watch the Lambda Status DRO for info as to what is going on, or, any reason as to why it isn't trimming (ie
is it out of bounds such as not warm enough etc). If you see the trim go to the limits of authority (set here to
+/- 20%) then it means your VE table is NOT tuned correctly.
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Closed Loop Wideband Lambda
Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

ME442 Inbuilt Wideband Lambda
The ME442 range features inbuilt Bosch Wideband control, meaning you can directly connect an LSU4.9
sensor to the ECU and it will give high speed, high accuracy lambda readings.
For the plug-in models, we offer a direct fit 2.5 meter cable along with genuine Bosch LSU sensor available
from the web-store LOOM_PI_LSUKIT. The cable directly plugs into the ME442 Core at one end, and then
into the LSU sensor at the other allowing a fast install time.
For the Wire-In ME442, you will need to hook up the 6-way wires to the ECU according to the ME442 wiring
diagrams.
The ME442 models feature an on-board BOSCH wideband controller. You can therefore directly connect an
LSU 4.9 sensor to the ECU and have live, accurate fuel AFR readings.
It will also follow the guideline BOSCH heating strategies such that the sensors life is extended.
The below default tab shows the typical layout of the wideband settings. These should be left as default
unless you are requiring different PID settings (which is rare).
Once configured, and warmed the status will report it is operating as normal. Int. WB AFR will then be
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reporting correctly. You can use this wideband signal as a reference for lambda control by selecting it under
"sensor type" of the lambda settings (set it to Internal WB).
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Wideband Long Term Trim (LTT)
LTT stands for “Long Term Trim”. Itʼs used extensively in most modern OEM ECUs as a way to ensure
proper engine functioning when using the same map over tens of thousands of units, with the inherent
manufacturing differences between them and to cater for the wide range of conditions in which they are
required to function.
Proper functioning of any engine rests on having the correct Air-Fuel Ratio (AFR). As the name suggests,
it's the ratio between the air's mass and the fuel's mass that's being burned in the cylinder. There are some
key terms here:
Stoichiometry = the ratio at which all the fuel is burned (14.7 for pump gasoline)
Lean mixture = more air than fuel (>14.7)
Rich mixture = more fuel than air (<14.7)
Lambda reading = Current AFR / Stoichiometric AFR
By defining the desired AFR for specific conditions (normally a 2D table against RPM and Load) and by
using a wideband sensor to measure the actual AFR, we can make real-time corrections as to how much
fuel is being injected in order to reach the desired AFR. In short, if the current AFR is smaller than the target
AFR, then it means the mixture is too rich and we need to make the injection pulses shorter. Similarly, if
the current AFR is bigger than the target AFR, this suggests we are running too lean and more fuel needs to
be added.
The “Long Term Trim” uses those real-time corrections and compounds them over time. As more real-time
trim values are gathered and stored, the initial fuelling values as the engine enters a set of conditions (RPM
and Load) become more precise and in need of less corrections from the wideband sensor.
Note however, that in the case of the ME221, the LTT is there to help actual VE tuning of the base-map.
Because the ME ECUs uses its built-in flash memory to record these modifications, indefinite use of the LTT
system will eventually ‘wear outʼ the memory - however our estimates show it to last over 20,000 miles - so
once you are happy with the AFRs of the engine under all conditions, it is best to disable the LTT system
(applying the discovered trims to your VE table) and instead just use the WB Lambda as a normal closed
loop AFR targeting system.
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Also, please bear in mind that itʼs best to set the ‘MAP Min.ʼ to a value just slightly above overrun MAP
value. In order to determine that value you can either use MEITEʼs histogram feature to see the readings
while on overrun or simply by logging the data using MEITE. You'll need to do this even if you don't use the
Overrun fuel cut feature built into the ECU, the reason behind that is that the lack of airflow through the
engine when lifting off produces unreliable readings and might result in unreasonably high corrections values
being applied as LTT fuel trims.
Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

LTT Algorithm Operation
In the previous section, the general functioning of the LTT was described, now itʼs tie to get an insight into how it
works on the ME221. First, the ME221 needs to be correctly set, as shown in the below System>Lambda Settings
dialog.

The following parameters are important for LTT:

●

Type - needs to be set to ‘Widebandʼ (Usually Proportonal)

●

WB LTT Enabled - needs to be set to ‘Yesʼ

●

LTT Req. Conf - determines the required number of passes for each cell before that value is deemed
stable and is no longer modified by the algorithm

There are three tables are that are used by the LTT system:

●

WB LTT Table (RPM x Pri. Load -> LTT Trim)
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●

WB LTT Conf. Table (RPM x Pri. Load -> LTT Confidence Level)

●

Target AFR Table (RPM x Pri. Load -> Target AFR)

As valid AFR readings are taken from the wideband sensor, they are compared to the desired AFR (obtained from
the Target AFR Table) for that area of the map. The ratio between the Current AFR reading and the Target AFR value
determine the theoretical correction needed. This is then multiplied with the ‘WB Algo Pʼ teri to deteriine how
much of that correction is to be applied during this step. This value is then multiplied with the previous trim
applied to get the final value.
Example:
Step 1:
Target AFR: 14.7
Curr AFR: 16
Previous LTT Trim: 1.0
WB Algo P: 0.5
We first calculate the theoretical trim needed to reach the target AFR. This value will be the ratio between the
current AFR and what we set as target, so 1.088, or a 8.8% increase in fueling to reach the target AFR. However, as
the ‘WB Algo Pʼ is set to 0.5, only half of this trii will be applied in this step. So:
Final LTT Trim: + (8.8% * 0.5) = +4.4%
Step 2:
Target AFR: 14.7
Curr AFR: 15
Previous LTT Trim: 1.044
WB Algo P: 0.5
We follow the same steps as before to get the current trim set as +1%. However, as the current values result from
the previously applied trim for these conditions (1.044), the final result is:
Final LTT Trim: 1.01 (+1%, current trim) * 1.044 (previous trim)
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LTT Usage Example
This is the place to be if you already know what LTT is, how it works and just want to learn how to use it on the ME
ECU for auto-tuning.

●

Ensure that all the sensors (MAP, IAT, CLT, RPM, O2 etc) are reading and functioning correctly and
acceleration enrichment is disabled (set the AE Threshold to a very high number). If any of them don't
display the correct values, please check the HRTs, wiring or the sensor itself.

●

Correctly populate your Target AFR table with the appropriate values for your engine. If you're not sure
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what they are, please contact a tuner, as continuing the process without a proper understanding of these
notions will damage your engine.

●

Re-check your “Lambda Settings”. Make sure that the conditions for using the sensor readings are
correct (minimum coolant temperature, RPM, TPS, MAP etc) and that the LTT-related configuration
parameters are correctly set.

●

Ensure that the input axes for tables ‘WB LTT Tableʼ , ‘WB LTT Confdence Tableʼ and ‘Base VE Tableʼ have
the same values stored.

●

Reset the ‘WB LTT Tableʼ cells to 1 and the ‘WB LTT Confdence Tableʼ cells to 0. You can do this by
selecting all the cells in the table, pressing backspace and entering the desired value there.

●

Drive/dyno your car. Transients are bad for data collection, so try to keep RPM and load steady for a
few seconds until moving on to the next area of the map. The changes to the WB LTT tables are not shown
in real-time, so do not expect the table to be modified in the MEITE as you drive, also, note that the last
two minutes of engine running are never stored - so we advise at least 10-20 minutes of driving under
various loads and speed - the more the better, though once you have confidence numbers of 50+ for the
mainly used areas of the map, this is usually enough.

●

Cycle the ignition, and with the ignition on, but the engine off (not started), itʼs tie to check the results!
Re-Connect using the MEITE, and then when loading the WB LTT tables, the trims and confidence values
should be nicely distributed along the map, with high confidence values for all the ‘heavily drivenʼ cells.

●

You can either apply the long term trims to your VE Table to improve your map or leave them untouched
in the WB LTT table. Do bare in mind that firmware updates erase all tables though, so always apply your
trims, and save your calibration before doing a FW update. In order to apply your long-term-trims, rightclick on the Base VE Table and select ‘Multplyʼ froi the ‘Apply Trii to Entre Tableʼ ienu.

●

The wizard pops up with the following components (Fig. 3):

○

‘Trii Tableʼ - selects which table is to be used as the trii source. Set it to ‘WB LTTʼ for this.

○

‘Confdence Tableʼ - set to ‘WB LTT Conf.ʼ

○

‘Min Confidence. Levelʼ - This stpulates the iiniiui level of confdence reruired to tune that
cell - in other words, if the LTT module has only visited that cell a small number of times, we may
not want to use it to tune the VE table. Set this to a reasonable number: 5 is a good starting
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point.

○

‘Reset table valuesʼ - whether or not to reset the corresponding tableʼs values afer the wiiard
has finished and all the changes were sent to the ECU.Generally this is the case as once the
changes have been applied, to stop ‘repeat triiiingʼ it is best to do so.

Fig 3: Wizard loaded with correct settings for LTT Trimming.

●

Now press ‘Apply Triisʼ and the data grid will now show the VE table with the triis having been
applied to it. Check its correctness, then press the ‘Send to ECUʼ buton to push all the changes to the ECU.
(Fig. 4).

Fig 4: Trims applied to the VE table, but not yet stored in the ECU.
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●

The VE table has now been modified by the fuel trims (Fig. 5, below), and the WB LTT Table (as well as its
confidence table) have been set back to their default values. You can now either turn 'LTT Enable' off in the
lambda driver, or do some more driving to fine tune even more.

Fig 5: Trims applied and sent to the ECU.
Created with the Standard Edition of HelpNDoc: News and information about help authoring tools and
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Electronic Boost Control
The ME ECUs features several advanced boost control strategies. These strategies allow better control of
the engine's boost when using a turbo-charger by modulating the pressure seen at the actuator, therefore
changing the position of the waste-gate - the more open the waste-gate, the less exhaust gas passes
‘throughʼ the turbo turbines, and hence less boost is created.
You can also use electronic boost control to allow ‘boost switchingʼ - i.e to have a high/low boost switch on
the dash. Note that even though you are changing the maximum boost, you can usually just use one
VE/Ignition table to cover all settings - i.e in low boost the engine may only use up to the 160 kPa load line,
then in high boost, it may reach the 250 kPa area of the map - no need to have separate maps, just map
both high and low boost areas on the same VE table. (Note that the ME221 does have switch-able
VE/IGN/Boost maps however if needed for advanced applications, though as shown above, they are not
really needed for 99% of applications.)
To use this feature you will need a 3-port boost control solenoid, and a spare Low-Side driver channel on the
ECU. The drive frequency and duty ranges are usually specified by the manufacturer, or though much like
the idle settings, the optimal values can be found by using the manual duty mode and experimenting. Most
off the shelf units, including the one we supply (Part# ACC_BCS_1) work best at 30-60Hz.
There are several control methods available to use:
●
Manual Duty Mode
●
Closed Loop
●
Open Loop
●
Boost-by-Gear
The ECU also allows over-boost protection, as well as ‘boost scrambleʼ, whereby an over-boost pressure is
allowed for a short time, such as what occurs with larger turbo during initial spool.
HINT:
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Boost is usually referred to as ‘Gaugeʼ pressure, meaning it doesn't take into account the typical 1 Bar (100
kPa) of atmospheric pressure that already exists all around us (at sea level). To say we run 1 Bar of boost,
means the inlet manifold pressure with reference to a vacuum (or ‘Absoluteʼ pressure) is actually 2 Bar, or,
in KPa, 200 kPa. Hence you can see that a MAP reading on the ECU of 150 kPa would mean we have 50
kPa of boost, or 0.5Bar of boost. (There are 15 psi to every 1 Bar - so 50 kPa = 0.5 Bar = 7psi.)
Below is a picture of the Boost Control driver, as seen in FW 1.8.4:

Boost control can be as simple or as complex as the user requires. As we detailed above, as long as the
VE/Ignition tables are mapped for the full boost range, then we can increase/decrease boost as required up
to the maximum ‘mappedʼ level, as well as change how the turbo spools.
We assume you have installed the hardware correctly, such that as we increase the duty to the wastegate/boost control valve, we in effect decrease the amount of pressure placed against the waste-gate, and
therefore allow the turbo use more of the available exhaust pressure to increase manifold pressure.
If the opposite is true, you can select ‘Invertedʼ in the ‘PWM Solenoid Controlʼ option box.
The most basic of boost control - and indeed the first step to setting it up - is to operate the valve in ‘Manual
Dutyʼ mode, as seen in the image above.
Now, be sure to set the valve's drive frequency, which is usually specified by the manufacturer of the valve numbers from 10-60Hz are typical.
With this set, you can change the ‘PWM Manual Dutyʼ field from 0-100%, to find the min/max duties (where
no change above or below these points changes the boost level) and also to find some various duties for
different boosts when running in ‘Open Loopʼ mode.
So, for the sake of example, letʼs say we find that duties of 33% and below show actuator pressure - that is
- the boost pressure when the system runs fully mechanically (and in this example we have the actuator
boost pressure set to 7 psi, or 150 kPa Absolute) - note that if the valve were to fail, this would be the boost
that would be ran. We would note this down as our ‘PWM Min Dutyʼ. Likewise, we may find that duties of
60% gives us (our desired in this example) around 1 Bar of boost, or 200 kPa Absolute.
Now it may be thought that 60% would be the number to put in our ‘PWM Max Dutyʼ, however - this is not
actually correct - the boost may reach the target at this duty, but the turbo may spool faster if we allow it
run to 100% duty (and therefore keeping the waste-gate completely closed) when at low RPM. Again, the
manufacturer usually gives the Min/Max recommended duties for valve). It's not easy to discover this ‘Maxʼ
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number on your engine without risk of over-boosting, and engine damage, but it can be found using the open
duty table, which we will cover shortly.
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Overboost Protection
The ECU will safeguard your engine from an overboost condition. With the ‘Overboost Protectʼ option
Enabled, you will be able to set the Absolute Maximum manifold pressure that is allowed to occur before the
fuel or ignition is cut as per the ‘Overboost Cut Modeʼ option.
This limiter is removed as soon as the manifold pressure falls below the ‘Abs. Max Boostʼ setting minus the
‘Overboost Hyst.ʼ setting. i.e, if Max Boost is set to 200 kPa, and the Overboost Hyst is set to 20, then
once the engine hits 200 kPa (or above) manifold pressure, the limiter will kick in, and will stay active until
the manifold pressure falls below (200 minus 20 equals) 180 kPa.
Created with the Standard Edition of HelpNDoc: Easily create CHM Help documents

Manual Fixed Boost Control
The simplest step here to take advantage of electronic boost control, would be to set the boost control mode
to ‘Manual Dutyʼ and the ‘PWM Manual Dutyʼ field to the duty required (e.g 60% in this engine/config
example for 1 Bar) to attain the boost you would like.
You could go as far to install a switch in-line to the boost control solenoid - when this switch is closed, the
valve runs at 60% duty, giving the 1 Bar boost, and when the switch is open, the valve never receives a
signal/opens, hence returning to actuator pressure only - a simple two mode High/Low boost control.
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Open Loop Boost Control
Of course, we may want to go further and give maximum spool speed (i.e leave the wastegate closed, or
100% bleed via the boost valve) when the engine is below say 3,000 RPM, but as engine RPM, and hence
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exhaust flow increases, reduce the duty to our example of 60% to keep the engine at 1 Bar (and prevent
overboosting during spool up) once the exhaust flow can support it.
To enable this, first set the mode to ‘Open Loopʼ, and in this example we would fill the open loop table as
shown below. Note that this is for our imaginary example, 60% might give 1 Bar of boost in this example,
but it may give significantly more (or less) on your engine configuration. We also up the duty slightly
towards the end of the RPM band, to allow for more use of the exhaust gas as the turbo leaves its efficiency
band.

The open loop table also references throttle position - maybe we want more boost at WOT, but less at 50%
throttle and below. We also may want less aggressive spooling when under 50% throttle. The new Open
Loop table may look like the below:

Of course you can tune this table to give perfect spool rate and boost holding without any overshoot, and
this ‘open loopʼ control mode will once again be suitable for 99% of applications. With a switch in-line, you
get the high/low boost switch effect as before, also.
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Closed Loop Boost Control
One feature-set demanded of it by the most expert of users, is closed loop boost control.
Closed Loop uses the target boost table to reference what the tuner would LIKE the manifold pressure to be
at a given RPM/Throttle Position. It then uses a PID algorithm (as set by the PID settings) to achieve this by
varying the valves duty between the Min/Max duties in real-time.
Tuning the closed loop boost control is very much like tuning the idle control - find a ‘Pʼ value that is low
enough to not cause oscillations, but fast enough to give good response - we have found 0.5-0.9 to be good
settings for most aftermarket valves.
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The settings below are excellent for the boost control kit we offer on line when using a TD04 Turbo, and the
target boost table shown gives around 0.5 Bar of boost early on, raising to 0.70 Bar later in the revs at WOT,
slightly less at part throttle.

Note that the numbers in the table represent target absolute manifold pressure.
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Boost by Gear
It may be beneficial to set boost dependant on gear (to limit torque in lower gears). Of course you will
require a suitable vehicle speed sensor, as well as configuring it to give current gear dependant on the road
speed/engine speed ratio. Please refer to the relevant section on Vehicle Speed/Gear settings to first setup
the correct gear reporting. With this in place, you can then ‘clampʼ the maximum target manifold pressure
dependant on gear. Note this only works in Closed Loop boost control mode. The following is an example
table showing 0.5 Bar of boost in lower gears (first and second), and 1 Bar maximum in higher gears:
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With the above tables and settings, although our Closed Loop table ‘asksʼ for 210 kPa at higher RPMs, in
1st and 2nd gear it will actually only target 150 kPa - and in 3rd upwards it will allow the target to be at
maximum 200 kPa. This illustrates how the Gear Clamp table ‘overridesʼ the target table. Note it will not
allow the target boost to go higher - i.e if the gear clamp table had 300 kPa in all gears, and the Closed
Loop Target Boost table had 200 kPa, then the target boost would still only be 200 kPa - the clamp does
exactly that, it CLAMPS, it cannot increase the target tables values.
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Cooling Fans
The ME Platform offers two cooling fan channels, Primary and Secondary. You can choose which physical
output these signals are routed to via the Output Settings.
The Fan settings box allows you to jump the idle duty up (to cope with the extra load on the alternator)
Select which fan you would like the Idle adder to happen from the "On Fan".
It will then add the selected Duty to the current idle duty for the time set.
The On and Off Temp settings allow you to set the temperature when either fan will come on/off. And the
Fan Status DROs will indicate if the ECU is commanding the chosen Fan channels to be On/Off.
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Alternator Control
Note to use alternator control, you must also set a PWM Low Side Output to "Alternator Ctrl.". Depending
on your alternator you may need a 5v/12v pull-up when using a Wire-In ECU. For our Plug-Ins that require
alternator control such as late Mazda MX-5s, the Plug-In base board already has all the pull-ups etc as
required. Always use a basemap when using a Plug-In as things such as Alternator control will already be
configured for you.
Below you can see the default Alternator settings layout which is under AC/Fan/Alt tab of a default layout in
MEITE.

The Status DRO reports the alternator control mode. The Alt. Ctrl Duty (%) is the current PWM drive duty of
the chosen Alternator Control pin, and Battery Voltage is the current measured voltage making it to the ECU
Ignition input.
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Alternator Settings
Mode
Mode can either be PID (which ), Fast Switch (the easiest to
PID Mode
This will use the CL & PWM Params for adjusting the drive duty to reach the targeted battery voltage.
Standard PID tuning will need to be followed to set this effectively.
Fast Switch
Fast switch will simply check the battery voltage as often as possible. If the battery voltage is higher than
the current target voltage, it will turn off the alternator, or, if it is lower, it will turn on. The end result is a
rapidly changing average duty. This is easiest mode to setup, and the most typically used.
Manual Duty
The output duty will always operate at the value entered in the Manual Duty(%) box.
Off
No alternator control, and the chosen output will be set to off/0% Duty.

Inverted Output
This will drive the alternator either normally, whereby when the Duty is 100% the chosen output will be ON,
or vice versa. because most ECUs require a pullup which will then INVERT the drive type, usually this is set
to Inverted output. If you find using manual mode that more duty=more battery voltage (when the engine is
running of course!) then you should set this to normal.

Min RPM
Alternator control will be left at 0% until this minimum RPM level is met, at which point the Start Delay (s)
Timer will begin. Once it elapses, then Alternator control will activate.

Charge Mode/Run Mode Voltage/Charge Mode Time
When the engine initially starts, the car will be in Charge Mode, and the system will target the Charge
Mode Voltage. Then, after the amount of minutes set in the Charge Mode Time, the system will change
to Run Mode and then target the Run Mode Voltage.

Overvoltage Limit and Duty
If the battery voltage goes over the set Overvoltage Limit, the alternator drive duty will go to the set
Overvoltage Duty - a basic protection system in case of alternator failure.

PWM/CL (Closed Loop) Params
The PWM Params sets the PID controller when in PID Mode. The drive frequency of the alternator, as well
as the Min and Max Duties. The CL Params sets the PID control system as per normal PID tuning.
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Tachometer
If you wish to connect a tachometer to the ECU, the ME221 and ME442 Wire Ins offer a dedicated Tacho
Pin in the Output Settings.
When set as "tacho" in the IO settings, it will offer a 12v square wave which will output pulses as per
configured in the Tacho Output Settings (under System in the Entity Tree).
The Tachometer output can be used as a low current low side driver for driving up to 0.5A - useful if you wish
to use it as an extra relay driver, for example for a second cooling fan etc.

Tachometer Modes:
You can set the tachometer output to operate in a few different modes, detailed below.

Toggles per Revolution
This will toggle the tachometer pin from High to Low then back to High the amount of times per the engines
revolution as set by the the "Toggles per revolution" setting. This must be a whole number, ie 1,2,3,4 etc.

Mirror Coils
This will make the output act like all of the dwell signals of the coil lines combined, so for example a short
3.5ms (or whatever the dwell table is set to) pulse each time ANY coil fires.

Mirror Coils Inverted
As per mirror coils, only a ground pulse will be given instead of a 12v pulse each time the coils are fired.
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VTEC / Variable Valve Timing
The ME platform supports both on/off ‘VTECʼ style cam control, as well as sophisticated closed loop
constantly variable valve timing, such as the VVT system of the ST170 engine or MX5 NBFL VVT engine.
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VVT Settings
The VVT Settings window, pictured below (VVT>VVT Settings) offers a host of settings for correctly defining
how VVT should operate. It is important however, than your crank and cam triggers are correctly defined in
the Engine Driver, and also you have assigned VVT to the correct output (PWM must be used for VVT) in
the PWM Output settings, as well as having tested it using the test mode (use fast toggles and check you
can hear the VVT solenoid buzzing with the engine off).
Note that the min CLT option allows VVT to not become active until oil temperature has reached a certain
level, typically this should be set at around 30*C.
You can also drive the VVT solenoid ‘invertedʼ to make the on/off states reversed.
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VTEC / Switched VCT Mode
The VTEC system of the ME221/ME442 allows a band gap system of Load and RPM. It will also switch to
the secondary Fuel and Ignition tables during VTEC operation to compensate for the different engine
characteristics.
The VTEC switching system is defined by six data points. These can be found in the VVT Settings under
VVT. Be sure to set the VVT Mode to "Sw. VCT".
You can also set the fuel/ignition tables to switch to the second maps (useful for accurate fuel/spark timing
when in the higher lift modes) by setting them as "VVT Active" under System>Map Switching Settings.
Then, when the VTEC is active, the secondary fuel/ignition tables will be used.
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The diagram below illustrates how the VTEC enabled zone is configured. When the parameters of LOAD and
RPM are in the Green zone, then the VTEC output (VVT Cam Advance A in IO settings, on your chosen
LowSide output) will be to ON (ie GROUNDed). When outside of this zone, it will be turned off.
Also, note that minimum coolant, throttle and vehicle speed (VSS) also need to be met for VCT to be
activated.
There is also an RPM and Load hysteresis which will stop repeat triggering when at the threshold points.
PWM params and Manual Mode settings are ignore when in "Sw VCT"/VTEC mode.

The above diagram, when set in the VVT Settings, would appear as below:
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Closed Loop VVT
Closed Loop VVT is a more complex system to get working, however, our base-maps for various engines
already exist, and should be used as a starting point. Experienced tuners will recognise the other settings,
but we will cover them in detail, as well cover the setup of a typical system, such as the Ford ST170 / Puma
1.7 VVT System.
Closed loop looks at the target cam angle table and drives an oil control valve at variying frequencies to allow
oil flow in or out such that the cams real position (determined by measuring the cams position in relation to
the cranks)
It is first CRITICAL that you have set a trigger pattern set for your cam in the Engine Driver, and it is working
- without it, closed VVT will simply not work.
The steps to tuning vlose loop VVT, in essence are:
1.
2.
3.
4.

Configure the PWM output channel for where you have wired the solenoid.
Use Manual/Test mode to see how the VVT operates.
Find out and set the rest advance.
Tune the PID settings so the cam actual advance closely tracks the Target Advance.
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5. Tune the Cam Advance Target table, while tuning VE to suit the differing airflows.
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Setting Rest Advance
Rest Advance is the angle of camshafts trigger pattern (that the ECU decodes to find the cams position) in
relation to the crankshafts TDC position. We need the Rest Advance to read ZERO when we are not
actuating the cams VVT control solenoid - that way when our VVT table commands, for example 35 degrees
of cam advance, we then advance the cam from its rest, or natural position, by 35 degrees in relation to the
crank.
It is important to set the Rest Advance correctly. Follow the below steps to do so:

We assume you have carried out an output test on the chosen VVT channel(s) to confirm
the VVT solenoid works electronically.
1.
2.
3.
4.

5.

Ensure first that you have full tracking of both crank and cam (i.e Sync Status is FULL and the
correct patterns are set in the engine driver).
Unplug the VVT solenoid wires, so the cam will be in its ‘naturalʼ rest state when VVT is not running.
Rev the engine, and note the VVT>VVT Current Ang readout - note that it should stay relatively
consistent even with varying engine speed, as we unplugged the VVT control system in step two
above.
Add the resultant ‘averageʼ number you read in VVT>VVT Current Ang to the VVT Settings>Rest
Advance. For example, if the VVT Current Ang reads approx 41, and your rest angle is set to 70,
change the Rest Advance to 111. You will note that the VVT Current Angle changes to approx ZERO.
Confirm it remains at approx ZERO as you vary the engines RPM.
The Rest Advance has now been found, and it has zeroed the current advance to ZERO when the
VVT is deactivated. Reconnect the VVT Solenoid, and the ECU will now vary the PWM signal to the
chosen LS line in the IO Settings, attempting to have the VVT Current Angle match the Required
Angle.
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ST170 VVT Setup Example
The Ford ST170 which has factory VVT can lose over 40 lb/ft of torque without the VVT working - and
traditionally before ECUs could offer correct, OEM like closed loop control, most would either lock the
cams, or replace them - neither of which give the same return per investment as simply using the stock
control system with a capable ECU such as the ME221/ME442.
If you have loaded an ST170 basemap, then you will have the following settings prefilled in the VVT Settings,
as well as the following basemap VVT table:

Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator

Motorsport Features
Created with the Standard Edition of HelpNDoc: Easy to use tool to create HTML Help files and Help web sites

Switchable Maps
The ME platform features the ability to switch between two sets of ignition, fuel and boost maps on the fly,
using a toggle switch which can be mounted on the dash. You can also set the source for the switching,
either Digital Pin (such as Digital Input which has been set to "Map Switch" in IO settings), or an Analog
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Button (such as one set to Analog Button 1,2,3 in the Analog Input settings), or as VVT (to trigger a map
switch when VTEC becomes active).
You can choose whether to switch all maps to second tables, or just specific maps, such as ignition only, if
running a different octane of fuel. The configuration driver is shown below, and it can be found under the
‘Systemʼ node:

Ensure you enable it, as well as select the correct switch state, and set the maps you would like to switch,
such that with the switch armed, the ‘Sel. Mapʼ indicators show the correct map that will be used in that
state.
Note that on Plug-In ECUs, you would generally use a spare Digital Input on the MAC Connector - running a
wire from the chosen Digital Input through a switch to ground. Then in the IO settings the chosen ‘Dig Inʼ pin
should be set to Map Switch.
Please refer to the Hardware Install Guide for your specific model if you have a Plug-In system, or the
general ME100/ME221/ME442 Wire In manual for the pin-outs if you are using a self wired system for
details on the connectivity.
Example of wiring a toggle switch for switchable maps:
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Launch Control
Launch control is used to help maintain better traction and reduce wheel spin from standing starts.
It works by limiting the RPM to a user set amount by retarding the ignition timing as well as cutting ignition
events. This can sometimes be referred to as a ‘2-Step Limiterʼ.
The ECU can be trigger to utilize launch control via a clutch switch, and then either use an in-line manual
toggle switch to enable it, or, for more advanced applications, use a Vehicle Speed Sensor (VSS), (ideally
on an undriven wheel) to disable the launch limiting once the road speed reaches a certain speed.
On PnP applications, where the vehicle supports it, the clutch switch and VSS will already be connected
and configured via the default base map. To add a manual override switch, simply place a toggle switch in
series with the clutch switch, such that the signal can be ‘interruptedʼ.
The below illustrates the Launch Control/ALS configuration driver (Under the ‘MOTORSPORTʼ node):

Set the ‘Switch Active Stateʼ such that when you apply the clutch (ensure your in-line toggle switch is ON if
you have fitted one) the ‘LC/ALS Switch Statusʼ reads ‘Onʼ. Also, set LC Enabled to ‘Yesʼ.
Now you can set the RPM, (shown here set to 3,000), to be whatever you prefer the engine is limited to
whilst in Launch Control mode. Now, when you depress the clutch, the engine will be limited to this speed,
so you can apply wide-open-throttle and ensure any turbo-charging is sufficiently spooled - also it makes
launching more repeatable as the RPM is always fixed as opposed having to ‘find itʼ with the throttle. As
soon as you release the clutch, the RPM will be allowed to rise as normal, UNLESS you have a VSS Limit
set, in which case, the RPM will still be locked at the Launch RPM until your VSS passes the setting (in
the picture, itʼs set to 5mph). Setting the ‘VSS Limitʼ to zero will mean the system only uses the clutch
switch to enter Launch Control, and will ignore the vehicle's speed.
VSS Limiting is useful to allow full RPM sweeps even with the clutch depressed, i.e when down shifting at
high speed. Otherwise, an in-line switch to the clutch switch will be needed to disable launch control, and
hence stop the RPM being limited during gear changes.
Example of using a toggle switch to "Activate" and then a clutch button switch to trigger launch control:
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Water Methanol Injection
Water methanol injection control allows the ECU to take over from other eternal controllers. It will activate
the pump when certain conditions are met, as set by the Motorsport>Water Injection Settings driver in
MEITE. The settings are self explanatory, and the driver is shown below. You should wire it as per the guide
here.
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Drive-by-Wire
DRIVE BY WIRE SHOULD NOT BE USED ON PUBLIC HIGHWAYS. INCORRECT USAGE
CAN CAUSE DEATH OR INJURY AND IS ENTIRELY USED AT THE END USERS OWN
RISK.
Drive by Wire (DBW) allows a host of other features. You can access it from the DBW section of the Entity
true, and follow this simple setup guide. OEM installations that use DBW with a our Plug-In solutions
already have the majority of their settings pre-configured. Note that when using DBW you can omit the fitting
of a PWM/Stepper based Idle Valve as the DBW system can also be set to manage idle control.
The process for configuring Drive-By-Wire is as follows:
1.
2.
3.
4.
5.

Install physical wiring as per the wiring guide for DBW here.
Configure and calibrate the Pedal Position Sensors and Throttle Position Sensors
Test the Throttle in Manual Mode.
Calibrate the PID controller to give fast response with low overshoot.
Start the engine in "Manual Percent" mode to find the idle values and configure the idle control.
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Calibrating PPS and TPS Sensors
Before Drive-By-Wire can be used, its four primary sensors need to be calibrated.
There are usually two sensors in the pedal system. They typically share a 5V reference and Ground, and
then output two signals that go between zero and five volts as the pedal is moved. These signals have a
slight offset, so the ECU can see that the sensors and signals are indeed working correctly. if a sensor were
to fail, then the relationship between these two signals would change, and the ECU would notice the signals
being "out of sync" and will then trigger a DBW fault mode, which will then safely close the throttle. The
throttle plate also has a similar two-sensor set-up to give protection from a motor/driver failure in the throttle
control mechanism.

Calibrating the Pedal Position Sensors
First ensure you have correctly set the analog channels for your pedal sensors in the Analog Input settings
under the IO Settings Tab. Both Pedal Position 1 Raw and Pedal Position 2 Raw should be assigned to
their respective Ana V pins.
Below, you can see we have wired the pedal signal lines to Ana V1 and Ana V3. You can also see we have
wired the throttle signal wires to Ana V2 and Ana V5, but we will cover those in a later section,

With the Pedal position sensors wired, you should note the DBW A Pedal Pos Raws 1 & 2 varying as you
move the throttle pedal. If they do then you are ready to calibrate them.
Open the DBW Settings as pictured below. It may be worth creating a new tab for this under layout
manager.
Now, moving the pedal, note the minimum and maximum voltages for both sensor channels of the pedal
sensor. Input these in the left hand columns of both of the DBW A Pedal Pos. HRT tables. In the example
below, you can see these numbers highlighted in green.
After this, sweeping the throttle from closed to open should show 0-100% in the DBW A Pedal Pos 1 & 2 %
readout DROs. DBW A Calc. Pedal Pos will also then show 0-100% as a combined reading of the drivers
demanded throttle position (when DBW mode is set to anything other than OFF in the DBW Settings
Driver.)
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You can now repeat the same for the THROTTLE PLATE position sensors. We recommend you physically
push the throttle plate fully closed and fully open to capture the DBW Throttle Pos Raw values as most
DBW plates rest slightly open if the motor fails as a limp mode. Complete the DBW A Throttle Pos 1 & 2
HRT tables as before.
Both Throttle and Pedal sensors will now be correctly calibrated.
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Testing Throttle Operation
Once you have succesfully calibrated the PPS and TPS sensors in your DBW instalaltion, the next step is
to test the actuation of the throttle motor.
Be sure to have the H-Bridge outputs set to use DBW A if you are working with just one DBW setup, and
wired to the pins as specified. YOu can do this in the IO Settings (Output Settings) as shown below:
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You can now head back to the DBW settings, and start a manual test mode.
First, have the following items on display, as per the standard DBW layout show below:
Be sure to set your Solenoid Base Freq. to that specified by your DBW motor supplier, usually 500-1000Hz
is typical.

Next, set the DBW Mode to "Manual - Duty".
You can now try entering a duty into the PWM Manual Duty box (try -30 to 30-40%) and you should note the
throttle plate will move. If it does not check, that the Duty is indeed what you have typed in, and then check
wiring. If you find that the throttle opens with a negative duty (i.e. -40%) then you should change the PWM
Solenoid Control from Normal/Inverted as necessary such that a high duty (say 80%) drives the throttle
open, and a NEGATIVE duty (such as -50%) drives it closed.
The next step is to test "Manual - Position". You can then enter a target position % for the throttle plate, and
it should meet it.
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This confirms the throttle motor is correctly wired, and that its frequency and drive direction is also correctly
set.
The next step is to set it to track the pedal position (by setting the correct mode and fail-safes) and then
tuning its PID so it tracks quickly without overshooting.
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Closed Loop Setup
One you have configured the sensors, and confirmed that in manual mode, the throttle plate moves correctly
(ie a positive drive duty percent opens it, a negative drive duty closes it) its now time to calibrate the PID.
Set the throttle mode to closed loop. The below default PIDs should be used. If you find the throttle
overshoots the pedal (or the plate oscillates) try reducing the P value. PID tuning should usually be left to
your tuner, or, you can load the settings we have on file for various throttle types. We can also assist
remotely with PID tuning of throttle plates.
The Main TPS and PPS should be set - usually this is sensor 1 in each case, as the below illustrates.
Note that the TPPS and PPS Max Error are the acceptable error margins (1-10, 1 being any amount of
difference is OK, and 10 being that the sensors must align perfectly). If you have a sensor failure, the
Failsafe PWM % will be driven to the DBW Motor. You can experiment with the failsafe numbers by
disconnecting one of the sensor channels on either the TPPS or PPS and check that the system "notices"
and correctly acts upon it.
If failsafe occurs during normal pedal sweeping after correct calibration (as denoted by the DBW Sensor
Status DROs) then the Max Err should be raised, and the ECU power cycled.
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DBW Idle Control
Drive-by-wire idle control utilises the same idle control strategy as PWM idle, making configuration easier.
To use it, once DBW has been properly calibrated, simple set the Idle Drive in the Idle Settings to DBW.
DBW TP Max then states what 0-100% of the idle duty represents in terms of DBW target throttle position.

169 / 197

Motorsport Electronics User Documentation

For example, if we find that DBW Idle (to go up to say 2000rpm) requires a DBW throttle Plate position of
8%, then we would set DBW TP Max to 8%.
Then, for example, if we used manual idle mode, and set the manual idle duty to 50%, the DBW throttle
plate will set itself to 4%. (50% of the maximum 8% allowed by the DFW TP Max.)
Idle closed loop, and open loop would work in the exact same way as normal idle control, only now, they are
driving the DBW throttle plate position from 0-100% of the DBW TP Max. PID etc would be tuned in the
normal way as per the idle control tuning guides.
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Base Settings
The below sections detail some base settings for common DBW units. These have been provided by both
our internal testing as well as some customer supplied information. Please use at own risk.
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VAG DBW Units
The below are default guide settings for the DBW units used on Volkswagen engines such as the 1.8T.
The part numbers for the DBW Throttle unit are: BOSCH 0 280 750 036 or VAG 06A 133 062 C
The below screen shot shows default settings. You may need to calibrate your PPS if required.
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Flex Fuel
The ME221/ME442 supports flex fuel as standard. You will need to wire the flex sensor (use the standard
GM type) into a spare HIGH SPEED Digital Input (GEN1 Black Plug Ins, ME221 Wire In) or a normal Digital
Input (GEN2/White Plug-Ins/ME442 Wire-In).
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Check it shows the fuel flex amount and temperature correctly in MEITE once you have installed it before
attempting to tune it.

1. Map as normal using the traditional fuel tables on normal gasoline. Use Flex fuel ethanol % reading
2.
3.
4.
5.

(from the DRO) to set ‘Base Tables Ethʼ in the Flex Fuel Settings
Fill the tank with “high ethanol” fuel - maximum ethanol % that the car will ever see
Set that value in ‘Aux Tables Ethʼ - Flex Fuel Settings
Enable ‘Flex Fuelʼ from within the Flex Fuel Settings
Map the engine as normal, but use the tables that start with ‘Aux.‘ . They are all in the relevant
sections
a. Aux - Base VE Table
b. Aux - Ignition Table
c. Aux - Target AFR
d. Aux - OL Duty Table - Idle
e. Aux - Cranking Fuel Trim
f. Aux - After-start Fuel Trim
g. Aux - Priming Pulse
h. Aux - OL Duty - boost
i. Aux - CL Target MAP
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General Purpose Tables
General Purpose Tables, or ‘GPTsʼ, allow an ME ECU a massive flexibility in control. Unlike other ECUs
which may feature one basic “PWM” table, the ME GPT system allows control over fuelling, ignition, idle,
boost and other trims, as well as being able to to be tied in sequence for even greater control.
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Because the realm of flexibility is so great, a couple of example uses will be shown below.
If you have a specific “GPT” function that you feel would make a great addition to the ME Core settings, we
can look to convert it into a normal function on the ECU. The GPT system for that reason makes a great
development and testing platform when designing new algorithms with advanced tuning in mind.
Created with the Standard Edition of HelpNDoc: Free Kindle producer

GPT Example 1: AFR / Load Safety Cut (Failsafe)
A typical use of a GPT may be to protect an engine., If the user connects a wideband sensor to the ECU, and has
properly calibrated it, then the ECU will also report the “Wideband AFR”
We may want to protect the engine from running outside of these parameters - if we detect a lean AFR when a
turbocharged engine is on boost, this would be a catastrophe, and it would be best to cut the engines power at
this point.
We cannot simply use the Wideband AFR Error to act upon, as in some circumstances, such as cold idle, overrun
and startup, the AFR error from the target table will be not repeatable.
A simple GPT setup for this would therefore require a two-dimensional table, that outputs a fuel trim (perhaps a
slight enrichening in “slight” circumstances, with an overall fuel cut if the engine goes outside of parameters.
We would implement this like so:
First we need to capture the data we wish to use in designing this fail-safe control:
1.
2.
3.

Create a New Blank Tab using the View>Layout Manager menu, and name it “AFR Failsafe”.
Add to the tab Wideband AFR, MAP and RPM histograms.
Carry out power runs (assuming the engine is safe) noting AFRs seen under different levels of boost and
RPM - this is the baseline “safety” level as a tuner you donʼt want the engine to operate outside of. Note
you can press the key “P” on the DRO Histogram to pause the data after runs and use the cursor to review
the acceptable AFR at given MAP levels and RPMs. You can skip this step if you already have an idea of
safety targets in mind.

Next, we create the GPT control strategy. We donʼt have any other GPT algoʼs setup, so we will be using GPT 3D 1
for our control.
1.
2.
3.
4.

Add to the tab: (Under GPTs) GPT 3D 1 Config, GPT 3D 1 Out Link, and the GPT 3D 1 table:
As this table type will be outputting “Data” as opposed to a direct PWM output, its type should be set to
Data in the config window.
As we will be affecting the fuelling output, its Output should be changed to “Safety Cut”
X Axis Source should be set to “WBO2 Cur AFR [900]” and then set the Y axis Source to “MAP [6]”

Next we need to set the the actual GPT 3D table up. Remember we have assigned the output to use the Safety Cut
trigger. Any number other than ZERO fed into this module will cut the ignition events from happening. This
because as it moves between two fields or 0 and 1, the system will interpolate to deliver 0.5 etc, and what we
require is a hard cut based on leaving the acceptable cells.
First we will setup the Axis. The top (X-Axis) we defined to be sourced from “WBO2 Curr AFR” - so the current AFR is
used to look up the left-right location of the output. We will fill this top row evenly from 10-18 AFR by double
clicking each top item and changing it as such.
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The Left (Y) axis, we defined to be supplied by “MAP” - (manifold pressure), so we will scale this from 0(vacuum) to
300kpa which is 2 bar of boost, as 1 bar (100 kpa) is atmospheric pressure.
The cells we will fill out as we see fit as a tuner, for example AFRs over 14 when above 150kPA should result in
complete safety cut to save the engine. The end result of this strategy is shown below:

Created with the Standard Edition of HelpNDoc: Easily create Help documents

GPT Example 2: Shift Light
In this example we will set up a single LED shift light which will activate at a certain RPM. It will flash as we
approach the shift point (7000rpm), then light solid at the limiter (7300rpm).
Source a 12V automotive High brightness LED. (These have the built in current limiting resistor). Wire it to a
spare PWM Low Side Driver as shown below. Note it must be wired the correct way round to function. The
positive is usually a Red Wire.
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Now we must configure the General Purpose Table to operate it.
First create a new tab using the layout manager, named 'Shift Light'.
Add to the tab:
· Inputs>RPM
· GPTs>GPT 2D 1 Inp Link

·
·

GPTs>GPT 2D 1 Config
GPTs>GPT 2D 1

The display will now look like the below:

Configure as per the above image, Note we have set the output to be a "PWM" type, with a Base frequency
of 20 Hz. (So when the Duty is 50% it will flash On and Off 10 times a second, half of 20). Polarity is
Normal, so 0% Duty = the LED of OFF and 100% means it is on. And we have set the input for the 2D
Table 1 to be RPM and its output to go to the GPT PWM 1 Duty place holder.
Next we edit the GPT 2D 1 Table such that below 7000 RPM the LED is OFF and then as we approach
7300 it goes from fully off to fully on. Then we fill the rest of the table such that there are no random numbers
anywhere.
The final step is to assign the output. We have chosen to wire the LED in this example to Low Side, or LS,
number 3, so under the IO Settings/Output settings we set LS3 to be GPT PWM 1, as shown below.
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GPT Example 3: PWM Electric Water Pump Control
In this example, we will be using the system as a simple controller for an electric PWM water pump. We will
be connecting the pumps driver module (which can handle the high current, requiring a simple 100Hz PWM,
or pulse-width modulated signal, whereby 100 equals fully on, and 0 equals fully off) to the LS1 output of the
ECU.
We know we will be needing to read the engine coolant temperature, and from that, output a PWM signal to
control the pump. As we only need one input, we can just use a single 1D GPT Table.
Firstly, (although not required, but it makes things easier to work with!) we add a new tab using the layout
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manager. We have named ours “Electric WP”. As we are using a 1D table add the following items from the
tree view:
●
Inputs>Coolant Temperature
●
GPTs>GPT 2D 1 Config
●
GPTs>GPT PWM 4 Duty
●
GPTs>GPT 2D 1
The final tab layout could look as shown below:

We will be using this as a simple PWM output (ready to assign to an output pin) so the Type in the Config
should be set to “PWM”, and the Base Freq (which is said to be 100Hz by the manufacturer of the pump
driver) should then be set to 100.
The Output should be set to GPT PWM 4 Duty [2108] (which we will then assign in the IO settings), and
the Tbl In (the source, or X axis), for the table should be set to Coolant temperature [14].
We can then fill the table with temperatures and chosen duties for the water pump, which would be
discovered via tuning, such as the below:

The only final step is to assign GPT PWM 4 to our chosen output (LS 1) in our IO settings (Output
Settings):
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CAN-Bus
The ME221 Gen2 and ME442 all support CAN-BUS.
The standard ME_CAN stream DBC file is also available for use with after market dash-boards and gauges.
Please download it from the support section of our website.
Please see the subsections for more information.
Created with the Standard Edition of HelpNDoc: Easily create iPhone documentation

OEM CAN Streams
Currently supported OEM CAN-Streams are shown in the below table. You can enable them using the drop
down in the CAN Driver in MEITE on any CAN-Enabled ME product. Be sure to be running the latest
firmware.

Model

Functionality

Notes

BMW
E46

RPM, Coolant Gauge,
Output only
Throttle Load and Alternator
Feedback

VW Golf RPM Gauge Only
4
Renault
Clio
172/182

Full Dash Features-et as per
OEM

Mazda
MX-5
Mk3

Full OEM Dash/ABS
Feature-set
Created with the Standard Edition of HelpNDoc: Full-featured multi-format Help generator
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Entity Tree View

Entity Tree View
You can use these items listed to find out more about the specific functions of items in the ME Tree View in
MEITE, and if applicable, any sections of the manual that may be relevant to their use.
Note the manual section here on the Entity Tree details every possible ME Entity at the time of writing.
Some products may not have access to all entities (for example there is no on-board wideband on the
ME221).
Created with the Standard Edition of HelpNDoc: Free iPhone documentation generator

Inputs
Created with the Standard Edition of HelpNDoc: Free help authoring tool

RPM
The RPM variable reports the current RPM (Rotations Per Minute) measured from the engine. Without Sync,
this number will be 0.
Created with the Standard Edition of HelpNDoc: Create help files for the Qt Help Framework

MAP Raw
MAP Raw (Manifold Absolute Pressure) is the variable readout of the analog reading from the Analog
Channel channel assigned to MAP Raw. It will range from 0-65535 depending on voltage between 0-5 Volts..
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.
For more information on RAW Values, please see here,
Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

MAP
The MAP variable represents the Manifold Absolute Pressure. It is determined by the MAP HRT which
translates the MAP Raw (0-65535 or 0-5volt) signal into KiloPascals (KPa).
Please also see the section on calibrating the MAP Sensor.
Created with the Standard Edition of HelpNDoc: Produce online help for Qt applications

TPS Raw
TPS Raw (Throttle Position Sensor) is the variable readout of the analog reading from the Analog Channel
channel assigned to TPS Raw. It will range from 0-65535 depending on voltage between 0-5 Volts..
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.
For information on calibrating this sensor, see the TPS Calibration Wizard.
Created with the Standard Edition of HelpNDoc: Easily create EBooks
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TPS
The TPS variable represents the Throttle Position. It is determined by the TPS HRT which translates the
TPS Raw (0-65535 or 0-5volt) signal into a percentage (usually 0 to 100%).
For information on calibrating this sensor, see the TPS Calibration Guide.
Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

Primary Load
The Primary Load variable is given as a percentage. If using Throttle for Load, this relates to the Throttle
Value (TPS), or, if using Manifold Pressure for Primary Load, then it relates to current MAP in KPa.
For more information on Load Sources, please see the Fuelling Modes section.
Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Secondary Load
The Secondary Load variable is given as a percentage. If using Throttle for Secondary Load, this relates to
the Throttle Value (TPS), or, if using Manifold Pressure for Secondary Load, then it relates to current MAP in
KPa.
For more information on Load Sources, please see the Fuelling Modes section.
Created with the Standard Edition of HelpNDoc: Free help authoring environment

O2 Raw
O2 Raw is the variable readout of the analog reading from the Analog Channel channel assigned to O2 Raw.
It will range from 0-65535 depending on voltage between 0-5 Volts.
It is the channel typically used for either external wide-band controllers analog signal, or narrow-band
lambda sensors signal. See the section on Lambda Control for more information.
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.
For information on calibrating this sensor, see Calibrating the Lambda Sensor.
Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

O2 Val
Created with the Standard Edition of HelpNDoc: Benefits of a Help Authoring Tool

Coolant Temp. Raw
Coolant Temp Raw is the variable readout of the analog reading from the Analog Channel channel assigned
to Coolant Temp Raw. It will range from 0-65535 depending on voltage between 0-5 Volts.
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts, Ohms or a RAW number from within MEITE.

Created with the Standard Edition of HelpNDoc: Full-featured Documentation generator
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Coolant Temp.
The Coolant variable represents the current coolant temperature of the engine. It is determined by the CLT
HRT which translates the Coolant Temp. Raw (0-65535 or 0-5volt) signal into a Temperature.
For information on calibrating this sensor, see the Temperature Sensor Calibration Section.
Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Intake Air Temp. Raw
Intake Air Temp Raw is the variable readout of the analog reading from the Analog Channel channel assigned
to Intake Air Temp Raw. It will range from 0-65535 depending on voltage between 0-5 Volts.
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts, Ohms or a RAW number from within MEITE.
Created with the Standard Edition of HelpNDoc: Easily create EPub books

Intake Air Temp
The Intake Air Temp. variable represents the current Intake Air temperature of the air flowing into the engine.
It is determined by the IAT HRT which translates the Intake Temp. Raw (0-65535 or 0-5 Volt) signal into a
temperature.
For information on calibrating this sensor, see the Temperature Sensor Calibration Section.
Created with the Standard Edition of HelpNDoc: Create HTML Help, DOC, PDF and print manuals from 1
single source

Battery Voltage Raw
Battery Voltage Raw is the variable readout of the analog reading from the Analog Channel channel assigned
to Battery Voltage Raw. It will range from 0-65535 depending on voltage between 0-30 Volts.
This variable is usually already assigned to the internal main voltage of the ECU in the Analog Input Settings
(If assigned on the VBAT channel).
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.

Created with the Standard Edition of HelpNDoc: Free PDF documentation generator

Battery Voltage
The Battery Voltage variable represents the Overal Ignition System Voltage. It is determined by the VBAT
HRT which translates the Battery Voltage Raw (0-65535) signal into a voltage (0-30V).
This reading in MEITE should match the measured voltage at the ECU Ignition +12V Ignition Live pin. It is
used for functions such as Injector Dead Time Compensation and Alternator Control.
You should not need to change this calibration as it is factory set.
Created with the Standard Edition of HelpNDoc: What is a Help Authoring tool?

Analog Spare Raw 1/2/3/4
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Analog Spare(s) are the variable readout of the analog reading from the Analog Channel channel assigned to
Analog Spare 'X' Raw. It will range from 0-65535 depending on voltage between 0-5 Volts. They are used for
GPTs or simply for logging other external sensors connected to the ECU.
Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Oil Temp. Raw
Oil Temp. Raw is the variable readout of the analog reading from the Analog Channel channel assigned to Oil
Temp. Raw. It will range from 0-65535 depending on voltage between 0-5 Volts..
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.
See Calibrating Oil T/P Sensors.
Created with the Standard Edition of HelpNDoc: Produce Kindle eBooks easily

Oil Temp.
The Oil Temp, variable represents the engines current Oil Temperature. It is determined by the Oil Temp.
HRT which translates the Oil Temp. Raw (0-65535 or 0-5volt) signal into Degrees C.
See Calibrating Oil T/P Sensors.
Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

Oil Press. Raw
Oil Press. Raw is the variable readout of the analog reading from the Analog Channel channel assigned to
Oil Press. Raw. It will range from 0-65535 depending on voltage between 0-5 Volts..
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.
See Calibrating Oil T/P Sensors.
Created with the Standard Edition of HelpNDoc: Easy EPub and documentation editor

Oil Press.
The Oil Press, variable represents the engines current Oil Pressure. It is determined by the Oil Press. HRT
which translates the Oil Press. Raw (0-65535 or 0-5volt) signal into KiloPascals (KPa).
See Calibrating Oil T/P Sensors.
Created with the Standard Edition of HelpNDoc: News and information about help authoring tools and
software

Ethanol Content
The Ethanol Content variable is reported as a percentage. For it to work correctly, a GM type Ethanol/Flex
sensor must be wired to a Digital Input and its channel assigned in the Digital Input Settings driver. This
input does not require calibration.
For more information see the section on Flex
signal provided by the sensor.

Fuel . Fuel Temperature is also reported via the same
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Fuel Temperature
The Fuel Temperature variable is reported as Degress Centrigrade, and is used as part of Flex Fuel
calculations. For it to work correctly, a GM type Ethanol/Flex sensor must be wired to a Digital Input and its
channel assigned in the Digital Input Settings driver. This input does not require calibration.
For more information see the section on Flex

Fuel .

Created with the Standard Edition of HelpNDoc: Easily create Qt Help files

Btn X Raw
Btn X Raw is the variable readout of the analog reading from the Analog Channel channel assigned to Btn X
Raw. It will range from 0-65535 depending on voltage between 0-5 Volts.
X will be the number of the chosen Btn channel.
For more information on RAW Values, please see here,
You can set whether this variable is displayed/used in Volts or a RAW number from within MEITE.
For information on using Analog Inputs as Digital Switch Inputs, see here.
Created with the Standard Edition of HelpNDoc: News and information about help authoring tools and
software

Btn X Val
Btn X Val will report either ON or OFF, dependant on the Btn X Raw Value. If Btn X Raw is larger than 32767
then it will be reported as ON. otherwise, it will be reported as OFF.
These are used to allow spare analog channels to become standard switch inputs.
For information on using Analog Inputs as Digital Switch Inputs, see here.
Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

Analog Settings
This opens the driver for the Analog Input Settings.
Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

HRTs
Please see HRT Tables for more information on how HRTs are used and work.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Free Web Help generator

TPS HRT
The TPS HRT Table translates the TPS RAW variable as an input (Voltage/RAW 0-65535) and Outputs the
Current throttle position (TPS) in % for use elsewhere in the ECU.
If you do not have a Throttle sensor connected/calibrated you may have limited idle, boost and safety control
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strategies.
Most users use this as a linear, straight line sensor, but with the 16 cells, you can program a non-liner
relationship for specific advanced use.
Please also see the section on Calibrating the Throttle Position Sensor.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Easily create PDF Help documents

MAP HRT
The MAP HRT Table translates the MAP RAW variable as an input (Voltage/RAW 0-65535) and Outputs the
Current Manifold Pressure (MAP) in KPa for use elsewhere in the ECU.
If you do not have a map sensor connected to the wiring (for example you are using throttle bodies with
throttle for primary load), be sure to set the entire tables outputs to "100" such that MAP does not effect the
fuel equation.
Please also see the section on Calibrating the MAP Sensor.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Free Web Help generator

CLT HRT
The CLT HRT Table translates the Coolant Temp. Raw variable as an input (Voltage/RAW 0-65535) and
Outputs the Engine Coolant Temperature (Coolant Temp.) for use elsewhere in the ECU.
It has 16 cells and can be fully user configured for any sensor type.
Please see the section on Calibrating IAT/CLT Sensors.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Easily create Web Help sites

IAT HRT
The IAT HRT Table translates the Intake Air Temp. Raw variable as an input (Voltage/RAW 0-65535) and
outputs the Engines Intake Air Temperature (Intake Air Temp.) for use elsewhere in the ECU.
It has 16 cells and can be fully user configured for any sensor type.
Please see the section on Calibrating IAT/CLT Sensors.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

VBAT HRT
This reading in MEITE should match the measured voltage at the ECU Ignition +12V Ignition Live pin. It is
used for functions such as Injector Dead Time Compensation and Alternator Control.
Its Input is Battery Voltage Raw and its output is Battery Voltage.
You should not need to change this calibration as it is factory set. If you lose it by accident, you
can reload it from any of our basemaps.
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Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Free Qt Help documentation generator

WBO2 HRT
The WBO2 HRT Table translates the O2 RAW variable as an input (Voltage/RAW 0-65535) and Outputs the
Current AFR/Lambda (TPS) in AFR for use elsewhere in the ECU.
It is used for when connecting an external analog wideband controller to the ECU. The ME442 can also use
its internal Wideband controller which will not use this table.
Please also see the section on Calibrating an external Analog Wideband Sensor.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Generate EPub eBooks with ease

Oil Temp. HRT
The Oil Temp HRT Table translates the Oil Temp. Raw variable as an input (Voltage/RAW 0-65535) and
Outputs the Engine Oil Temperature (Oil Temp.) for use elsewhere in the ECU.
It has 16 cells and can be fully user configured for any sensor type.
Please see the section on Calibrating Oil Pressure/Temp. Sensors.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

Oil Press. HRT
The Oil Press. HRT Table translates the Oil Press. Raw variable as an input (Voltage/RAW 0-65535) and
Outputs the Engine Oil Pressure (Oil Press.) for use elsewhere in the ECU.
It has 16 cells and can be fully user configured for any sensor type.
Please see the section on Calibrating Oil Pressure/Temp. Sensors.
Also see the MEITE Guide on Using 2D Tables.
Created with the Standard Edition of HelpNDoc: Generate Kindle eBooks with ease

Injection
Created with the Standard Edition of HelpNDoc: Free EPub producer

The Injection Driver
Shown below is the Injection Driver (Entity Tree View>Injection>Injection Driver).
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Fuelling Mode:
This determines how the injectors will be timed and fired. Fully Sequential will require a cam sensor, and
working settings for it. You can also run batch (where all injectors fire together, once every 720*), grouped,
where the odd numbered injector channel in the firing order (defined above in the engine driver) will fire
alternately to the even numbered injection channels every 360*, or, you can set it to ‘Offʼ, whereby no fuel
injection events will take place - which is useful for setting base timing without then flooding the engine.
Use IAT in Algorithm:
If you would like the ME221s fuelling algorithm to compute the air density for you, and apply fuel corrections
based on the inlet air temperature automatically, you should leave this set to YES. However, if you would
instead like to use the Entity Tree View>Enviromental>Inj. IAT Trim to instead manually apply fuelling trims,
you should calibrate this table and set the chosen “default” or mapped IAT value in the box below.
In other words, 'Yes' - uses the ideal gas law to determine the mass of air according to the measured
temperature, while 'No' - assumes the IAT sensor to always read a constant temperature and relies on the
IAT Trim Table to generate the temperature-related corrections.
The latter is normally used on bays that suffer from severe heat-soak and where the IAT readings are not
very precise as the bay temperature increases.
Inj Max Duty:
This allows you to set a maximum duty at which point the ECU will failsafe and enable the fuel cut limiter.
Typically you should avoid running injection duties over 85%. If you need more than 90% duty to stay at the
right AFRs, then you need bigger injectors! You can set this field here as a safety limiter in these events.
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Pri Inj Size (cc/min):
Set this to your Primary/Main injectors cc/min flow rate at their test/reference pressure.
Fuel Pressure (kPA):
Enter the actual fuel pressure you are running here. This will then calculate the TRUE flow rate of your
injectors. In most cases this number can be the same as your reference pressure (above), and in later
versions of the firmware you will be able to set this to an HRT Fuel Pressure Sensor for real-time flow rate
corrections.
Inj Ref. Pressure (kPa):
Enter the pressure at which your injectors have the above stated cc/min flow rate.
Fuel Pump Prime Time:
This is how many seconds the fuel pump output should run for once ignition is turned on to prime the
system - two to five seconds is fairly typical.
Priming Pulse Settings
The two drop down boxes here allow you to set if priming should take place once you turn the key on, or, if
the priming pulse should happen once the engine starts to crank - the varying schools of thought on this
meant we would give the tuner the option of either.
The priming pulse (the time all of the injectors are fired for to ‘wetʼ the inlet) can we set from the Enitity Tree
View>Startup>Priming Pulse table, which is coolant temperature dependant.

Staged Injection
Please see the section on Staged Injection for details on how to use these settings.
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Overrun Settings
Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

System
Created with the Standard Edition of HelpNDoc: What is a Help Authoring tool?

Output Settings
The output settings window (from an ME442) is shown below. Note that other ME ECU models such as the
ME100 or ME221 may have different listings, though the functions work in a similar way.
You can access this window from the IO Setup page (if using a default layout). It is also available under the
Tree View>System>Output Settings.
From this window, you can set the Coil Mode / Rest States. Assign Outputs to a particular Function or
carry out Output Testing.
The output types consist of Coils, Injectors, PWM, Relay and Others. Only certain functions can be
assigned to certain pin types, so this should be conisdered when wiring up a universal ME ECU.
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Coil Rest State
A critical thing to notice is the ‘Coils Rest Stateʼ at the top of the Output Settings. If you are driving a wasted
spark or normal coil pack DIRECTLY (i.e it does not contain an ignition amplifier, such as a Ford coil pack)
then this should be set to NORMAL - that is, the output will be pulled to ground to ‘dwellʼ the coil. If however
you are using a PnP that drives a coil module amplifier, such as an MX5, then it would be set to ‘Invertedʼ the output will then go to 5v (or 12v depending on the PnPs circuit board) to drive the coil.

DAMAGED COIL DRIVERS DUE TO INCORRECT REST STATE
SETTINGS ARE NOT COVERED UNDER WARRANTY. IF IN DOUBT,
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CONTACT US FIRST!
Created with the Standard Edition of HelpNDoc: Easy CHM and documentation editor

Coil Outputs
Created with the Standard Edition of HelpNDoc: Full-featured Documentation generator

Injector Outputs
Created with the Standard Edition of HelpNDoc: Single source CHM, PDF, DOC and HTML Help creation

PWM Low Side Outputs
Created with the Standard Edition of HelpNDoc: Free Kindle producer

Relay Low Side Outputs
Created with the Standard Edition of HelpNDoc: Free CHM Help documentation generator

Others
Created with the Standard Edition of HelpNDoc: Free Kindle producer

Engine Driver
The Engine Driver widget houses the main configuration parameters of the engine. It is used to configure the
Triggering, Fuelling Algorithm and Firing Order.
It can be found on the Entity Tree View>System>Engine Driver.
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Trigger Options
Correctly setting the triggers is the first step in getting an engine running. Note: You should also check you
have routed the trigger signals correctly in terms of I/O. These are set correctly in basemaps for Plug-Ins
and should not be changed in those cases.
You can confirm routing of the trigger input settings and the actual physical sensors wiring by monitoring the
Crank/Cam IRQs while cranking.
Trigger Pattern:
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This is the main trigger pattern, usually what is found on the crank (or on some models the CAS unit).
Crank Trig. Edge:
This defines what the ECU considers a ‘pulseʼ - the rising or falling edge (or sometimes both) of the trigger
wheel. Some ECU brands require correct polarity wiring of their crank/cam sensors. This option allows you
to "try" both ways without swapping wires. Rising means the voltage at the Crank +Ve pin increases as a
tooth approaches it, and falling means the voltage falls as the tooth moves towards the sensor. Both is used
for specific modes for higher accuracy.
Cam Pattern
This is the camshafts trigger pattern. Typical patterns such as single lobe and various OEM are listed. If you
plan to use the ECU for semi-sequential fuelling/ignition only, you can set this to ‘Noneʼ to ignore it.
Cam Trig. Edge:
This defines what the ECU considers a ‘pulseʼ - the rising or falling edge (or sometimes both) of the
camshafts trigger pattern. See the troubleshooting section on ‘Getting Syncʼ for more details of its use.
Ignore Cam After Sync:
You can choose to only "listen" to the cam sensor when looking to gain initial sync (or re-sync after a loss
of crank-sync) using this option. It should only be used on non-VVT engines, and, ideally, not used at all. It
can be handy if an engine has a high cam tooth count which causes noise at higher RPMs, and
subsequently, lost sync events.
Trigger offset:
This is the offset in degrees that the triggering decoder software calls TDC (Top-Dead-Centre: when the
piston is at the top of the cylinder on number 1) and the engine's ACTUAL TDC. See the guide on setting
your trigger offset.
Trigger Filtering:
Use to reduce noise affecting triggering, the filter will help to get synchronisation quicker and maintain it.
Timing Delay(us):
This function should usually be set to 0, but it can be used to add a fixed amount of MicroSeconds onto
each timing element. It is used to compensate for hardware latency if you notice ignition drift at higher
RPMs. Note that timing lights will show rift at higher RPMs so do not rely on these to compensate. Only
advanced users will need to adjust this should the need arise.
Sync Start/Loss Multipliers:
These are for advanced use only, and typically should be left at 1.3. They relate to the size of the ‘big gapʼ
tooth in relation to a normal tooth - with control for acceptance of these at both starting of sync, as well as
the multiplier error that failed sync should be flagged.
Created with the Standard Edition of HelpNDoc: What is a Help Authoring tool?

Algorithm Cfg.
The master fuelling algorithm settings are set here.
Primary/Secondary Load:
These allow you to choose the source for load determination for the primary and secondary VE/Ignition
tables. For an NA/ITB engine, you would normally use TPS (Throttle Position) for primary, and fit a throttle
sensor. For a forced induction engine, you would normally use MAP (Manifold Absolute Pressure). For more
information, please see the section on fuelling model.

190 / 197

Motorsport Electronics User Documentation

Type:
Here you can select the engine's firing type, such as 4-Stroke, 2-Stroke or Rotary. This box may be greyed
out on some models of ME ECU.
Displacement (cc):
The size of the engine, in cubic-centimetres - used as part of the VE fuelling equation. For example, if your
engine is a two-litre, you would set this to 2000.
Number of Cylinders:
Set this to your number of cylinders or Rotors (if on a Rotary). Note it may be greyed out in some versions
which do not have multi-cylinder support such as some Plug-Ins.
Created with the Standard Edition of HelpNDoc: Create help files for the Qt Help Framework

Firing Order
The Firing Order drop-downs allow you to determine the injector firing order of the engine. Note #1 will
always fire first.
Changing these will impact the order of the injectors and coils are fired as set-up in the I/O Settings.
For any cylinders not used, or any cylinders set over the previous set number of cylinders will be ignored.
These should be set to "Not Used".
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Inj. IAT Trim
This table is responsicible for trimming the fuel quanitiy delivered based on the Intake Air Temperature
measured. Note that it is ALWAYS in effect. It is a multiplicaitive trim - so 1.3 would be 30% extra, and 0.8
would be 20% less than the VE computed amount.
The IAT trimming for gas density can be set to be computed automatically in the Entity Tree
View>Injection>Injection Driver.
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Accel. Enrich
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AE RPM Clamp Trim
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Inj AE Trim
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AE CLT Trim
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Knock Control
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Appendix A : Troubleshooting
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Trigger Troubleshooting
Getting the ECU to fire the coils from the crank sensor is the first step in getting the engine running, and usually the
easiest to diagnose and fix.
Firstly, with the ECU connected to the MIETE, we need to create a quick ‘Diagnostcs Tabʼ. Add a new tab in the
usual way, and add to it the following widgets:
-Engine RPM
-Sync Status
-Lost Sync Count
-CAM IRQs
-CRANK IRQs
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Check that the Trigger Types for the crank and cam are set correctly under the “System>Engine Driver”.
Disconnect the injectors and the coils, and then crank the engine.
Firstly, check that the ECU does not ‘power ofʼ while cranking. This could be either low voltage (in which case you
need better grounding, power connections or a stronger battery), or incorrect wiring to the key barrel.
The first thing you should see are the Crank IRQs and, if being used CAM IRQs increase at a steady rate. This
means your sensor(s) are ok (it may be noisy) but it at least shows that the ECU is picking up engine ‘iotonʼ.
We will assuie you stll donʼt have an RPM yet, (if you did and all wiring for the coils and coil rest states are
correct then they should indeed be sparking!), so have a look at the Sync Status readout. A status of 0 means that
not even crank sync occurred, whereas a state of HALF means crank sync, but the EXPECTED cam sync was not
found (note the ECU does not check for CAM sync if not using a CAM sensor, and wil go straight to ‘2ʼ if crank sync
is found). A state of ‘FULLʼ ieans that full sync occurred, and the coils SHOULD be fring, unless, the LOST SYNC
count is also steadily increasing, which means that it is getting Sync, then losing it.
This could be down to incorrect cam/crank trigger settings, OR noisy signal lines. Check you have shielded cable
for the cam/crank lines, and that the shields are earthed at the ECU end ONLY. Also check there is no ‘run-outʼ or
oscillation of any aftermarket trigger wheel, and that the gap is around 0.5-3mm from the sensor to the teeth.
If the system gets a nice steady RPM while cranking with the coils unplugged, but loses it once you plug in the
coils, this is HT noise entering the crank triggering wiring - shield where appropriate.
Also, try swapping the cam +/- wires or crank +/- as if these are wired inverted it can cause issues also.
With all of the above correctly set, and the sensor correctly wired (refer to the hardware installation section) then
the RPM reading should go live and read 100-300rpm while cranking. If it does not, please get in touch via a
support ticket on our website.
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High Load Misfire Issues
If you experience high load misfires (but revving fine to the limiter under no load conditions) be sure to check the
injector duty has not gone over 95% as the ECU auto protects and turns off injector outputs should this happen. If
you need 95% duty to get the right AFR, then it is time to install bigger injectors! Of course also check you are not
getting spark break down due to failed plugs or failing ignitors!
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Non-Start Diagnosis
When the engine is cranking/running, take note of the Injector Duty, as well as the position of the yellow crosshairs on the Base VE Table - this is the VE number the ECU is looking at to compute the final injection pulsewidth.
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To add fuel, increase the number (Press W on the cell), to reduce fuel, reduce the number (Press Q on the cell), and
so forth.
Engine Coughs, Kicks back during cranking
This is an ignition timing issue. Most engines will start and run at around 10-20* of advance. Check the angle you
are seeing in the Ignition Adv Angle DRO, and adjust the Ignition Table Pri1 table as required. Also be sure to check
ignition lead order, as well as base timing.
Engine Runs but Cuts out shortly After starting
This is usually down to fuel starvation - check the fuel rail is remaining pressurised during running (i.e the fuel
pump is staying active), or, force a richer mixture by increasing the VE numbers at the cells where the cross hairs
are during initial startup/running.
Engine Fails to Fire/Pop/Bang AT ALL
Check the spark plugs - if they are soaking wet with fuel (too much fuel), replace/clean, and reduce the VE tables
numbers by 30-40% (Select the entire table, press the ‘=ʼ key and in the box that appears, type -30% ), retest. If
however, the plugs are bone dry (not enough fuel) check for fuel pressure, injector operation (clicking under test
mode), and try increasing the entire VE table by 30-40%.
If you still cannot get the engine to start, please record a log (see the MEITE manual on data logging) and email it to
us, along with your calibration, to support@motorsport-electronics.co.uk.
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Odd MEITE Display Resolution
Sometimes in MEITE, especially on Windows 10, the display can look strange, with spacings and wasted
space. This is down to DPI scaling. To correct this, simply right click on MEITE icon, and under the
compatibility tab, click the "Change high DPI Settings". Tick the override box, and in the drop down, select
"System". Then restart the computer, and MEITE will display correctly (as per the below):
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Appendix B : Technical Notes
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PID Tuning Guide
The following is a short guide on basic PID tuning. Volumes are written on this subject, so along with further
reading detailed at the end, this should be a quick start to how PID works, and also how to get the best from the
ME221s PID based modules (such as closed loop boost, VVT and idle control). For this guide we will assume to be
working with closed loop idle control.
First, the base frequency of the PWM valve needs to be known. Usually, our PnP base-maps will have this set, but,
if not, itʼs easy to ieasure it using an oscilloscope.
We assume you have discovered the min/max settings of your actuator/valve duties - it will have an effective
range of say 20-80% duty, and beyond those extremes it is no longer linear, so first these limits are set. To find
these limits override the valves control by placing it in manual mode by the respective driver control, and slowly
increase the number until no noticeable effects happen. i.e. with Idle, increase it until the engine revs no longer
rise, this would be the max duty, and the same goes for the minimising. Make sure that your ‘Valve Modeʼ is set to
either ‘Norialʼ or ‘Invertedʼ as such that when increasing the duty of the valve ianually, the RPM at idle rise.
With these set, the PID algorithm now has a window to work in. It wonʼt try and change the duty beyond those
limits.
The next setting is the update interval, or how fast the PID algorithm should run. 10ms -100ms are usual amounts.
Choose a value that allows enough time for the system to react to control changes. For idle, weʼve discovered this
to be ~100ms.
For those interested in the maths behind, this is the formula of our PID algorithm. Itʼs very rarely that youʼll need
to use the derivative as well, so just leave ‘Tdʼ set to 0 for norial applicatons.

Our PID configuration parameters are:
●
●
●

P (Kc) - overall gain of the controller. A larger value will iake the systei adjust faster, but could
make it unstable.
I (Ti)
- integral tie. A bigger value will iake the accuiulated error have a sialler efect on the
output, whilst a smaller value will have the opposite effect.
D (Td) - derivatve tie constant. Not reruired norially.

First off, you should start by setting the ‘Iʼ and ‘Dʼ to 0. Startng value of ‘Pʼ set to 1. Next, change the target of the
PID algorithm (Target Idle RPM for this example) and start adjusting the ‘Pʼ untl the RPM oscillates constantly
around the target RPM value. That means exceeding the target by ~200 RPM and then falling below the target by
the same amount. Note down this value as ‘Kuʼ. Also note down the period of these oscillatons (tie it takes to
move from peak RPM to minimum RPM and then to peak RPM again). You can use our inbuilt MEITE logger to
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obtain this. This value will be ‘Puʼ and is ieasured in iilliseconds.
With these values written down, a good starting point would be to set ‘Pʼ to Ku / 2.2 and ‘Iʼ to Ku / 1.2 . These are
normally good starting values, but better results can be achieved by experimenting. If youʼre having oscillatons
while in steady-state, try increasing the ‘Iʼ teri, while if it oscillates heavily around the target when that changes,
try reducing the P component.
Further Reading
http://innovativecontrols.com/blog/basics-tuning-pid-loops
https://controls.engin.umich.edu/wiki/index.php/PIDIntro
https://controls.engin.umich.edu/wiki/index.php/PIDTuningClassical#Ziegler-Nichols_closedloop_tuning_method
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Appendix C: Glossary of Terms
AC - Air Conditioner
AE - Acceleration Enrichment
AFR - Air / Fuel Ratio
ALS – Anti-lag Strategy
ASE - After Start Enrichment
BTDC - Before Top Dead Centre
CAS – Camshaft Angle Sensor – used on some cars (mostly Japanese) to get engine position
CLT - Coolant Temperature
DRO - Digital Read-Out
DSP – Digital Signal Processing
ECU - Engine Control Unit
EGT - Exhaust Gas Temperature
GPT - General Purpose Table
HRT – Human Representation Table – all tables that convert sensor raw readings into real-life value (kPa, *C etc).
IAC - Idle Air Control
IAT - Intake Air Temperature
IGN - Ignition
IO - Input / Output
IRQ – Interrupt Requests – shows how many ‘pulsesʼ the processor received from the trigger sensors. Used to work out
trigger sensor wiring
LTT - Long Term Trim
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MAC – Motorsport Auxiliary Connector
MAP - Manifold Absolute Pressure
MBT - Minimum Best Torque/Timing - this is actually not official automotive terminology, but is a quick and easy term
to signify the lowest amount of advance that produces the most torque (right at the beginning of the torque plateau
in a non-knock limited engine)
NB - Narrow Band
OEM - Original Equipment Manufacturer
PID - Proportional Integral Derivative
PnP - Plug n Play
PW – Pulse-Width – mainly relating to injection pulses
PWM - Pulse Width Modulation
RAW – Raw reading from the ADC sensors (0-65535). In newer MEITE versions this is convertible into Volts and
Ohms (for temperature sensors)
RPM - Revolutions Per Minute
RTI - Return To Idle
TDC - Top Dead Centre
TPS - Throttle Position Sensor
VE - Volumetric Efficiency
VSS – Vehicle Speed Sensor
VVT - Variable Valve Timing
WB - Wide Band
WBO2 - Wide Band O2 Sensor
WOT - Wide Open Throttle
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Appendix D: Revision History
17/07/19 - Status Bar, Lambda Sections
10/07/19 - Remove and clear unused sections
Add PlugIn info
Improve Thermistor Info
01/04/19
Plug In Harnesses for ME100/ME221 added
19/03/19 - 1.1 Wideband Wiring Documentation added for ME442 Wire-In and Plug-In
18/03/19 - 1.0 Initial Commit
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